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ABOUT THE GUIDE

This section provides a brief description of the scope, the audience, the references, the
organization of the user guide and conventions incorporated into the user guide. The topics in this
section are organized as follows:

e Scope of the quide

e Intended Audience

e Documentation Accessibility

e Access to Oracle Support

e Related Information Sources

ScoPE OF THE GUIDE

The Oracle Financial Services Data Governance for US Regulatory Reporting User Guide
explains the concepts of the Oracle Financial Services Data Governance for US Regulatory
Reporting (DGUSRR) and provides step-by-step instructions for navigating through the
application.

INTENDED AUDIENCE

Welcome to release 8.0.4.0.0 of the Oracle Financial Services Data Governance for US
Regulatory Reporting User Guide. This manual is intended for the following audience:

e Business Analysts and supervisors in financial institutions

DOCUMENTATION ACCESSIBILITY

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

ACCESS TO ORACLE SUPPORT

Oracle customers have access to electronic support through My Oracle Support. For information,
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

RELATED INFORMATION SOURCES

For more information, refer to the following documents in OTN Documentation Library:
e Oracle Financial Services Data Management Installation Manual Release 8.0.4.0.0

e Oracle Financial Services Analytical Applications Reconciliation Framework User Guide,
Release 8.0.2

e Oracle Financial Services Data Foundation Installation Guide 8.0.3
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e Oracle Financial Services Analytical Applications Infrastructure User Guide, Release 8.0.3
(present in this OTN documentation Library)
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1 Introduction to Oracle Financial Services Data Governance for US
Regulatory Reporting

This chapter provides a brief overview of BCBS 239 Principles and Oracle Financial Services
Data Governance for US Regulatory Reporting (DGUSRR).

This chapter includes the following topics:

e Basel Committee on Banking Supervision (BCBS) 239

e Oracle Financial Services Analytical Applications Solution for BCBS 239 Regulations

e Overview of Data Governance for US Regulatory Reporting

e Important Features of Data Governance for US Requlatory Reporting

1.1 Overview of Basel Committee on Banking Supervision (BCBS) 239

The Basel Committee on Banking Supervision (BCBS) 239: Principles for Effective Risk Data
Aggregation and Risk Reporting are also known as the 14 principles. These principles were
developed because, many banks lack "the ability to aggregate risk exposures and identify
concentrations quickly and accurately at the bank group level, across business lines, and
between legal entities." The BCBS 239 framework is intended to strengthen the risk data
aggregation and reporting practices of the banks. BCBS 239 is designed to drive more timely
information and better strategic planning and reduce the impact of losses.

1.2 Oracle Financial Services Analytical Applications Solution for BCBS 239
Regulations

Oracle Financial Services Analytics Applications (OFSAA) unified platform creates a foundation to
address the regulatory requirements and successful BCBS 239 compliance, by providing a
common data infrastructure that:

e Builds a single source of truth
o Enables effective data usage

e Supports comprehensive and consolidated reporting
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Following table describes the 14 principles of BCBS 239:

BCBS 239 Principles Answered by Respective OFSAA Components

BCBS 239 Principle Description

OFSA Application Catering to the
Principle

BCBS Principle Category: Overarching Governance and Infrastructure

Principle 1: Governance Identification, assessment and
management of data quality risks to
be part of a bank’s risk management
framework.

Risk data aggregation and risk
reporting practices must be fully
documented and validated, extended
to new initiatives, unaffested by the
organization structure.

Awareness of the limitations of full
risk data aggregation.

This principle is addressed by Data
Quality Framework and OFS Model
Risk Management.

Principle 2: Data Architecture and IT | Integrated data taxonomies and
Infrastructure architecture across the group.

Establish roles and responsibilities to
ensure adequate controls.

This principle is addressed by OFS
Data Foundation, OFS Analytical
Applications Infrastructure and OFS
Enterprise Modeling Framework.

BCBS Principle Category: Risk Data Aggregation Capabilities

Principle 3: Accuracy and Integrity Ensure that risk data aggregation is
accurate and reliable with adequate
controls, data reconciliation, and
single source of data for each risk

type.

Documentation of risk data
aggregation process.

Establish escalation channels and
action plans.

This principle is addressed by OFS
Analytical Applications Infrastructure,
OFS Enterprise Modeling
Framework, OFS Reconciliation
Framework, OFS Data Foundation
and OFS Operational Risk.

Principle 4: Completeness Capture all material risk data by
relevant dimensions.

Any exceptions to completeness
should be identified and
documented.

Consistent risk data aggregation
capabilities.

This principle is addressed by OFS
Data Foundation, OFS Analytical
Applications Infrastructure, OFS
Enterprise Modeling Framework, and
all OFS Applications.

Principle 5: Timeliness Generate aggregated data as per the
desired frequency.

This principle is addressed by OFS
Analytical Applications Infrastructure,
OFS Applications and Exadata
Benchmarks.
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BCBS 239 Principle

Description

OFSA Application Catering to the
Principle

Principle 6: Adaptability

Flexibility to meet ad-hoc requests
especially during stress.

Incorporate changes related to
internal and external business
factors and regulatory framework.

Generate sub-sets of data based on
specific dimensions.

This principle is addressed by all
OFS Applications with OFS Data
Foundation, OFS Analytical
Applications Infrastructure, OFS
Enterprise Modeling Framework.

BCBS Principle Category: Risk Reporting Practices

Principle 7: Accuracy

Reports should be reconciled with
risk data, validations to be applied to
the output and exception reports to
be displayed.

Establish the reliability of
approximations such as output from
models, scenarios and stress tests.

This principle is addressed by all the
standalone OFS Bl analytics
applications, and dashboards of all
the OFS applications.

Principle 8: Comprehensiveness

Cover all material risks including
credit, market, operational and
liquidity risks, capital adequacy,
stress testing.

Exposure and position data,
concentrations, limits, risk appetite.

This principle is addressed by all the
standalone OFS Bl analytics
application, and dashboards of all
the OFS applications.

Principle 9: Clarity and Usefulness

Reports should contain risk data,
analysis, interpretation and
qualitative information.

Customized to suit individual
requirements.

This principle is addressed by all the
standalone OFS Bl analytics
application, and dashboards of all
the OFS applications, and Oracle
Business Intelligence Enterprise
Edition (OBIEE).

Principle 10: Frequency

Produce reports at the desired
frequency.

Timely availability of reports under
stress conditions.

This principle is addressed by all the
OFS Bl analytics application, OFS
applications which compute metrics,
and OFS Enterprise Modeling
Framework.

Principle 11: Distribution

Make reports available to relevant
stakeholders in a timely manner
while maintaining confidentiality.

This principle is addressed by all the
standalone OFS Bl analytics
application, and dashboards of all
the OFS applications, and Oracle
Business Intelligence Enterprise
Edition (OBIEE).
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BCBS Principle Category: Supervisory Review, Tools and Cooperation

BCBS 239 Principle Description OFSA Application Catering to the
Principle
Principle 12: Review Supervisors should: This principle is addressed by OFS
. . Data Governance for US Regulatory
e Review banks compliance Re ;
) S porting.
with principles 1 to 11.
e  Examine the results of
internal and external audits.
e Testbank’s data
aggregation and reporting
capabilities under normal
and stress conditions.
Principle 13: Remedial Actions and Use of multiple tools for: This principle is addressed by OFS
Supervisory Measures ) . . Data Governance for US Regulatory
¢ Required remedial action Reporting.

e Increased scrutiny
e Independent review

e Capital add-ons

Principle 14: Home/Host cooperation | Supervisors of relevant jurisdictions

should cooperate with each other.

Information and experience sharing
through bilateral or multilateral
dialogue.

1.3 Overview of Data Governance for US Regulatory Reporting

Data Governance for US Regulatory Reporting (DGUSRR) operationalizes the data governance
process. The OFSAA DGUSRR enables financial institutions to map multiple data sources to a
standard, common business glossary.

Additionally, DGUSRR enables to:

Identify all critical data elements.
Track and monitor the data elements from their source to the eventual usage in reporting.
Manage Regulatory submissions.

Establish a governance process around the data elements and reporting process to offer
greater visibility and increased confidence in the organization for the board of directors and
regulators.

Consolidate and collaborate across the enterprise providing a truly unified enterprise data
management process.

The content provided to DGUSRR helps the customer to have access to over 20,000 business
terms and definitions that form a part of Metadata Glossary.
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1.4 Important Features of Data Governance for US Regulatory Reporting

The key features of DGUSRR are listed as follows:

Provides business glossary for standardization.

Defines operational and quality controls on ever data element and monitors effectiveness of
controls.

Monitors all key metrics, trends, and variances on data elements.
Defines, maintains, and tracks regulatory report submissions.

Completes data quality dashboards.
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2 Components of Data Governance for US Regulatory Reporting

The components of DGUSRR are listed as follows:

Business Glossary: It maintains the business glossary for standardization along with the
Business Terms.

Critical Data Elements: It classifies the Business Terms as critical data elements with
approval and review workflows.

Controls: It defines the operational and quality controls on every data element and
monitors the effectiveness of the control.

Key Indicators: It monitors all the key metrics, trends of the metrics, variances and so on for
the data elements.

Issues and Actions: It defines the issues and remediation action plans to resolve issues.
Process Monitoring: It defines, maintains and tracks the regulatory report submissions
which includes all the runs required for the submission.

Metadata Report Extract: It enables you to view the complete lineage and relationship
between metadata.
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3 DGUSRR Application and Common Functionalities

This chapter, details on how to log into the DGUSRR application, and explains the common
features that are found across the modules of DGUSRR application. It describes the organization
of the user interface and provides step-by-step instructions for navigating through the application.

To avoid repetition, the common functionalities used in different modules of DGUSRR are
explained under the Common Functionalities section, taking Glossary as an example.

This chapter has the following sections:

e Logging in to OFS DGUSRR Application

e Common Functionalities

e Data Governance for US Requlatory Reporting Common Screen Elements

e Managing Data Governance for US Regulatory Reporting

3.1 Logging in to the DGUSRR Application

Once the application is installed and configured, you can access DGUSRR through the web
browser.

Access the DGUSRR application using the login credentials (User ID and password). The built-in
security system ensures that you are permitted to access the window and actions based on the
authorization only.

Financial Services Analytical Applications

ORACLE o
Langusge
User ID |
Password
1 acle and affilial

After logging into the application, the following window appears:

Oracle Financial Software Services 16


../../nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#common_functionality
../../nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#LOGGING_INTO_OFSDGS
../../nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#common_functionality
../../nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#DGS_common_screen_elements

User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

US-English v DGSUSER v

ORACLE’ Financial Services Analytical Applications

Object i il System C & |denfity
Select Applications
Financial Services Data Governance for US Requ... ¥ 4 m Common Tasks ~
Menu for Common Tasks
4 B common Tasks
» B Data Model Management » E Data Model Management » Unified Analytical Metadata
4 EI Unified Analytical Metadata Manage Data Model Define and maintain analytical metadata definitions
& Metadata Report .
» B Operations Metadata Report »|’#% Operations
Metadata Browser Generale Metadata Reports Tools for Data Cenler operalions
&ta Dala Govemance for US Regulalory Reporiing Ei'll‘l e —
Browse metadata lineage
Gty Data for US Regulatory Reporting
Data Governance for US Regulatory Reporting
v
About Oracle  Confact Us Legal Notices Terms Of Use  Your Privacy Rights Copyright © 2016 Oracle and/or its affiliates. All rights reserved.

Click the Data Governance for US Regulatory Reporting option in the Left Hand Side (LHS) of
the menu. The DGUSRR window appears.

(& Glossary Master Summary - Intemet Explorer - [m] X
ORACLE' Data Governance for US Regulatory Reporting glmereator | Thursday, November 10, 2016 About & Logout
Standards & Policies

Glossary 7 Help »

B SearchandFilter ©> Go | & Clear
D7 Name 7

El Glossary (3) | @ Add | Deete | [&] Export
E3 D Name Created By Created Date Maodified By Modified Date

[ 50988 Glossary reject DGSUSER 10-11-2016 GLMAPPROVER1 10-11-2016

[ 50803 Glossary test DGSUSER 10-11-2016 GLMAPPROVER1 10-11-2016

[J 11593 OFSAA Glossary DGSUSER 22-01-2016 DGSUSER 22-01-2016

< ] >
W
®100% ~

3.2 Common Functionalities

It is possible to modify, view, delete, and find dependencies of a Glossary, Control, Key Indicator,
Issue, and so on. Following sections explains how this is done, taking the example of a Glossary.
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3.2.1 Viewing a Glossary

You can view a Glossary at any given point. To view an existing Glossary, perform the following
steps:

1. Select the checkbox adjacent to the Glossary hame.
2. Click the ID to view the glossary details.

The Glossary Details window displays the details of the selected Glossary.

3.2.2 Deleting a Glossary

To delete an existing Glossary, perform the following steps:
1. Select the checkbox adjacent to the Glossary name.
2. Click Delete button from the tool bar. A confirmation dialogue appears

3. Click OK. The Glossary details are deleted.

3.2.3 Exporting a Glossary

Refer to section Exporting Records for details.

3.2.4 Searching and Filtering

The Search and Filter option in the user interface helps you to find the required information. You
can enter the nearest matching keywords to search, and filter the results by entering information
on the additional fields. Refer to section Managing Search and List page for details.

3.3 Data Governance for US Regulatory Reporting Common Screen Elements

This section describes the common screen elements of DGUSRR.

The following tables lists the various icons and buttons in the DGUSRR user interface:

Icon/Button Name Description

This Icon displays at the top right corner of a page. Click this

Help Help button to display information related to the page.
G co This button displays in all Search bars and performs the search
Er*} © function. Click this button to search the selected search criteria.
4 Clear Clear Search Click this button to clear the search fields to blank.

e When values displayed in the column of a matrix is lengthy, only
[':53.] Wrap \Wrap the first few characters are displayed. Click this button to wrap the
text in all columns of a matrix.

\When values displayed in the columns of a matrix are expanded,
[Z:-_ ] Unwerap Unwrap click this button to display full details of the text in all columns of a
matrix.
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When values displayed in a particular column or row are lengthy,
] Expand only the first few characters are displayed followed by the Expand
(22 p button, indicating that more text is available. Click this button to
expand the column or row for the complete text to view.
\When values displayed in a particular column or row are
|5 Collapse expanded, click the Collapse button in that column or row to
contract the displayed text.
This button displays at the lower left corner of the Details page.
Ed View More [View More Click this button to view additional details of a record such as
Documents, Workflow History, and so on.
E Hide Hide Click this button to hide additional details of a record.
. This button is present in some sections of the Details page. Click
@ or Section Expand this button to expand a section and display the fields.
ﬁ‘ E Section Collapse Click this button to collapse a section, which is already expanded.
. PS€ 1Al fields in the section are hidden.
Calendar Click this button to display the calendar. You can select a date
from the calendar.
This button displays on actionable sections of the Ul which do not
Clear display any pre-populated data. Click this button to clear the data
entered.
Save Draft Save Draft Click this button to save a draft version of a record.
[ Add Click this button to add a new record.
5] Delete Click this button to delete record.
Delink Delink Click this button to delink records.
&£ Edit Edit Click this button to edit the details of a record.
Export Click this button to export a record.
#1 Submit Submit Click this button to submit a record.
E Cancel Cancel Click this button to cancel an action.
[=] Approve Click this button to approve a record.
Reject Click this button to reject a record.
)| Link Click this button to link records
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3.4

34.1

| Close \ Close Click this button to close a page or window.

= Difference Click this button to view the difference

Managing OFSDGUSRR

This section describes how to manage the Oracle Financial Services Data Governance for US
Regulatory Reporting application. This applies to users across all modules of the application.
Some of the functionalities may be specific to the rights owned by a user.

This section discusses the following topics:

e Managing Inbox
e Managing Search and List Page

¢ Managing Details Page

Managing Inbox

The Inbox page displays all Tasks and Notifications of the logged in user. The Task IDs are
hyperlinks that enable you to view the contents of the task or notification. You can click the Task
ID to view its details and take action, if required.

This section covers following topics:

e Searching Inbox

e Reassigning Tasks

ORACLE' DataGovernance for US Regulatory Reporting dgsuser | Tuesday,October27,2015 ¢4 OFSAA [E) About jLogout

Inbox  Controls  Keylndicators ~ Process Monitoring  Issues & Actions  Admin
Inbox Help|

Search ) Clear |5 Go

Open Tasks mpleted Tasks Notifications Reassigned Tasks

B Inbox (1) | s Reassign |13
2 Task ID Task Name Entity Name Status Due Date Overdue By Received On Flag Entity Type

[ 12748 12729.Issue Identified - New issued assig... () test Open 19102015 Issues

There are four tabs in the Inbox of any user:

Open Tasks

This tab displays tasks received by the user which are yet to be completed.
Completed Tasks

This tab displays tasks which have been performed or completed by the user.
Notifications

This tab displays notifications sent to the user for information.

Reassigned Tasks
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This tab displays tasks which were not performed by the actual receiver and are reassigned to a
different user.

3.4.1.1 Searching Inbox

The Inbox page allows you to filter the tasks and notifications that you want to view and analyze.
This search is based on limited set of search criteria and helps to retrieve the relevant tasks and
notifications of the Inbox.

To search the Inbox, perform the following steps:

1. Loginto OFSDGUSRR.

2. Click Inbox. The Inbox page is displayed.

3. Click the Expand icon (+) in the Search field to display the details.
4

Enter the details in the fields to filter the list.

The following table provides the list of the search criteria that display in the Inbox Search

section:
Fields Description Fields Description
Task Name Enter the name of the task.
From Enter the name of the user from which task was generated
Due Date Select a condition from the drop-down list with the following
options:
<=
<=>
>=
Select a date from the calendar.
Entity Type Refers to a specific module in Data Governance

5. Click Go. The records meeting the criteria are displayed in the tabs of Inbox.

NOTE: If no records match the search criteria, the following message is displayed: No
records found for the selected search criteria.

3.4.1.2 Reassigning Tasks

This feature helps reassign certain task to a different user who is mapped to the same role as the
logged in user.

To reassign a task, perform the following steps:
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1. Login to OFSDGUSRR. The OFSDGUSRR Home page is displayed.
2. Click Inbox. The Inbox page is displayed.

3. Select atask and click Reassign. The Re-assign Task window is displayed.

ORACLE' DataGovernance for US Regulatory Reporting dgissasr | Thursday, November10,2016 #f; OFSAA About &1 Logout

Inbox Issues & Actions
Inbox Help A

Search Clear | Go

Open Tasks

Bl inbox (1) | 4% Reassign | [}F

Jask®) & Re-assign Task - Internet Explorer - x [BecevedOn__|Flag Eatiy,Typo

51373 1011112016 Issues
< = Role DGS Issue Owner Re- Assign To* =& ' >

| submit | | Back |

v

HI00% -

_— B —

4. Click the hierarchy browser icon beside the Re-Assign To box. The hierarchy browser is
displayed.

5. Select the appropriate user and click OK. The Re-assign Task window is displayed.

6. Click Submit. The following message is displayed: Update Operation Successful. Click OK.
The Re-assign Task window is displayed.

7. Click Back to return to the Inbox. The task is moved to the Reassigned Tasks section.

3.4.2 Managing Search and List Page

This section provides details about the components of the Search and List page, and describes
how to manage them.

This section includes the following topics:

e Components of Search and List Page

¢ Managing Pagination

e Exporting Records

3.4.2.1 Components of Search and List Page

The Search and List page displays the summary of all records and is sorted by the Last Modified
Date by default. It displays the total number of records, page number, and the total number of
pages in the search result.
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The Search and List page contains the following components:

Inbox  Controls  KeyIndicators  Process Monitoring  Issues & Actions  Admin
Issues Help
B Search | Clear T 6o

1) Hame
Issue Category | v‘ Component B Criticality

<y

Priority 7 | v| Creator B Owmer B
Target Date 5 (2 Last Modified From Z Last Modified To (2
Status !
[ Issues (6)
[ Create issue | 5} | | [ export 113
£ p Name Component Issue Category  Actions Creator Oumer TargetDate  Status  LastModified
01258 test2 o 0 dgissapr dgsuser 00c2015  Draf 18002015
[ 12728 testd e 0 dgissapr dgsuser 0002015 Open 19-0c-201
Masthead

The mast head displays at the top of the page and contains the menus of the application.
Navigation Path

The Search and List page and the Details page have navigation path to display the route taken
to reach the current page. Click any component of the navigation path to view the respective
screen.

Izzues =* |ssue Details

Search Bar
This section allows you to search and view records and their details.
List Header

The header contains the title and displays the total number of records. The header also provides
pagination with forward and backward arrows for advancing page by page or to the first or last
page.

Action Buttons

Action buttons are the tool bar buttons that enable you to perform various actions such as create,
delete, close, export and so on. These buttons are enabled or disabled based on the access
rights provided to the user and the operations that can be performed on the selected record.

NOTE: The actions buttons differ from module to module. Refer to the respective chapters for
more details.

Check Boxes

Check boxes are provided at the beginning of each row in the Search and List Page. You can
select one or more check boxes depending upon the action you take.

Column Headings

Column headings provide labels that depict the kind of information displayed in the columns. The
list of records can be sorted from the column headings.

To sort the records, perform the following steps:
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1. Navigate to the Search and List page.

2. Right-click on a column heading. A list of sorting options is displayed.

+= Sort Ascending
+= Sort Descending
= Clear Sort

X Group By Tree
B3 Group by Tab

iy Field Chooser

[E Transpose

3. Select the relevant sorting option. The records are sorted as per the selected sorting option.
4. Select Clear Sort to clear the applied sorting option.

The different sorting options are described as follows:

Sort Ascending

Upon selecting this option, the records are sorted in ascending order if the data is numeric. In
case of a text field, the data is sorted in alphabetical order. If the selected column is a date
column, then the data is sorted in chronological order.

Sort Descending

Upon selecting this option, the records are sorted in descending order if the data is numeric. In
case of a text field, the data is sorted in reverse alphabetical order. If the selected column is a
date column, then the data is sorted in reverse chronological order.

Clear Sort

Upon selecting this option, the applied sorting is removed and records are displayed in their
original order.

Group by Tree

Upon selecting this option, the records are listed in a tree structure under various values in the
column. You can click Close to close the grouping and view the normal List page.

NOTE: The Group by Tree option is enabled only for columns which have predefined values
from dim tables. They are not enabled for columns for which the data is captured in the
front end by the Business User. Also, these options are not available for columns with
distinct values like Name, Amount and so on.

Transpose

This option allows you to convert columns to rows. Upon clicking this option, the column headings
are arranged vertically, the records are displayed horizontally and the record details are displayed
vertically corresponding to each column. You can click Close to close the transposed view.

Field Chooser

Oracle Financial Software Services 24



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

This option allows you to enable or disable fields in a grid. The changes made are applicable for
future sessions of the logged in user alone and can be modified whenever necessary.

To sort by Field Chooser, perform the following steps:
1. Right-click on the column heading. A list of sorting menu displays.

2. Click Field Chooser. The Field Chooser window is displayed. The columns displayed are
selected by default.

ré Field Chooser - Internet Explorer | =, 8 X .|1
[ ] AutoFit &, W
] cColumns Control Width
TaskID 0 .
Task Name 220
Entity Mame 300
Status 130
Due Date 100
Overdue By 90 v
| OK | | Cancel | | Save |

Select the fields which you want to display.

4. You can increase or decrease the width of a column by modifying the Control Width value. To
change the position of the columns, select a column and click = or ¥ .

5. Click OK. The Field Chooser window closes and the selected columns are displayed.
Or

Click Save. The Field Chooser window closes and the selected columns are displayed. The
changes made are saved for the logged in user.

3.4.2.2 Managing Pagination

This feature helps manage a large number of records in a single grid. A limit is defined in each
grid as to how many records will be displayed at a time. If it is defined that only x number of
records will be displayed in a single page of the grid at a time, the rest of the records will be
displayed in the subsequent pages. These pages can be viewed by using pagination options.

1126 P»

e Click * toview the records in the next page.
e Click = to view the records in the previous page.
e Click * to view the records in the last page.

e Click %€ to return to the first page when you are in any other page.
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3.4.2.3 Exporting Records

The Search and List page allows you to export the listed records to a Microsoft Excel
spreadsheet. If any search criteria is applied, the values exported are restricted only to the search
result.

To export the records, perform the following steps:
1. Navigate to the Search and List page.
2. Click Export. The Export Details box is displayed.

B Export Details

Select Form Data/ Grid Data : [Form Data z]
Include Mapper Information: [ ]
Include Search Information: [ ]

Document Type : lWord V|

Template: [General Word Template | V|

Display Form Name: @) Yes ()No

| Export | | Cancel |

3. Select the appropriate options from the Export Details box.

Fields Description

Select Form Data/ Grid Data |Select Form Data or Grid Data from the drop-down list.

Include Mapper Information  [Check if you want to include mapper information in the report.

Include Search Information  |Check if you want to include search information in the report.

Document Type Select from Word or Excel from the drop-down list.

Template Select General Word/Excel Template from the drop-down list.

Select if you want to display the form name or not from Yes or No radio

Display Form Name buttons.

4. Click Export. The File Download box is displayed.
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File Download X

Do you want to open or save this file?

@ Mame: AlaxsServlet.xls
Hl ]

Type: Microsoft Office Excel 97-2003 Worksheet
From: 10.184.135.227

Open ] [ Save ] [ Cancel

Always ask before opening this type of file

harm your computer. |f pou do not trust the source, do not open or

g : While files from the Intemet can be useful, some files can potentially
save this Hle. 'What's the nisk?

5. Click Open. A Word file/ Excel spreadsheet is displayed, which consists of a compiled list of

all records.

3.4.3 Managing Details Page

This section covers the components of the Details page, and describes how to manage them.
The details page components may vary from module to module.

This section includes the following topics:

Components of Details Page

Managing Linkages

Managing Documents

3.4.3.1 Components of Details Page

The following sections describe the components found in the Details page:

Field and Data Types

The Details page of all modules has the following types of fields:

Text Box: This is an alphanumeric free-text field with a restriction of 300 characters.

Text Area: This is an alphanumeric free-text field with a restriction of 3000 characters. The
number of characters allowed for these fields displays in a box which is non-editable. The

count is updated based on the actual number of characters entered in the Text Area.

Hierarchy Browser: Some fields are provided with a hierarchy browser button, which displays

a list of values in hierarchical format. You can select the relevant value from the list.

Drop-down List: Some fields are provided with a drop-down button, which displays a list of

values. You can select the relevant value from the list.
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e Radio Buttons: Radio buttons are provided for fields where the user must select from two or
more options.

e Numeric Fields: These fields allow only numeric data to be entered. The different types of
numeric fields include:

o Number Field - You can enter up to 20 digits.
o Amount Field - You can enter up to 20 digits and 8 decimals
o Percentage Field - You can enter up to 3 digits

o Date: These fields are provided with calendar button which allows you to select a date. If you
click the Calendar button, a calendar of the current month is displayed with the current date

highlighted.
4 | October SR 4 (2015 )| »
1 2 3
4 B 8 T 2 -] 10
11 12 13 15 18 17
18 19 20 21 22 23 | 24
25 28 27 28 29 30 31
Close

¢ Mandatory Data Fields: Mandatory fields are fields which capture data that must be entered
by the user. All data fields that are marked with a red asterisk (*) are mandatory data fields.
Only when all of these fields have been completed, an entity can be submitted by the user for
further steps in the workflow. For example, the Owner field is mandatory for submitting a
record.

However, some fields are mandatory based on the data captured. If such fields are not
captured, an alert message displays, asking to capture the relevant fields.

Contextual Help

Contextual Help is offered at every field level in the User Interface screen, by providing a brief
description about the specific field. You can click to view the contextual help text. Contextual help
available for that field displays in a window box for a few seconds and closes automatically.

Issue Category | “
| Classification of the Issue.
Criticality | L
Tool Tip

You can refer to the Tool Tip to identify a task or action button. The Tool Tip displays when you
place the cursor over a button. In case of a button, it specifies the purpose of the button.
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[ Search [& Vijﬂ's | & Clear | &> Go | Save
N/

|Search using pre-defined views|
Issue Category ‘

&
Priority >
Target Date [ 7| >
Status §

}

3.4.3.2 Managing Linkages

OFSDGUSRR allows you to link and delink records of different modules. Linking and delinking
can be performed through the Linkages tab in the Details page. The entities which can be linked
vary from module to module.

The process of linking a control to an Issue is explained as follows. The same process can be
followed for linking any record to any entities applicable to a particular module of OFSDGUSRR.

Linking Records

To link a record to another, perform the following steps:
1. Navigate to the Search and List page of a module.
2. Select arecord. The Details page is displayed.

3. Click Linkages. The Linkages section is displayed.

Controls (0) | B Link | [ | ;]

Key Indicators (0) | B34 Link | [ | [

4. Click Link next to the record you want to link. The Search page displays.

Select one or more records from the list. You can also search the records by entering search
criteria in the search fields.

6. Click Link. The following message is displayed: Records Linked Successfully.
7. Click OK. The linked record is removed from the list.

8. Click Back to return to the Linkages section. The linked record is displayed in the Linkages
section.

Delinking Records

To delink a record, perform the following steps:

1. Navigate to the Search and List page of a module.
2. Select a record. The Details page is displayed.

3. Click Linkages. The Linkages section is displayed.
4

Select the record you want to delink. The Delink button gets enabled.

Oracle Financial Software Services 29



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

5. Click Delink. The following message is displayed: Are you sure you want to de-link the

records?

6. Click OK. The following message is displayed: De-link operation successful. Click OK. The
record is removed from the Linkages section.

3.4.3.3 Managing Documents

This section covers following topics:

e Attaching a Document

e Deleting a Document

The Details page allows you to attach or delete documents related to the module. You can attach
documents in the following formats:

e Microsoft Word

e Microsoft Excel

e PDF

e Text

Attaching a Document

To attach a document, perform the following steps:

1. Navigate to the Details page.

2. Click View More. The Documents section is displayed.

3. Click Attach Document(s). The Attach Documents window is displayed.

\g Attach Documents - Internet Explorer =X
Component* Issues
Type* v|

Logical File Name

Choose a file* Browse... |10 Attach File |

| cancel |

4. Enter the required details in the Attach Documents window. The following table describes the
fields in the Attach Documents window:

Fields

Description

Component

Displays the component name for which the document is uploaded. This is a
non editable field.
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5.
6.

Type Select the type of file from the following options in the drop-down list:
e Regulation

e Policy

e Documentation

e  Annexure

Logical File Name Enter the Logical File Name. It is a text field which supports alpha-numeric
characters.

Click Browse to choose a file from your computer.
Click Attach File. The following message is displayed: Add Operation Successful. Click OK.

The document is attached and listed in the Documents section.

Deleting a Document

The attached documents can be deleted if no longer required. You can delete a document only if
you have uploaded it. Documents attached by one user cannot be deleted by others.

To delete a document, perform the following steps:

1.

2
3.
4

o

Navigate to the Details page.
Click View More. The Documents section is displayed.
Select the document which you want to delete. The Delete Document button enables.

Click Delete Document. The following message is displayed: Are you sure you want to
delete this record?

Click OK. The following message is displayed: Delete Operation Successful.

Click OK. The document is removed from the Documents section.
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4 Obtaining the Business Glossary

4.1

4.2

This chapter explains the process of obtaining the business glossary.
This chapter includes the following topics:

e About Business Glossary

e User Roles and Actions

e Business Glossary Workflow

e Creating a Business Glossary

e Importing a Business Glossary from Standard Glossary Providers

About Business Glossary

Business glossary is a collection of business terms that provide definitions for common
terminologies and acronyms in business processes, accounting, finance, risk management and
other aspects of a financial organization. Primarily, a business glossary minimizes the
misunderstanding and confusion of business terminology and communications.

The benefits of a business glossary are:

e |t maximizes the understanding of the core business concepts and terminology of the
organization.

e It minimizes the misuse of data due to inaccurate understanding of the business concepts
and terms.

¢ It maximizes the accuracy of the results obtained as a result of search for business concepts,
and associated knowledge.

The OFSAA business glossary of comprises its entire ecosystem spanning risk, compliance,
performance and customer insight. It permits import and housing of other business glossaries into
OFSAA and also allows mapping of organization specific or industry standard glossaries to
standard OFSAA glossary.

User Roles and Actions

All the users are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP, along with their respective individual group.

Following are the user roles and actions for Glossary:

e Glossary Viewer: Permits the user to view the glossary. User needs to be mapped to
GLMVIEWERGRP group.

e Glossary Creator: Permits the user to create and maintain glossary objects. User needs to
be mapped to GLMCREATEGRP group.

e Glossary Owner: A user with this role has all the permissions/rights which a creator has to
his specific glossary. The user is responsible person for the glossary of the organization.
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Additionally, a user with this role receives all important ongoing notifications, emails and so
on regarding that glossary. User needs to be mapped to GLMOWNERGRP group.

e Glossary Approver: Permits the user to approve/reject glossary objects. User needs to be
mapped to GLMAPPRGRP group.

4.3 Business Glossary Workflow

Mew glossary

l

Saved as draft

|

Pending approval

|

Active glossary

4.4 Creating a Business Glossary

While defining a Glossary, the fields that are displayed are explained as tabulated.

NOTE: You should have Glossary Creator, or Glossary Owner rights to create a
glossary.

4.4.1 Fields and their Descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

D Identification number assigned to the glossary.

Name of the glossary
Glossary Name

Glossary Definition A brief description of the glossary

4.4.2 Procedure to Create a Glossary

Perform the following steps to create a glossary:
1. Navigate to the Glossary menu in the Standards and Policies tab.

2. Click Add. The Glossary Details page is displayed.
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ORACLE" DataGovernance for US Regulatory Reporting

Glossary

Glossary »> Glossary Details

Glossary Details ‘

save Draft | [ Cancel
Glossary Name* ID* 18016

Glossary Definition*

3. Enter the Glossary Name and Glossary Definition in the fields. The status of the Glossary
is New.

4. Click Save Draft. The status of the Glossary changes to Draft. A Confirmation dialog box is
displayed, with the message: Add Operation Successful.

5. Click OK.

6. Click Edit to review and update the fields, and Submit. A Confirmation dialog box is
displayed, with the message: Update Operation Successful.

7. Click OK. The glossary is created,and the Glossary status changes from Draft to Pending
Approval state.

45 Approving a Glossary

NOTE: You should have Glossary Approver rights to approve/reject a glossary.

To approve a Glossary perform the following steps:
1. Navigate to the Glossary menu, and select the glossary.

2. The status of the Glossary is displayed as Pending Approval.
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(& Glossary Master Details - Internet Explorer - [m] X
ORACLE" Data Governance for US Regulatory Reporting glmapprover! | Thursday, November 10, 2016 About | Logout
Standards & Policies

Glozzary >> Glossary Details Help

Pending Approval
Glossary Details
Glossary Name* Glossary reject ID* 50988 Approve Reject

Glossary Definition* Glossary reject
Reason for ApprovaliRejection* \

javascript: H100% ~

3. Provide areason, in the Reason for Approval/Rejection field.

4. Click Approve. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’

5. Click OK. The status of the Glossary changes to Active.

4.6 Rejecting a Glossary

NOTE: You should have Glossary Approver rights to approve/reject a glossary.

To reject a Glossary perform the following steps:
1. Navigate to the Glossary menu, and select the glossary.

2. The status of the Glossary is displayed as Pending Approval.
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Gloszary >> Glossary Details

Glossary Details

& Glossary Master Details - Internet Explorer - [m] e
ORACLE" Data Governance for US Regulatory Reporting glmapprover! | Thursday, November 10, 2016 About | Logout
Standards & Policies

Help

Status: Pending Approval

Glossary Definition* Glossary reject
Reason for ApprovaliRejection* \

javascript:

Glossary Name*  Glossary reject ID* 50988 [E Approve

Reject

H100% ~

3. Provide areason, in the Reason for Approval/Rejection field.

4. Click Reject. A Confirmation dialog box is displayed, with the message: Update Operation

Successful.

5. Click OK. The status of the Glossary changes to Draft.

4.7 Exporting a Glossary

To export a Glossary, perform the following steps:
1. Navigate to the Glossary menu, and select the glossary.

2. Click Export to export the glossary.

ORACILE" DataGovernance for US Regulatory Reporting

Inbox _ Standards & Policies  Controls  Key Indicators  Process Monitoring  Issues & Actions  Admin
Glossary

[ search and Filter ©>Go | & Clear

D Name

B Glossary (1) |E§Add | Delete

OFSAD | Tuesday, Augusts, 2017 % OFSAA [ About & Logout

Help

D Name Created By Created Date  ~ Modified By Modified Date

11593 OFSAA Glossary OFSAD 22-01-2016 OFSAD 22012016

=)

® 10.184.155.225:2233/OFSAAIL/export_properties_std.jsp?inf

[} Export - Properties - Google Chrome

Bl Export Details

Select Form Data/ Grid Data: Form Data v
Include Mapper Information :
Include Search Information :
Document Type : | Word v
Template : | General Word Template v
Display Form Name : @ Yes () No

Export | [ Cancel |

Status
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3. Select Form Data/Grid Data as Grid Data or Form Data.

4. Select Include Mapper Information if you want to include information about Mapper.
5. Select Include Search Information if you want to include search information.

6. Set Document Type as Word or Excel or PDF.

7. Select Display Form Name as ‘Yes’ if you want to display form name.

8. Click Export in the Export Properties dialog box to display the Glossary Master Summary.

Glossary Master Summary

Glossary

ID I Name Created By Created Date | Modified By | Modified Date Status

11593 OFSAA Glosgsary OFSAD 22-01-2016 OFSAD 22-01-2016 New
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5 Mapping the Business Terms

5.1

5.2

This chapter explains Business Terms and the process of mapping Business Terms.
This chapter includes the following topics:

About Business Terms

User Roles and Actions

e Business Terms Workflow

e Creating a Business Term

e Usage term
e Mapping Business Terms

About Business Terms

Business terms are individual terms present in a glossary. It includes a definition and several
attributes which provide a complete description of the glossary.

Additionally, Business Terms provide associated knowledge such as the user responsible for the
term, the associated metrics, correct usage of the term, related terms, list of possible values for
the term and so on. OFSAA Glossary includes all the terms related to risk, performance,
compliance and insight pre-packaged with all the relevant information in them

User Roles and Actions

All the users are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP along with their respective groups.

Following are the user roles and actions for Business Terms:

e Business Term Viewer: Permits the user to view the Business Terms. User needs to be
mapped to GLTVIEWERGRP group.

e Business Term Creator: Permits the user to create and maintain Business Terms. User
needs to be mapped to GLTCREATEGRP group.

e Business Term Owner: A user with this role has all the permissions/rights which a creator
has to his specific glossary. The user is responsible person for the glossary of the
organization. Additionally, a user with this role receives all important ongoing notifications,
emails and so on regarding that glossary. User needs to be mapped to GLTOWNERGRP
group.

e Business Term Approver: Permits the user to approve/reject Business Terms. User needs
to be mapped to GLTAPPRGRP group.
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53 Business Terms Workflow

MNew Business Term

l

Saved as draft

|

Pending approval

1

Active Business Term

5.4 Creating a Business Term

While defining a Business Term, the fields that are displayed are explained as tabulated.

NOTE: You should have Business Term Creator, or Business Term Owner rights to create a

glossary.

5.4.1 Fields and their descriptions

Fields Description
Fields marked in red asterisk(*) are mandatory
D Identification number assigned to the glossary
term.
Name Name of the Business Term
Definition A brief description of the Business Term
Glossary Select the Glossary from the drop-down box
Provide a reference text for additional
Annotate ) . )
information on Business Term
Provide the keywords used to search the
Keywords .
Business Term
Subject Area Select the subject area from the drop-down box.
Source Select whether the source is Internal or External
] Select whether the domain is Alphanumeric,
Domain .
Date or Numeric
= Select whether the glossary term is a critical
Critical Data Element
data element or not
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5.4.2 Procedure to Create a Business Term

Perform the following steps to create a Business Term:

Standards & Policies

Business Terms >> Business Term Help

Business Term ‘ Term Usage

1. Navigate to the Business Terms menu in the Standards and Policies tab.

2. Click Add. The Business Term page is displayed. The status of the Business Term is New.
(& Glossary Details - Internet Explorer - a x
ORACLE’ Data Governance for US Regulatory Reporting gltcreator | Thursday, November 10, 2016 About | Logout

Save Draft | [B Cancel

Subject Area* ‘ Vl

Definition

Glossary* ‘ v

Annotate

Keywords

>

Name | ID* 51675

Source* ‘ vl Critical Data Element  (yes @ No v}
r

H100% ~

5.5

10.

Enter the required information in the fields.
Select whether the Business Term is a Critical Data Element.

Click Save Draft. A Confirmation dialog box is displayed, with the message: ‘Add Operation
Successful.’

Click OK. The status of the Business Term changes to Draft.
You can view the related Business Terms, and link or delink the terms.
You can select the List of Values, and Add or Delete the values.

Click Edit to review and update the fields and Submit. A Confirmation dialog box is
displayed, with the message: Update Operation Successful.

Click OK. The Business Term is created,and the status changes from Draft to Pending
Approval state.

Approving a Business Term

NOTE: You should have Business Term Approver rights to approve/reject a Business Term.
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To approve a Business term, perform the following steps:

1. Navigate to the Business Term menu under Standards and Policies tab, and select the
Business Term.
2. The status of the Business Term is displayed as Pending Approval.
| (& Glossary Details - Intenet Explarer - [m] s
ORACLE' DataGovernance for US Regulatory Reporting gitcreator | Thursday, November 10, 2016 [ avout & Logout
Standards & Policies
‘EusmeesTerms >> Buginess Term Help
New
[ Business Term Term Usage
Keywords A
Subject Area® ‘ v|
Source* ‘ vl Critical Data Element  (Jyes @ No
Domain® ‘ v| —
= Related Business Items [] |
e D Name Glossary
No Data Found
< >
[ List of Values [] |
& [ Listof Value
No Data Found
< > v
- mn‘w‘no% -
3. Provide areason, in the Reason for Approval/Rejection field.
4. Click Approve. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’
5. Click OK. The status of the Business Term changes to Active.
5.6 Rejecting a Business Term

NOTE: You should have Business Term Approver rights to approve/reject a Business Term.

To reject a Business Term, perform the following steps:

1.

Navigate to the Business Term menu under Standards and Policies tab, and select the
Business Term.

The status of the Business Term is displayed as Pending Approval.
Provide a reason, in the Reason for Approval/Rejection field.

Click Reject. A Confirmation dialog box is displayed, with the message: Update Operation
Successful.

Click OK. The status of the Business Term changes to Draft.
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& Glossary Details - Internet Explorer

Standards & Policies

Business Terms >> Business Term

Business Term Term Usage

ORACLE' DataGovernance for US Regulatory Reporting

gitapprover

| Thursday, November 10, 2016

Status:

About & Logout

- o X

Help
Pending Approval

Name* business term reject

Definition

Glossary™ Glossary test
Annotate business term reject

‘ Keywords

business term reject

business term reject

Subject Area* Compliance
Source®  External
Domain* Date

ID* 50996

Critical Data Element No

Reason for ApprovallRejection” [rgject

] Related Business ltems [] Link | Defink

[ Approve

Reject

) Name

[ 22225 Otc Indicator

Delete &

B List of Values [ Add |

Glossary
OFSAA Glossary

javascript:

5.7

Exporting a Business Term

To export a Business Term, perform the following steps:

1. Navigate to the Business Term menu under Standards and Policies tab, and select the

Business Term.

2. Click Export to export the Business Term.

%1 OFSAA About ] Logout

ORACLE" Data Governance for US Regulatory Reporting ORSAD. I, iTnenay, At 2011
Inbox _Standards & Policies  Controls  Key Indicators  Process Monitoring  Issues & Actions  Admin
Business Terms Help
B search and Filter &> Go | & Clear
D Term
Subject Area Status
Glossary
B Business Terms (7057) I[g§Add | Delete Export to PDF 11283 > »
D Term Critical Data Element Subject Area Domain Source Status Glossary
Option Margin Requirement- Local Currency Yes Account Amount Interal New OFSAA Glossary
Margin Balance- Local Currency Yes Account Amount Interal New OFSAA Glossary
Cash Balance- Local Currency Yes - — = N New OFSAA Glossary
[} Export - Properties - Google Chrome |
Margin Market Value Long- Local Currency Yes ol New OFSAA Glossary
S iRaY 5
Margin Market Value Short- Local Currency Yes OHAbA8A155225 New OFSAA Glossary
Total Cash And Security Value- Local Currency Yes B Export Details New OFSAA Glossary
Money Market Fund Balance- Local Currency Yes Select Form Datal Grid Data: | Form Data v New OFSAA Glossary
Margin Equity- Local Currency Yes Include Mapper Information : New OFSAA Glossary
Total Debt- Local Currency Yes IntlideSeprelbinformation: New OFSAA Glossary
: v
Uncleared Balance Amount- Local Currency Yes e New OFSAA Glossary
Template : | General Word Template v
Overdraft End Of Period Balance- Local Currency ~ Yes SRR e New OFSAA Glossary
Last Overdraft Negative Balance Amount- Loca Yes New OFSAA Glossary
Net Colateral Value- Local Currency Yes New OFSAA Glossary
Collateral Requirement- Local Currency Yes New OFSAA Glossary
273845 Account Gross Assets- Local Currency Yes New OFSAA Glossary

Ledger Balance- Local Currency Yes ) New OFSAA Glossary
Death Value Amount In Reporting Currency Yes New OFSAA Glossary
Initial Deposit Amount In Reporting Currency Yes e Rount e New OFSAA Glossary
Policy Fee Amount In Reporting Currency Yes Account Amount Internal New OFSAA Glossary
Premium Amount In Reporting Currency Yes Account Amount Internal New OFSAA Glossary
Outstanding Balance Of Loan Linked To The P... (53] Yes Account Amount Internal New OFSAA Glossary

© Oracle. All rights reserved

3. Select Form Data/Grid Data as Grid Data or Form Data.
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5.8

58.1

5.8.1.1

4. Select Include Mapper Information if you want to include information about Mapper.
5. SelectInclude Search Information if you want to include search information.

6. Set Document Type as Word or Excel or PDF.

7. Select Display Form Name as ‘Yes’ if you want to display form name.

8. Click Export in the Export Properties dialog box to display the Glossary Summary.

9. Click Export to PDF to export the glossary in PDF format with the following details:

= Definition

= Domain
= Usage
Usage Term

The definition of Business Terms is generally designed to produce a common understanding of
the meaning of the term, for the entire organization irrespective of the business function. These
are standard definitions and do not really define the usage of the term in a specific context.
Usage Term of Business Terms explains the terminology in the context of its usage. A
terminology can have one or more usage terms based on the number of use cases that it is
applicable for in the organization. Each usage of that particular term has its own explanation of
how and why it is used, along with the list of values for that specific context.

OFSAA business glossary provides standard and complete Usage Term for each Business
Term.

Creating a Usage Term

NOTE: User can create Usage Term for Business Terms which are in the Draft stage.

While defining a Usage Term, the fields that are displayed are explained as tabulated.

Fields and their Descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

Name Related to other glossary identifiers (multiple
contextual definitions for the glossary term)

Content Definition Contextual definition of the glossary term from

perspective of source or application

Usage Term Name Provides the name of the usage term
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Fields

Description

Fields marked in red asterisk(*) are mandatory

Scope It is the name of the context in which the term is
used
Context ID It is a system generated number

5.8.1.2

Perform the following steps to add a Usage Term:

Procedure to Create a Usage Term

1. Navigate to the Business Terms search and list page in the Standards and Policies tab.

2. Select a Business Term in Draft state. Click the Term Usage tab.

3. Click Add.

(& Usage Term - Internet Explorer

Inbox Standards & Policies Controls Key Indicators

Business Terms >> Business Term

Business Term Term Usage

ORACLE" DataGovernance for US Regulatory Reporting

Process Monitoring

Issues & Actions Admin

dgsuser | Thursday, November 10, 2016

- o x

5 OFSAA About & Logout

Help
Draft

Name* business term reject

Definition business term reject

E Usage Term [ Add | @ Delete

ID* 50996

& | ContextID
[ 51023

Usage Term Name Scope

S5558555558 ALM

Definition

e . 1

HqI100% -

4. A webpage dialog box is displayed. Enter the required information in the fields.
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e

| ORACLE' DataGovernance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 5 OFSAA About | Logout
Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin
Buginess Terms >> Business Term Help
Draft ||
T
& Contextual Definition - Internet Explorer - L
Na Usage Term Name * Business TermID 50996

Defi

Bl Usage Term [T Add | Context Definition
Context ID
[ 51023

List of Values [£] Add | [ Save | @ Delete |[F]

| Save \ \ Close

H100% ~

5. Select the Context Name, and provide the Contextual Definition.

6. Click Save. A Confirmation dialog box is displayed, with the message: Add Operation
Successful.

7. Click OK. You can view the Usage Term in the Search and List page.

5.9 Mapping Business Terms

This process involves mapping a term in a glossary to another term in a different glossary. Terms
in one glossary are mapped to similar, or related terms in another glossary to achieve
consistency and standardization. While organizations use their own terminology, it is essential for
them to map their terminologies to industry standard terminologies. This ensures completeness
and consistentency in communication with external parties and regulators.

Following are the steps to map business terms with other business terms:

1. Select a business term in draft status.

2. In Related Business Term Grid, Click Link. This displays a new window with all the

Business Terms in the system except the current Business Term.

3. Select the checkbox adjacent to the Business Term and click Link.
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Details - Intemet Explare - o x
| ORACLE' Data Governance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 55 OFSAA About & Logout
Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin
Buginess Terms >> Business Term Help
Draft
2 Related Glossary Map - Intemet Explorer - X

Business Term T Usage
bl

Definition bUSi 7 Glossary Terms (740) 1168 >
Glossary* Glos]

Annotate busi £ ] Name Subject Area Glossary Definition Last Assessed  Status Glossary

Keywords  busi [] 22222 Customer Nu... Master Data This term refers to a unique code to identify cus.. New OFSAA Glossary

[0 22223 Sale Price Master Data This term refers to the price at which the instru... New OFSAA Glossary

SubjectArea® Com| [] 22224 Source System Master Dala This term refers to the source system from whe. New OFSAA Glossary

Source* Exel [ 22226 Squared-Off P. Master Data This terms refers to the flag which indicates wh New OFSAA Glossary

Do Galg [] 22227 Trading Book ... Master Data This term refers to the Flag which identifies wh... New OFSAA Glossary

[] 22228 Coupon Rate ... Master Data This term refers to the Coupon Rate of all coup... New OFSAA Glossary

= Related Business ltems [0 Link | O 22229 Swap Rate Master Data This term refers to the interest rate applicable t New OFSAA Glossary

D Name O 22230 Sovereign Rati Master Data This term refers to the rating of the sovereian of New OFSAA Glassary

[ 22225 Otc Indical [] 22231 underlying Ins. Master Data This term refers to the instrument code of the u Mew OFSAA Glossary

[] 22232 Cds Recovery ... Master Data This term refers to the recovery rate of the credit. New OFSAA Glossary

B Listof Values B Add | @ Delete [ 22233 Repo Limit Master Data This term refers to the limit in terms of percent ... New OFSAA Glossary
<k [ Listof Value e — wil

Link Close

O

® Oracle. All rights reserved

4. A success message is displayed. Click OK. Click Close.

§ _ x B
0 e o st Eltonos
suictpren
Inbox Stand
! - Glossary
Business Terms Help
= Glossary Terms (740) 1168 > Draft
& D Name Subject Area Glossary Definition Last Assessed  Status Glossary
Business Ter|
O 22222 Customer Nu. Master Data This &7 Information - Webpage Dialog % OFSAA Glossary
| (& edit | (4 [ 22223 Sale Price Master Data This OFSAA Glossary ~
[ 22224 Source System Master Data This OFSAA Glossary
[ 22228 Squared-OffiP...  Master Data This % [11899] Add Operation Successful OFSAA Glossary
O 22227 Trading Book | Master Data This OFSAA Glossary
[ 22228 Coupon Rate Master Data This = OFSAA Glossary
‘Swap Rate Master Data This ‘OFSAA Glossary
[ 22230 Sovereign Rali.. Master Data This term refers to the rating of the sovereign of ... New OFSAA Glossary
O 22231 Underlying Ins. Master Data This term refers to the instrument code of the u. New OFSAA Glossary
0 22232 Cds Recovery Master Data This term refers to the recovery rate of the credit New OFSAA Glossary
[ 22233 Repo Limit Master Data This term refers to the limit in terms of percent . New OFSAA Glossary
Cunk ] [cise | ’
Bl Related Bus|
C AN Name Glossary
[ 22225 Otc Indicator OFSAA Glossary
B Listof Values 5] Add | @ Delete ¥
£ [ Listof Value
[[] 5555555555555555555555555555 v
© Oracle. All rights reserved

5.10 List of Values

List of Grid enables the user to add some values to the corresponding Business Term.
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Inbox  Standards & Policies

Busine:

Business Term |
L
| @ edit | & cancel

Subject Area*
Source*

] Related Business items [G Link | @ Delink

E: D

No Data Found
<

B List of Values F3J Add

ns >> Business Term

Name* Materiality Flag

Definition
Glossary"

Annotate
Keywords

Domain*

Name

@ petete

Controls

KeyIndicators  Process Monitoring  Issues & Actions  Admin

D* 191016

Employee

Critical Data Element No

Frequency

Glossary

(& Add List of Values - Internet Explorer

[] List of Value
No Data Found

Glossary ID: 191016
List Of Value:*

| —
[(save | [close ]

OFSAD |

Monday, March 27, 2017

1 OFSAA About & Logout

Help
Draft
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6 Identifying the Critical Data Elements

This chapter explains the process of identifying the critical data elements. It includes the following
topics:

e About Critical Data Elements

e User Roles and Actions

e  Workflow of Critical Data Elements

e Creating a Critical Data Elements

6.1  About Critical Data Elements

Critical Data Elements are Business Terms, which are critical for a specific business process.
These terms and their values are vital and significant for specific processes. For example,
regulatory reporting or management reporting.

These data elements are marked critical with their context, justification, level of criticality and
approval for the classification. They are ensured to have additional rigor in their data quality
checks, controls, and so on and have sufficient metrics around it to ensure timeliness and
accuracy of the values.

Critical Data Elements (CDEs) are defined for each report in Regulatory Repoting. DGUSRR wiill
contain all CDEs for a particular report. List of Critical Data Elements are identified for a particular
report and level of criticality will be defined and is stored in the FSI GL CDE DETAILS table.
These elements are monitored for accuracy and consistency of data within Key Indicator and
Control section.

6.2 User Roles and Actions

All the users are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP, along with their respective following groups.

Following are the user roles and actions for critical data elements:

e Critical Data Elements Viewer: Permits the user to view the critical data elements. User
needs to be mapped to CDEVIEWERGRP group.

e Critical Data Elements Creator: The user is responsible for classification and maintenance
of critical data elements. User needs to be mapped to COECREATEGRP group.

e Critical Data Elements Approver: The user is responsible for approval and rejection of
critical data elements. User needs to be mapped to CDEAPPRGRP group.

e Critical Data Elements Owner: A user with this role has all the permissions/rights, which a
creator has to his specific critical data elements. The user is responsible person for the
critical data elements of the organization. Additionally, a user with this role receives all
important ongoing notifications, emails and so on regarding those critical data elements. User
needs to be mapped to CDEOWNERGRP group.
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6.3 Workflow of Critical Data Elements

Mew Critical Data Element

l

Saved as draft

|

Pending approval

|

Active Critical Data Element

6.4 Creating a Critical Data Element

While defining a CDE, the fields that are displayed are explained as tabulated.

NOTE: You should have CDE Creator rights to create a CDE.

6.4.1 Fields and their descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

ID Identification number assigned to the CDE
Entity Name Provide the Entity name
Attribute Name Provide the Attribute name

Enter the access level, whether public,
Access Level ) ) )
confidential or restricted

o Select the data classification level, whether
Data Classification Level . )
Legal, Financial, PHI or PII

Business Term Select the Business Term

L Provide justification for classifying the
Justification )
Business Term as a CDE

CDE Name Provides the name of the Critical data Element

NOTE: Entity Name and Attribute Name can only be added if CDE is in Draft status.

Oracle Financial Software Services 49


../AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Work/DM%20Pack/DM_Release_801/DGS/ofs_ug_dgs_8.0.htm#50556971_BABCJBGD

User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

6.4.2 Procedure to Create a Critical Data Element

Perform the following steps to create a CDE:

1. Navigate to the Critical Data Element menu in the Standards and Policies tab.

2. Click Add. The Critical Data Element Details page is displayed.

& Glossary CDE Details - Intemet Explorer

Inbox Standards & Policies Controls Key

Critical Data Element >> Critical Data Element Details

Critical Data Element |

ORACLE" DataGovernance for US Regulatory Reporting

Indicators Process Monitoring Issues & Actions

Admin

dgsuser | Thursday, November 10, 2016

- o X

5 OFSAA About & Logout

Help
New

save Draft | [# Ccancel
CDE Name™

D"

Access Level

vl Data Classification Level*

Business Term™

Justification”

= Entity Attribute Details [

=&

51685

/[ Logical Entity
No Data Found
<

Logical Attribute

Physical Entity

Physical Attribute

® Oracle. All rights reserved

3. Enter the required data in the fields.

4. Inthe Justification field, provide a justification for classifying the Business Term as CDE.

5. Click Save Draft. A Confirmation dialog box is displayed, with the message: ‘Add Operation

Successful.’

6. Click OK.

7. Click Edit to review and update the fields and click Submit.. A Confirmation dialog box is
displayed, with the message: ‘Update Operation Successful.’
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a
ORACLE" Data Governance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 6 OFSAA About ]| Logout
|
Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin
Critical Data Element >> Critical Data Element Details Help
Draft

Critical Data Element

| (& Edit | [ cancel
CDE Name* | €
CDEName cde reject
Access Level® 1
Business Term* } .
Entity Name*  [sssessment Group Dimension For M - | 2
Justification® 1 Attribute Name®™  [Assessment Group Name =S
| save | | close |

B Entity Attribute Details A

(1| Logical Entity &) Information -- Webpage Dialo X

Pag £l
[] Assessment Type Dimg
% [12194] Update Operation Successful
Lok |
© Oracle. All rights reserved

8. Click OK. The CDE is created,and the status changes from Draft to Pending Approval state.

6.5 Approving a CDE

NOTE: You should have CDE Approver rights to approve/reject a CDE.

To approve a CDE perform the following steps:
1. Navigate to the Critical Data Element menu, and select the CDE ID.

2. The status of the CDE is displayed as Pending Approval.

ORACLE' DataGovernance for US Regulatory Reporting

deapprover | Wonday,Apri 18,2016 [ About {8 Losout

Standards & Policies

jcal Data Element > Critical Data Element Detsils

Pending Approval

Data Classific

Reason for ApprovalRejection”
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3. Provide areason, in the Reason for Approval/Rejection field.

4. Click Approve. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’

| OF\’ACLE’ Data Governance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 % OFsan  [E About & Logout

Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin

Critical Data Element >> Critical Data Element Details Help
Draft

Critical Data Element

| (& Edit | [ cancel
CDE Name* | &
CDE Name cde reject
Access Level* 1
Business Term™

Entity Name™ |sgsessment Group Dimension ForMu - | 2>
Justification* 1 Attribute Name”™  |sssessment Group Name &
\ Save \ | Close \
[ Entity Attribute Details A
[]| Logical Entity &) Information -- Webpage Dialog x

[] Assessment Type Dimé

a [12194] Update Operation Successful

@ Oracle. All rights reserved

5. Click OK. The CDE is approved and the status changes to Active.

6.6 Rejecting a CDE

To reject a CDE, perform the following steps:
1. Navigate to the Critical Data Element menu, and select the CDE ID.
2. The status of the CDE is displayed as Pending Approval.

3. Provide areason, in the Reason for Approval/Rejection field.
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& Glossary CDE Details - Internet Explorer - m} x
ORACLE" Data Governance for US Regulatory Reporting cdeapprover | Thursday, November 10, 2016 About ]| Logout
Standards & Policies

Critical Data Element >> Critical Data Element Details Help
Pending Approval

Critical Data Element

[l Approve | Reject
CDE Name™ cde reject

D" 51030
Access Level* Confidential Data Classification Level* Legal
Business Term® Account Internet Facility Flag
Justification* cde reject
Reason for [reject
ApprovalRejection*
[ Entity Attribute Details [7] hd
e [] Logical Entity Logical Attribute Physical Entity Physical Attribute
[[] Assessment Group Dimension For Multi Loci Assessment Group Name: DIM_ASSESSMENT_GROUP_MLS V_ASSESSMENT_GROUP_NAME
O Type Dimension A ment Type Code: DIM_ASSESSMENT_TYPE V_ASSESSMENT_TYPE_CODE
javascript:

#100% -

4. Click Reject. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’

5. Click OK. The CDE is rejected and the status changes to Draft.
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2

7.1

7.2

Identifying the Controls

This chapter explains the process of identifying the runs.

This chapter includes the following topics:

About Controls
DQ Check and Controls

e User Roles and Actions

e Creating a Control

e Assessing a Control

e Raising Issues on Control

e Closing a Control

About Controls

A Control is a measure taken to mitigate a regulatory reporting risk. Control measures help an
organization to avoid the risks which may otherwise hamper business due to inconsistentcy in
reporting. Controls are defined to ensure that the data elements used for various business
processes are accurate in value and obtained in time.

The controls identified for risk mitigation can be recorded and stored in a repository. This section
helps how to capture Controls, and assess their effectiveness in avoiding the risks pertaining to
reporting.

Control effectiveness establishes the confidence factor on data elements and its values.

The two types of Controls are listed as follows:

e Quality Controls: They are used to assess the data accuracy.

e Operational Controls: They are used to assess the availability and timeliness of data
elements.

Controls are defined on data elements based on the defined DQ rules. The effectiveness of these
controls can be automatically assessed based on the DQ execution facts.

NOTE: A Control user should be mapped to the Issue Creator group in addition to other
Control related groups, to create an Issue.

DQ Checks and Controls

Controls are defined on data elements based on the defined DQ rules. The effectiveness of these
controls can be automatically assessed based on the DQ execution facts.

NOTE: A Control user should be mapped to the Issue Creator group in addition to other
Control related groups, to create an Issue.

Following are the types of Data Quality Checks and their definitions:
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Data Quality Check Definition

Blank Value Check Blank Value Check identifies if the base column is

blank without any values considering the blank
space.

Column Reference/Specific Value Check Column Reference / Specific Value Check compares

the base column data with another column of the
base table or with a specified direct value using the
list of pre-defined operators.

Data Length Check Data Length Check checks for the length of the base

column data using a minimum and maximum value,
and identifies if it falls outside the specified range

Duplicate Check Duplicate Check can be used when a combination of

column is unique and identifies all the duplicate data
of the base table in terms of the columns selected
for the duplicate check

List of Value Check List of Value/Code Check can be used to verify

values where a dimension/master table is not
present. This check identifies if the base column
data does not matches with any value or code

specified in a list of values.

NULL Value Check Null Value Check identifies if ‘NULL’ is specified in

the base column.

Referential Integrity Check Referential Integrity Check identifies all base column

data, which has not been referenced by the selected
column of the referenced table. Here, the reference

table and columns are user specified.

Range Check Range Check identifies if the base column data falls

outside a specified range of Minimum and Maximum

value.

7.3

Controls are specific to reports. DQs are defined in the DQ CHECK MASTER and
DQ GROUP MAPPING table.

DQ rules are defined on the basis of Stage Table and Column mapped to a particular report.

Operational Control

Operational Controls will be created for each of the unique tasks available for a Run.

Batch ##INFODOM## CREATE OP CONTROLS needs to be executed for any date to create the
Operational Controls based on the Tasks available at that point of time in the system.
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7.4

7.5

If new tasks are added, then this batch is required to be executed again to create the new
operational controls. There will not be any effect on the existing controls.

FSI CONTROL table stores the list of controls created. Operational controls can be identified with
N_CONTROL TYPE KEY=10002. All the tasks and operational controls mapping will be stored in
table -FSI OP CONTROL TASK MAP.

User Roles and Actions

All the users are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP, along with their respective individual group.

The user roles defined in the Controls section of the DGUSRR application are:
e Control Owner: Permits the user to create, view and maintain controls.
The Controls section allows you to perform the following actions:

e Creating Control: Allows the user to create a new Control. The user can attach or delete
documents. The user needs to be mapped to DGCOGRP group.

¢ Assessing Control: Allows the user to assess the effectiveness of a Control.

e Closing Control: Allows the user to close a Control in Open status and that is not in use.
o Deleting Control: Allows the user to delete a Control in Draft status.

e Exporting Control: Allows the user to export all the controls.

e Viewing Control: Allows the user to view the controls. The user needs to be mapped to
DGCOVIEWGRP group

Creating a Control

While defining a Control, the fields that are displayed are explained as tabulated.

NOTE: You should have Control Owner rights to create a Control.

7.5.1 Fields and their Descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

ID Displays the unique auto-generated D for the control

Name Provide a short description or name for the control

Description Provide a long description of the control to indicate the purpose and nature of
the control

Owner Select the user responsible for overseeing the control
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Fields

Description

Fields marked in red asterisk(*) are mandatory

Type Select the control type from the drop —down box. Quality Control, Operational
Control
Comments Provide additional information about the Control

Assessment Start Date Displays the date when the assessment is going to start

Frequency Select the frequency of assessment from the drop-down box: Daily
Assessment, Monthly assessment.
Methodology Select the methodology from the drop-down box: OFSAA Methodolgy

7.5.2 Procedure to Create a Control

This section details the procedure to create a control using Batches.

7.5.2.1 Control Creation via Batches

Perform the following steps to create a Control via Batches:

1. For control creation, FSI_DGS_CONFIGURATION table has to be seeded first. User needs
to set the frequency too.

£ V_MODULE_NAME V_LOOKUP_CODE |N_LOOKUP_VALUE V_LOOKUP_CODE_DESC
b |CTL COMMENT The control has been newly created by system| Default Comments
CTL CREATOR DGSUSER User who created this control
CTL LOCALE en_us English
CTL OWHER DGSUSER User to whom this control is assigned
CTL UPDATE_COMMENT |DQ Updated - Updation Comments

2. Once config table is seeded then following batch has to be executed, which will create the
Controls for the available DQs - Batch - #INFODOM##_CREATE_CONTROL.

3. Check FCT_CONTROL and FSI_CONTROL_DQ_MAP tables once batch is successfully

executed.

Error Profiling

1. Execute the DQs and check the Result Summary and Details.

2. Run the Batch - #INFODOM##_REFRESH_MAT_VIEWS, which will refresh all the required
Materialized Views.

3. Execute - Batch - ##INFODOM## LOAD_FSI_ERROR_DATA_PROFILE. This will load the
data into FSI|_ERROR_DATA_PROFILE table.
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7.5.3

4. Execute — Batch - ##INFODOM## LOAD_FSI_ERROR_DATA. This will load data into
FSI_ERROR_DATA table.

NOTE: This step is not required to be executed for current release.

* FSI_ERROR_DATA_PROFILE table is used for Error Profiling.

Control Execution Details
Following are the steps to perform control execution:

1. Once FSI_ERROR DATA PROFILE and FSI ERROR DATA tables are populated, execute
the Batch ##INFODOM## LOAD FSI CONTROL EXEC DETAIL.

2. This will load data into FSI CONTROL EXECUTION DETAILS tables, which will be used by
DGUSRR Ul to display the required execution details for a control.

NOTE: All the batches require FIC_MIS_DATE while executing. If wrong FIC_MIS_DATE is
given it may result to data corruption.

All the batches should be executed in the same sequence as mentioned above.

Assessment Parameter Maintenance

Navigate to the Menu > Admin > Control Assessment Parameters. The maintenance has a list
of seeded parameters, which are dependent on the Data Quality Framework of OFSAAI. The
outputs associated to these parameters are derived at run time based on the Data Quality
Profiling information within Data Governance for US Regulatory Reporting. The screen also
enables a user define new Assessment Parameters that can participate in the Score and Rating
calculation of Assessment. Assessments for a particular control depends on the Parameter Type
and Score Methodology.
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(& Control Execution Summary - Intemet Explorer - [m] X

ORACILE' DataGovernance for US Regulatory Reporting dgsuser | Thursday, November 10,2016 #f; OFSAA About | Logout

Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin
Control Assessment Parameters Help

El Control Assessment Parameters (3) | [F] Add Parameter | 5] Save | [ Score Specification | @ Delete Parameter | [:F]

= []| Parameter Name Weight Score Methodology Parameter Type
O —
[] Mumber of DQ checks that the data element goes through 1
[] Percentage of error flags (from all DQs put together) 2

*Minimum Weight of Fact
Parameter

H100% ~

7.5.3.1 Parameter Type

e Inference

A parameter defined as Inference is assumed to have minimum impact on the assessment of
a control (during score/rating calculation for a Control).

e [Fact

A parameter defined as Fact is supposed to have more weight during score calculation of a
control.

7.5.3.2 Score Methodology

There are two methodologies, which are used simultaneously during Assessments of a control.
a. Range based

This method helps to define specific ranges and score against each range at a parameter
level.

b. Value based
This method helps to define a specific value and score against a Parameter defined as Value
based.

Basically, we use Inference/Fact parameter type to provide weights to the parameters.

Minimum Weight of Fact Parameter is shown in Ul so user has to put greater than or equal value
of that and the weight value of Inference parameter type is less than minimum values of Fact.

Validations

o Sum of weights of all parameters should not be greater than 100.
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e Overlapping ranges should not be allowed in Score Specification for score method “Range

Based”
ORACLE’ DataGovernance for US Regulatory Reporting dgsuser | Friday, January 22, 2016 @ ofsan (B About & Logout
Inbox  Sta icies  Controls » Monit
Co .
=] eters (4) | (] Add Parameter | B Save | [ Score Specitcation

matthe gata element goes trough

om ail DO puttogether

Once parameters are created and ranges are specified, add values for the same parameter in
table - FSI_CONTROL_USER_PARAM_VALUES. This table captures the Assessment
parameter values at the control level. User is supposed to enter values in this table. Assessment
calculation mechanism will pick data from this table and utilize the inputs in the score calculation
of Assessment for a control or for multiple controls at run time.

n_control_key Refers to n_control_key column of FCT_CONTROL
d_fic_mis_date Date on which Parameter value is generated.
n_param_id V_ID column of £si control assessment admin
v_value Expected Value of a Parameter

The parameters can be defined as Inference Based/Fact Based.

7.5.4 Control Assessment

Assessment can be done for Controls (data elements) using an ICC batch. This provides
flexibility to trigger assessments of all the Controls in one go based on the frequency as defined
in FSI_CTL_FREQUENCY table. This Frequency can be setin FSI_DGS CONFIGURATION table.
The parameter information (definition/Values) present above are all utilized during batch
execution of Control Assessments.

7.5.4.1 Quality Control Assessment

Pre-Requisite
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e For doing Control Assessment, Control Execution Details should be present.

e Execution Details can be DQ related or User Defined Parameters related.

e DQrelated parameters will be available by default if DQ executions are done for that

control.

Generate Assessments

Once all the pre-requisites are met, execute the batch — Create_Control_Assessment for a given

FIC MIS_ DATE.

Once the Assessment batch is triggered, user can see the assessment IDs that are generated in
the User Interface of Data Governance for US Regulatory Reporting. The backend engine
generates Assessment Start Date as the date on which batch is triggered and the Frequency of
Assessment is defaulted to Monthly. Assessment Frequency and Assessment Start date together
decide whether the assessment has to be done for a control or not.

The default frequency that is used is configurable and can be adjusted in the following table:

fsi dgs configuration

1. Navigate to Controls module in DGUSRR.

2. Click the Control against which Assessment is expected. The Assessment tab will show a
unique Assessment Id along with Score, Rating and Status of the Assessment.

3. Click the Assessment ID to view the Assessment Parameter details and Assessment Data

Quiality Execution details.

(& Controls - Internet Explorer
ORACLE" DataGovernance for US Regulatory Reporting

Inbox Standards & Policies Controls Key Indicators Process Monitoring

Controls >> Control Details

| create 1ssue

Details Assessments | Issues and Actions

Issues & Actions

Admin

- a x

dgsuser | Thursday,November10,2016 i OFSAA [B About ] Logout

Help
Open

+ Control Name gperational-control

[ Control Assessments (1) | @ Delete Assessment

D Date E Score E Rating

Status
Completed

[ 52449 31-12-2015 100 Effective
<

javascript:

User Defined Assessments

H®100% -

1. Click Controls Menu to view all the Controls in the system.
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2. Click Control ID hyperlink for which the control status is Open.
3. Click Assessments tab to view all the assessments done for a particular control, if any.
4. Click Delete Assessment button to delete the assessment in the system.

& Controls - Internet Explorer - [m} X
ORACLE" Data Governance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 5 OFSAA About | Logout
Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin

Controls >> Control Details Help
| Create issue Open

Details Assessments Issues and Actions

+ Control Name: gperational-control

B Control Assessments (1) | @ Delete Assessment

D Date Effectiveness Score Effectiveness Rating Status

[] 52449 31-12-2015 100 Effective Completed
< I >

javascript: HI00% ~

7.5.4.2 Operational Control Assessment

Before doing assessment on operational control following things need to be done:
1. Complete Process Monitoring of the RUN for a given date.
2. Execute T2T to move Process Monitoring statistics to FACT table for the same date.
3. Data should be available in the following tables:
e FSI_PM_BATCH_SCHEDULED_TIME
e FSI_PM_BATCH_TASK_DEPENDENCY
e FSI_PM_BATCH_TASK_AVG_TIME
e FSI_PM_BATCH_TASK_SCH_TIME

Once the above steps are done, then batch ##INFODOM## OP CONTROL ASSESSMENT needs
to be executed for the given date to do the assessment on operational controls. Once
assessment is done, it will start appearing in Ul under Assessment tab for a control.

Tables:
e FCT_PM_BATCH_TASK MEASURES: Stores the statistics on each task.
e FSI_CTL_EFFECTIVENESS: Stores the Assessments created.

e FSI_ CONTROL_ASSESS SUMMARY: Summary of the assessment.

Oracle Financial Software Services 62



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

e FSI_OP_CONTROL_EXEC_DETAILS: Assessment details with all parameters.

& Controls - Internet Explorer - a x
ORACLE' Data Governance for US Regulatory Reporting dgsuser | Thursday, November 10, 2016 #5 OFSAA About & Logout
Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions. Admin
Controle >> Control Details Help
— Open
| create 1ssue

Details | Assessments Issues and Actions
+ Control Name gperational-control
[ Control Assessments (1) | @ Delete Assessment
A ) Date E Score E Rating Status
[] 52449 31-12-2015 100 Effective Completed
< | >
javascript: ®100% -

7.6 Raising Issues on Controls

In control module, if the user is mapped to Issue Creator role, the user has an option to create

issue if the control is in open status.

1. Navigate to the Control Details page, Create Issue button appears on the top of the page.

ORACLE' Data for US Reg y dgsuser | Monday,Apri18.2016 @ OFSAA [B) About 4 Logout
Inbox  Standards & Policies  Controls _Controls1_ KeyIndicators  Process Monitoring  Issues & Actions  Admin
Help

ntrol Detads
Open

Assessment Start Date”

Comments

2. Click Create Issue button to view the Issue Creation page.
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Controls >> Control Details >> Issue Details "e‘?
B soveDrat | B Cancel
7.7 Closing a Control
A Control in Open status can be closed. Perform the following steps to close a control:
1. Navigate to the Controls Search and List page, and select the Control.
2. Click Close Control. The following screen is displayed.
D™ 14085
Reason for Closure
| submit |
3. Enter ajustification for closing the Control. Click Submit.
4. The Control is closed.
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8 Defining the Key Indicators for Monitoring

8.1

8.2

This chapter explains the details of the Key Indicators (KI) module in the Oracle Financial
Services Data Governance for US Regulatory Reporting application and step-by-step instructions
to use this module.

This chapter includes the following topics:

e About Key Indicators

e Parameters of Key Indicators

e User Roles and Actions

e Creating a Key Indicator

e Managing Measure and Formulas

About Key Indicators

The Key Indicator (KI) component provides the flexibility to define Key Indicators to evaluate
values, trends and variances of various data elements. They are important measures from the
data foundation. which provide an insight into values of various data elements that are required
for critical organizational processes. These indicators are reviewed on a periodic basis to alert
stakeholders of possible situations needing attention.

OFS DGUSRR Key Indicators module provides an early-warning system to identify potential
costly operational hazards including fraud, legal and technology risks. The use of Kls is
recommended by Bank of International Settelments (BIS) for sound Operational Risk
management. Therefore, it is an essential component of Basel || and Sarbanes-Oxley laws.

The type of values are quantitative and qualitative. For quantitative type of Kl the user should
load the measures. Kls are used as quantitative measures to monitor individual Critical Data
elements and to determine the effectiveness of controls. The Kl values are monitored for specific
business processes such as regulatory reporting, used to determine variances, time series trends
and many other metrics of data elements.

The application allows users to define various levels of thresholds depending on the level of
analysis required. Kl values are compared against threshold ranges defined.This determines the
Red Amber Green (RAG) status of the KI. Various notifications and tasks can be sent to
appropriate stakeholders depending on the level of the Kl threshold value breach. The RAG
status can be used as an indicator of the effectiveness of the Controls.

NOTE: A Key Indicator user should be mapped to the Issue Creator group in addition to other
Key Indicator related groups, to create an Issue.

Parameters of Key Indicators

DGUSRR for Key Indicators for Regulatory Reporting is based on two parameters:

e Periodic Comparison
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8.2.1

8.2.2

e Edit Checks

Key Indicators based on Periodic Comparison

Periodic comparison, as the name suggests, is the comparison of reports between two time
intervals or periods. If we are handling monthly reports, then we need to compare and analyze
the reports of two months (periods). If handling yearly reports, we need to compare and analyze
the reports of two years (periods). This kind of comparison helps us to identify any kind of issue
with the data.

NOTE: For few reports, first quarter of the current year cannot be compared with the last
qguarter of the previous year. As the report is for the current year and hence,
comparison with previous year’s data is invalid. By default, the reports are filtered by
the latest values on the basis of Run Skey and MIS Date Skey Filter for period
comparison.

Data is analyzed for each MDRM codes present in Regulatory Reports to identify the possible
indicators. We have defined Key Indicator based on Period Comparison for each MDRM code
present in report. Corresponding Thresholds are defined for each Key Indicator and Scores are
provided for each threshold value. This score value in turn helps us to categorize RAG (Red,
Amber and Green) status against each Key Indicator. According to the RAG value, user can take
necessary actions for Red and Amber Kis.

Key Indicators based on Edit Checks

Each report has its own Edit check sheet that includes various Validity, Qualitative, Intraseries
and Interseries check.

¢ Validity Check: Validity check is basically Quantitaive check. A validity check is used to
check whether a particular value in a report is a number or not as it should be as per the
Edit Check sheet. For example; One of the most common validity check states Value not
equal to null.

NOTE: Derived columns should not be considered for Key Indicators. For example: if cells
Al1+A2=A3. Then A3 is the derived column.

e Qualitative Check: Qualitative Checks define value in one column should match values
of another column. This ensures the quality of the reports.

e Interseries Check: Interseries Check involves comparison of two schedules within a
single report.

e Intraseries Check: Intraseries Check involves comparison of two schedules from two
different reports

Edit checks are classified into two types:

e Controls
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¢ Key Indicators

Edit check is defined on the basis of MDRM code. If the MDRM code mapping is received from
the Staging phase, it is a Control and hence defined as a DQ check. If the MDRM code mapping
is received rom Reporting phase, it is a Key Indicator. Kl has its own formula. The Content of
DGUSRR will define the KI definition and threshold values. This is fed to the DGUSRR, which
reads the Kl definition and threshold values to generate the Kl indicators and provide the required

RAG value.

The KI definitions are available in the FCT KRI DEF table.

& KeyIndicator Summary - Internet Explorer

|5 )

ORACLE’ Data Governance for US Regulatory Reporting

OFSAD | Monday, March 27, 2017 # 0FsAA  [B About & Logout

Inbox  Standards & Policies ~ Controls _ Key Indicators  Process Monitoring  Issues & Actions  Admin
I Key Indicators Help A
[ search [&1 Advanced Search | & Clear | Go
D Name
E Key Indicators (15283) 21765 K< > »
Create Key Indicator | | | [ export | 3]
% v Name Type Frequency | Rating Measure Scale LatestValue  LastModified | Status
[] 26264  Qualityindicator for FNBKA100 - Edit chec... () Value-Based Daily Number 16-Fed-2016  Open
[ 26263  Qualityindicator for FNBKS468 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[ 26262  Qualityindicator for FNBK2309 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[J 26261  Qualityindicator for FNBK2309 - Edit chec... (%) Value-Based Daily Number 16-Fed-2016  Open
[] 26260  Qualityindicator for FNBK0O10 - Edit chec... (2) Value-Based Daily Number 16-Feb-2016  Open
[ 26259  Qualityindicator for FNBK1407 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[0 26258 Quality indicator for FNBKC384 - Edit chec... (33 Value-Based Daily Number 16-Fep-2016  Open
[ 26257  Qualityindicator for FNBKC376 - Edit chec... () Value-Based Daily Number 16-Fed-2016  Open
[ 26256 Quality indicator for FNBK2122 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[ 26255  Qualityindicator for FNBKC383 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[0 26254 Quality indicator for FNBKB5S56 - Edit chec... (33 Value-Based Daily Number 16-Fep-2016  Open
[J 26253  Qualityindicator for FNBKBA97 - Edit chec... (32) Value-Based Daily Number 16-Fed-2016  Open
[ 28252 Qualityindicator for FNBKAO31 - Edit chec... B3J Value-Based Daily Number 16-Feb-2016  Open
[ 26251  Qualityindicator for FNBK3623 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[ 26250 Quality indicator for FNBK3230 - Edit chec... (33 Value-Based Daily Number 16-Fep-2016  Open
[ 26249  Qualityindicator for FNBK4598 - Edit chec... () Value-Based Daily Number 16-Fed-2016  Open
[ 26248  Qualityindicatorfor FNBK3124 - Edit chec... (3J Value-Based Daily Number 16-Feb-2016  Open
[ 26247  Qualityindicator for FNBKCO79 - Edit chec... () Value-Based Daily Number 16-Feb-2016  Open
[ 26246  Qualityindicator for FNBKCO79 - Editchec... (3) Value-Based  Daily Number 16-Feb-2016  Open
[ 26245  Qualityindicator for FNBKAO34 - Edit chec... (%) Value-Based Daily Number 16-Fed-2016  Open
v

The Threshold values are available in the FCT KI DEF THRSLD table
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= KIMetrics - Intemnet Explorer =]
ORACLE' Data Govemance for US Regulatory Reporting OFSAD | Friday, April 7, 2017 i OFSAA About ] Logout

Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin

Key Indicators >> Key Indicator Details Help

Open

Details KI Metrics Issues and Actions

+ Name variance of accounts payable

Bl Key Indicator Metrics (2) |17

Score Date Score Variance Variance Percentage KIRating Comments Thres hold Ass essment Status
04-2pr-2011 580000 -200000 2564 © Red Threshold Success
04-Jan-2011 780000 Threshold S

::::::

B Measures (1) 17

[] Value Description Value Computation Status
[ Accourts payable 580000 Success

8.3 User Roles and Actions

This section explains the different user roles and actions that can be perform in the Key Indicator
module of the OFS DGUSRR application.

8.3.1 User Roles

All the wusers are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP along with their following respective groups.

The user roles defined in the Key Indicator module of OFS DGUSRR:

e Key Indicator Creator: Permits the user to create, view and maintain Key Indicators. The
user needs to be mapped to DGSKRCODGRP group.

o Key Indicator Value Capturer: Helps the user to generate metrics. The user needs to be
mapped to KIVCAP group.

e Key Indicator Viewer: Helps the user to view the key indicators. The user needs to be
mapped to DGKIVIEWGRP group.

8.3.2 Actions

The Key Indicator records module allows users to perform the following actions:

e Creating Key Indicator: This action allows the user to create a new Key Indicator record.
Users can link or delink the components, define the formulas, Threshold limits, and attach or
delete the documents before or after submitting the Key Indicator.

e Editing Key Indicator: This action allows the user to edit and update the Key Indicators in
Draft or Review status.
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8.4

e Closing Key Indicator: This action allows the user to close the Key Indicators in Open

status.

o Deleting Key Indicator: This action allows the user to delete the Key Indicators in Draft

Status.

e Exporting Key Indicator: This action allows the user to export the list of Key Indicator
records. The Exported Key Indicator function allows the organization to have a compiled list
of all applicable Key Indicator records.

Creating a Key Indicator

While defining a Key Indicator, the fields that are displayed are explained as tabulated.

NOTE:

You should have Key Indicator Creator rights to create a Key Indicator.

8.4.1 Fields and their descriptions

Fields

Description

Fields marked in red asterisk(*) are mandatory

Name Provide a short description for the Kl
ID Unique ID for the KI (auto-generated)
Description Provide a long description for the Kl
Type e  Value Based
e  Variance Based
Source Source from where the Kl value is obtained, whether Internal or External
Frequency Frequency at which the value of the Kl is obtained from the source such as yearly,

Half-yearly, Quarterly, Monthly, Fortnightly, Weekly, Daily

Measure Scale

Select the scale from the drop-down box, whether Percentage, Number or Amount

Owner

Select the Kl owner

Caution User

User to be notified when value breaches the caution level

Critical User User to be notified when value breaches the critical level
Currency Select the base currency for thresholds and Kl value
Comments Provide additional information if any.
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8.4.2 Procedure to Create a Key Indicator

You can create a new Key Indicator, when you identify a warning signal which has potential
impact in the organization. The Key Indicator Search and List page allows you to create a new
Key Indicator.

NOTE: Users mapped to the role of Key Indicator Creator can create a Key Indicator.

To create a Key Indicator, perform the following steps:

1. Navigate to the Key Indicator Search and List page, and click Create Key Indicator. The
Key Indicators Details page is displayed.

8.5

3> Key Indicator Detalls Help

NOTE: The status of the Key Indicator is New.

2. Enter the required information in the fields.

&

3. Inthe Owner field, click the hierarchy browser and select the Owner for the control. Click
to clear the field. Similarly, select Caution User and Critical User.

4. Click Save Draft. A Confirmation dialog box is displayed, with the message: Add Operation
Successful.

5. Click OK. The Key Indicator is saved and Key Indicator Details page is displayed. The status
of Key Indicator changes to Draft.

6. Click Edit to update the information, and Submit. A Confirmation dialog box is displayed,
with the message: ‘Update Operation Successful.” The status of the Key Indicator changes to
Open.

NOTE: You cannot submit a Key Indicator at the first instance.

7. You can view the Kl in the Key Indicator Search and List page.

Managing Measure and Formulas

For Enterprise valid Key Indicators, the values are generated. Predefined value sets are created in
the applications installed in the same Information Domain. Users mapped to the role of Key
Indicator Creator can update this details in Draft or Open status.
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8.5.1 Creating Measures

The seeded measures are populated in the measure list of Measure and Formula page. To create
the manual measures, perform the following steps:

1.

Enter the values in following columns of DIM_KI_MEASURE table (available in atomic
schema):

Columns of DIM_KI_MEASURE Table

Column Description

N_MEASURE_KEY This is the primary key. Enter a unique key number.

V_MEASURE_CODE Enter the measure code. This should be same as of N MEASURE_KEY.
V_MEASURE_NAME Allows you to enter the name of measure which is not available in existing

list. For example, number of customers, number or complaints and so on.
You can enter a maximum 300 characters in this column.

N_MEASURE_TYPE Enter the type of measure. The type is entered as Number as you have
defined it for status. Following are the types of measure

1 - Internal Source - (Automated)
2 - External Source - (Automated)
3 - Internal Source - (Manual)

4 - External Source - (Manual)

N_MEASURE_STATUS Enter the status of measure as 1 (active) or 2 (Inactive). Only active mea-
sures will be displayed in measure list of Measure and Formula page.

N_ENTITY_KEY Enter the entity key value. For example, if you want to create a measure
based on Risk module, enter the entity value of that module in this field.
The Entity Key values are available in SETUP_COMPONENTS table.

N_APP_KEY Enter the name of application. Following are the values for Application key:

1 — Data Governance for US Regulatory Reporting

DIM_KI_MEASURE_MLS table is used to store the names of the measure in different
languages as available or installed. Enter the values in following fields of
DIM_KI_MEASURE_MLS table:

Columns of DIM_KI_MEASURE_MLS table

Column Description

N_MEASURE_KEY This is the primary key. Enter the unique key number. This value should be
same as defined in DIM_KI_MEASURE table.

V_MEASURE_NAME Allows you to enter the name of measure which is not available in existing
list. For example, number of custom- ers, number or complaints and so on.
This value should be same as defined in DIM_KI_MEASURE table.
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3.

DESCLOCALE Enter the locale details of measure. For example, en_US and so on.

After populating these values in table, the created measures (if status is active) will be
displayed in Kl screen when defining the formula.

NOTE: Measures should be created in these tables to appear in the user interface.

8.5.2 Defining Limits

To define the limits for a specific Kl, perform the following steps:

1.
2.

Navigate to the Key Indicator Search and List page.
Click a Key Indicator ID. The Key Indicator Details page is displayed.

NOTE: While creating the KI, select the Type as Quantitative, Source as Internal, and
ensure that the Kl is in Draft state.

Expand the View more section. In the Threshold section, click Define Limits.

Assign Lower limit, Uppder Limit, Score and Rating. Ensure that the ranges do not
overlap.

Click Update. A Confirmation dialog box is displayed, with the message: Update
Operation Successful.

Click OK.

Click View Rating Scale to view the rating assigned to each score. Based on the score the
rating scale is classified as Green, Amber or Red.

E Rating Scales (3) | [

== Score Rating
1-32 ) Green
4-7 )
8-10 & Red

8.5.3 Bulk Kl Assessment

Bulk KI Assessment process helps to create assessments for multiple Kls at once based on the
frequency and start date of the Kls. For performing Bulk KI Assessment, execute the batch
<INFODOM> BULK KI ASSESSMENT for a given date.

8.5.4 DQ-CONTROL MAPPING UTILITY

Perform the following steps to access DQ_Control Mapping Utility:
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1. Select Financial Services Data Governance for US Regulatory Reporting from the Select
Applications dropdown.

2. Navigate to Common Tasks-> Operations-> Batch Execution.

3. SelectDg MDRM CTRL MAPPER batch from the Batch Details grid to execute the batch.

Applications | Otiect Adminsiration  System Configuration & Identity Managemant

Select Applications
Financial Senvices Data Govemance for US Reguitory Reparing v

e -

Exccuie Baich |

ABoutOracle | Contact Us | Legal Notices  Terms Of Usé  Your Privacy Right Copmah 2016 Crachs sevsor s $Thstes. A4 rghts reserved

To map the created controls to the DQs, navigate to the Batch Execution and execute the batch
DQ MDRM CTRL MAPPER.

This will map N_CONTROL_KEY from the DQs present in the fsi control dg map table to
the pre-seeded entries inthe fsi_rr ctl map.

8.5.5 Updating Measures in Formula

To update a Formula, perform the following steps:

1. Navigate to the Key Indicator Search and List page.

2. Click Key Indicator ID. The Key Indicator Details page is displayed.
3. Expand the View more section.
4

Under the Measure and Formula section, click Edit. The Measure and Formula page is
enabled.

5. Edit the Formula as required.

6. Click Save. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’

7. Click OK.

NOTE: To delete a measure from the Formula, select the measure and click Delete.
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9

9.1

9.2

Issues and Actions

This chapter explains the process of creating issues for problems or deficiencies arising during
execution of the plan, which require attention and resolution, and describes the process of
identifying the corrective actions for issues. When you identify a particular issue or a problem
statement that poses as an risk, you can create issues and subsequently create necessary action
plans to resolve or address those issues.

Organizations use action plans to address a particular issue that has occurred. Users mapped to
the role of Issue Owners or Action Creators can create Action Plans for their Issues.

This chapter includes the following topics:

e About issues and Actions

e |ssues

e Managing Issues

e Actions

e Managing Actions

About Issues and Actions

An issue is a problem statement or matter requiring attention. Actions are plans or activities taken
up to resolve those issues. Actions are corrections activities that are planned to remediate an
issue, and are assigned to individual users for updates and completion.

Organizations may need to identify and track issues whenever there is an alarming situation,
such as when an incident is reported, Key Indicators (Kls) are breached, risk is assessed as high,
control is assessed as ineffective, regulation is breached and so on. It can be created out of
ineffective controls, breached key indicators, or as a result of delays in completion of tasks
process monitoring. It can also be created to track change management of a change to a
metadata and its impact on all related metadata objects.

Issues can be created either from the Issues and Actions module or from other modules such as
Controls, whenever the parameters are alarming and require issue creation.

Actions are created to remediate an issue. After the actions are closed the issue is reviewed for
closure. Therefore, ensure that you complete all actions to close an issue. Action plans aim at
estimating the cost involved in addressing issues. If the cost of taking up the action is more than
the risk involved in the issue, an organization can choose to close the issues without any actions.

Issues

This section includes:

e User Roles and Actions

e Issue Workflow
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9.2.1

9.2.2

e Tasks and Notifications in Issues

User Roles and Actions

All the users are required to be mapped to DGSAUTHGRP, DGSADMINGRP, and
DGSANALYSTGRP along with their following respective groups.

This section provides information on the user roles and actions in Issues module.
User Roles

This module is designed for users mapped to the roles of Issue Creator, Issue Owner or Action
Creator, and Action Owner. Their roles and responsibilities, as they operate within the application,
include the following:

e Issue Creator: This user is responsible for creating an issue and helping the organization in
tracking the progress of an issue till its closure. This user can assign a created issue to an
Issue Owner and reopen closed issues.

e Issue Owner or Action Creator: This user is responsible for assessing the issue created by
the Issue Creator, adding issue details, and creating adequate action plans to resolve the
issue. This user can assign a created action to an Action Owner and reopen the completed
actions.

Actions
The User Roles described above can perform the following actions:

e Creating Issue: This action allows an Issue Creator to create a new issue identified by an
organization.

e Creating Action: This action allows an Issue Owner to create new action plans or link
existing action plans from the Issue Details page for resolving an issue.

o Deleting Issue: This action allows an Issue Creator to delete an issue in Draft status if the
Issue Creator believes that the particular issue is no longer required.

e Closing Issue: This action allows either an Issue Creator to close an issue when all the
associated actions have been completed.

e Reopening Issue: This action allows an Issue Creator to reopen a closed issue.

e Transferring Ownership: This action allows an Issue Owner to transfer the ownership of an
issue to an appropriate user.

e Exporting Issue: This action allows the user to export the list of issues to an Excel format.

Issue Workflow

The following figure displays the complete workflow of the Issues module:
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The status flow of the Issues module is as follows:

New Issue

Saved as
Draft

Open

Closed
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9.2.3 Tasks and Notifications in Issues

Tasks are actionable items assigned and sent to a user. By performing these tasks, you complete
the workflow defined in the module. Notifications are messages sent to a user stating that an
action has been performed in the application. Both Tasks and Notifications can be viewed from
the Inbox menu in the application.

The following table lists the tasks and natifications that each user role will receive in their Inbox
menu on performing a particular action.

Action Performed Task/Notification | Task/Notification Sent To Status
Description
Submitting an Issue | Task A Task is sent to the Issue Owner Open

Issue Owner selected
in the Owner field.

Transferring the Task A Task is sent to the Issue Owner Open
Ownership of an new Issue Owner
Issue selected in the

Transfer Ownership

window.
Transferring the Notification A Notification is sent to | Issue Creator Open
Ownership of an the Issue Creator who
Issue created the issue.
Closing an Issue. Notification A Notification is sent to | Issue Creator Closed

the Issue Creator who
created the issue.

Reopening an Issue | Task A Task is sent to the Issue Owner Open
by Issue Creator. Issue Owner selected
in the Owner field.

Submitting an Action | Task A Task is sent to the Action Owner Open
by Issue Owner or Action Owner selected
Action Creator in the Owner field.
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9.3 Managing Issues

This section includes the following:

e Creating an Issue

e Managing Issue Details

e Transferring Ownership of an Issue

e Closing an Issue

e Reopening Closed Issues

e Deleting an Issue

e Exporting List of Issues to Excel

e Creating Actions from Issues

9.3.1 Creating an Issue

While creating an Issue, the fields that are displayed are explained as tabulated.

9.3.1.1 Fields and their descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

Name Short description for the issue

ID unique id for the issue(auto generated)

Description long description for the issue

Issue Category Select the classification type of the issue from the drop-down box, such as

Data Authorization, Data Security, Data Privacy, Data Accuracy, Data
Availability, Timeliness

Criticality Select the level of criticality of the issue such as High/Medium/Low from the
dropdown

Target Date Select a target date from the calendar for completion of the issue

Owner Select the User, from the hierarchy button, who owns and tracks the

resolution of the issue

Component Select the component from the hierarchy button which the Issue is to be
created
Primary Source Select the particular entity in the source function for which the Issue is to be

created. This is only active if input is provided for Component.
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Fields Description

Fields marked in red asterisk(*) are mandatory

Comments Provide additional information if any

9.3.1.2 Procedure to Create an Issue

When you identify a particular issue or a problem statement that poses as risk to an organization,
you can create issues either from the Issues & Action module or from Controls module in the
application, and subsequently create necessary action plans to resolve or address the identified
issue.

NOTE: Only users mapped to the role of Issue Creator can create a new issue from the
respective modules.

To manually create an issue from the Issues and Actions module, perform the following steps:

1. When creating issues from the Issues & Actions module, select issues and navigate to the
Issues Search and List page and click Create Issue. The Issues Details page is displayed.
Or,
When creating issues from other modules in the DGUSRR application, navigate to the
respective module details page and click Create Issue. The Issues Details page is
displayed.

ssue Details Help

| (= save Draft | &7 submit | [& Cancel
Name* D7 23261
Description

ssue Category

Criticality”

Target Date*

o II

Component*

Comments

2. Enter the required information in the fields.

3. Click Save Draft to save the information entered in the Definition page. A Confirmation dialog
box is displayed, with the message: ‘Add Operation Successful.’

4. Click OK. You are navigated to the Issues Details page and the status of the issue changes
to Draft. You can Edit the Issue and Update or Submit it to the Issue Owner.
Or:
Click Submit to save the entered information and submit the issue to the Issue Owner for
taking further actions. A Confirmation dialog box is displayed, with the message: ‘Update
Operation Successful.’

5. Click OK. You are navigated to the Issues Details page and the status of the issue changes
to Open. A new issue is created.
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9.3.2

9.3.2.1

9.3.2.2

Managing Issue Details

The Issues Details page allows you to manage additional tasks and functionalities pertaining to
the Issues. This section covers the following topics:
e Editing an Issue

¢ Managing Details

¢ Managing Linkages

Editing an Issue

When you want to update or modify the issue details, you can edit an issue from the Issue
Details page.

Users mapped to the role of Issue Creator can view the details of all the issues in the Issues
Search and List page, but can edit only the issues that they created. An Issue Owner can edit an
issue in Open status whereas an Issue Creator can edit only in Draft status.

Editing an Issue in Draft Status

To edit an issue in Draft status, perform the following steps:

1. Select the Issue ID from the Issue search and list page. Navigate to the Issues Details page.
2. From the Details tab, click Edit. Modify the necessary issue details.

3. Click Update to save the information entered in the details page. A Confirmation dialog box is
displayed, with the message: ‘Update Operation Successful.’

4. Click OK. You are navigated to the Issue Details page and the status of the issue remains in
Draft.
Or:
Click Submit to save the entered information and submit the issue to the Issue Owner for
taking further actions. A Confirmation dialog box is displayed, with the message: ‘Update
Operation Successful.’

5. Click OK. You are navigated to the Issues Details page and the status of the issue changes
to Open.

Managing Details

This section covers the following topics:
e Attaching and Deleting Documents

Attaching and Deleting Documents

The Issue Details page allows you to attach or delete documents related to an issue. Refer to
Managing Documents section for details.
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9.3.2.3 Managing Linkages

When an issue is in Open status, an Issue Owner can link and delink records of entities to the
respective section such as Controls, Key Indicators from the Linkages tab.

NOTE: You cannot perform link or delink action when the status of an issues is in Closed.

This section includes the following topics:

Linking an Record to an Issue

Delinking an Record to an Issue

Linking an Record to an Issue

To link an entity record such as controls or Key Indicators to an issue, perform the following
steps:

1.

2
3.
4

Login to the application as an Issue Owner.
Navigate to the Issue Details page of an issue in Open status.
Click Linkages tab. The list of entities such as Controls or Key Indicators is displayed.

Click Link on the required entity. A window with a search bar and a list of pre-filtered records
is displayed in various statuses. The following table displays the statuses of records that you
can link to each entity:

Entity Name Status of Records

Controls Open

Key Indicators Open

Search for the required entity record using the Search bar and then select the entity record
from the List section.

Or:

Select the required entity record from the List section that already displays the pre-filtered list
of entity records through a default search criteria.

Click Link. A Confirmation dialog box is displayed, with the message: ‘Records Linked
Successfully.’

Click OK.
Click Back to navigate back to the Linkages tab.

The linked entity records are displayed in the respective entities section. You can click the ID
of the linked record to navigate to the respective entity details page.

Delinking an Record to an Issue

To delink entity records such as controls or Key Indicators from an issue, perform the following
steps:

1.

Login to the application as an Issue Owner.
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933

9.34

Navigate to the Issue Details page of an issue in Open status.
Click Linkages tab. The list of entities are displayed.

Expand the required section where you want to delink a record.

o &~ w0 DN

Select the record(s) using the checkbox and click Delink. A Confirmation dialog box is
displayed, with the message: ‘Are you sure you want to delink the records?’

6. Click OK. The following message is displayed: ‘De-link Operation Successful.’
7. Click OK.

The record is delinked from the respective entity section.

NOTE: You cannot delink a primary source record from the entities section. If you try to delete
a primary source record, the following message is displayed: The selected record
cannot be delinked as it is a primary source record for the issue.

Transferring Ownership of an Issue

When the owner of an issue has changed for reasons such as the Issue Owner user has quit the
organization or moved to a different role and so on, an Issue Owner user can transfer the
ownership of the issue to an appropriate user by using the Transfer Ownership option in the Issue
Details Page or from the Issues Search and List page

To transfer the ownership of an issue, perform the following steps:

1. Navigate to the Issues Search and List page. Select an issue in Open status, and click
Transfer Ownership. The Ownership Transfer window is displayed.
Or:

From the Issues Details page of an issue in Open status, click Transfer Ownership. The
Ownership Transfer window is displayed.

2. Select a new owner from the hierarchy browser window.
3. Enter any comments in the Comments fields.

4. Click Submit. A Confirmation dialog box is displayed, with the message: ‘Update Operation

Successful.’
5. Click OK.
6. Click Back.

You are navigated to either the updated Issues and Search List page or the Issues Details
page from where the transfer of ownership action is performed.

Closing an Issue

You can close an issue when you have completed all the actions created for an issue or you
believe that the identified issue is no longer relevant.
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9.35

NOTE: When you want to close an issue, the status of all the associated actions must be in
Completed status. If you try to close an issue without completing all the actions
associated with it, the following message is displayed: ‘Please close all actions
associated with the Issue.’

To close an Issue, perform the following steps:

1. Navigate to the Issues Search and List page. Select an issue in Open status, and click
Close Issue. The Issue Details page is displayed.

Or:

From Issues Details page of an issue in Open status, click Close Issue. The Issue Details
pag is displayed.

2. Enter the reason for the closure of the issue in the Comments field.

3. Click Submit. A Confirmation dialog box is displayed, with the message: ‘Update Operation

Successful.’
4. Click OK.
5. Click Back.

You are navigated to either the updated Issues and Search List page or Issues Details page
from where the closure action is performed. The status of the issue changes to Closed.

Reopening Closed Issues

An Issue Creator user can reopen a closed issue if the user believes that if there is a need to re-
examine the issue or the issue that was closed is still existing in the organization, or the actions
plans initiated to mitigate the issue were not satisfactory.

NOTE: Only users mapped the role of Issue Creator can reopen the closed issues.

To reopen a closed issue, perform the following steps:

1. Navigate to the Issues Search and List page. Select an issue in Closed status, and click
Reopen. The Issue Details page is displayed.

Or:

From the Issues Details page of an issue in Closed status, click Reopen. The Issue Details
page is displayed.

Target Date* 31-0ct-2015

Comnonent* Wau Indiratare

Ason:

Name* testq D 23261
Days to Completion
Description g a
Days Elapsed
Delay
I, Number of Azsociated
Criticality Components

Owner* dgsuser =2 Number of Actions
Primarv Source

e
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2. Enter comments in the Comments field.

3. Click Submit. A Confirmation dialog box is displayed, with the message: ‘Update Operation
Successful.’

4. Click OK. You are navigated back to the Issue Details window.
5. Click Back.

You are navigated to either the updated Issues and Search List page or Issues Details page
from where the reopening actions is performed. The status of the issue changes to Open.

9.3.6 Deleting an Issue

Users mapped to the role of Issue Creator, or Issue Owner can delete issues in Draft status if
they are not applicable to the business or an organization.

NOTE: You can delete an issue only when it is in Draft status.

To delete an issue, perform the following steps:

1. Navigate to the Issues Search and List page.

2. Select an issue in Draft status.

3. Click Delete. The Confirmation window is displayed:

4. Click OK. The following window is displayed: Delete Operation Successful.
5

Click OK. The selected issue is deleted. You are navigated to the updated Issues Search and
List page.

9.3.7 Exporting List of Issues to Excel

You can export the list of issues displayed in the Issues Search and List page to an Excel format.

NOTE: You cannot export individual issues to Excel.

Refer to section Exporting Records for more details.

9.3.8 Creating Actions from Issues

When an organization wants to record recommended action plans to address a particular issue
that has occurred, they can create action plans. Users mapped to the role of Issue Owner or
Action Creator can create action plans or new actions for an issue.
To create action plans for a an issue, perform the following steps:
1. From the Open Tasks tab in the Inbox menu, click a Task ID in Open status. You are
navigated to the Issues Details page.
Or:
Navigate to the Issues Search and List page and click the required Issue ID in Open status
on which you want to create actions. You are navigated to the Issues Details page.
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sections are displayed.

Expand View More from the Details tab. The Actions, Document and Workflow History

Click Create Action from the Actions section. The Actions Definition page is displayed.

ssue Details >> Action Details

Details

Help

Action Name*

Description

Start Date* %

Reminder(days)®

Component* Control
Comments

| B save Draft | 7 Submit | [& Cancel
D 7 23434

Ason:
Days to Completion
Days Elapsed

Delay
Owmer* w5
Number of Associated Gomponents
Target Date* B2
Progress Number of Activities
Number of Completed Activties
Primary Source 7 DQODOOS, DQ00007,DA00009
Number of Overdue Activities

4. Enter the following information in the Actions Definition page.

Fields

Description

Fields marked in red asterisk(*) are mandatory

Action Name Short description for the action

ID Unique id for the action (auto generated)

Description Provide a long description for the action

Criticality Select the level of criticality of the action plan such as High/Medium/Low
Start Date Enter the date by which the action plan has to be executed

Target Date

Enter a target date for completion of the action

Owner

Select the User who owns and tracks the resolution of the action

Reminder Days

Enter the number of days before which the action assessor has to be
intimated to complete the action

Progress This field is enabled for an Action Owner to update the measure of
completion of action plan.
Note: By default, this field is disabled when the action is created.
Component Select the component for the action

Primary Source

Select the particular entity in the source function for which the automatic
issue is being created

Comments

Provide additional information if any
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9.4

94.1

5. Click Save Draft to save the information entered in the details page. A Confirmation dialog

box is displayed, with the message: ‘Add Operation Successful’. Click OK. You are navigated
to the Actions Details page and the status of the issue changes to Draft.

Or:

Click Submit to save the entered information and submit the action to the Action Owner for
taking further actions. A Confirmation dialog box is displayed, with the message: ‘Add
Operation Successful.” Click OK. You are navigated to the Actions Details page and the
status of the action changes to Open.

A new action is created and a task is sent to the owner of the action for taking further actions.

NOTE: You can also use the Link option to link the various actions that are applicable to
the current issue.

Actions

This section includes:

e User Roles and Actions

e Action Workflow

e Tasks and Notifications in Actions

User Roles and Actions

This section provides information on the user roles and actions in the Actions module.

User Roles

This module is designed for users mapped to the roles of Issue Owner or Action Creator, Issue
Creator, and Action Owner. Their roles and responsibilities, as they operate within the application,
include the following:

Issue Owner or Action Creator: This user is responsible for assessing the issue created by
the Issue Creator, adding issue details, and creating adequate action plans to resolve the
issue. This user can assign a created action to an Action Owner and can also reopen the
completed actions. The user needs to be mapped to DGISASRGRP group.

Action Owner: This user is responsible for assessing the actions created by the Issue
Owner, implementing action plans pertaining to an issue and tracking them to completion.
This user can update the percentage completion of actions, activities performed and cost
incurred in carrying out the actions. The user needs to be mapped to the DGSAUTHGRP,
DGSADMINGRP, and DGSANALYSTGRP along with the DGAAGRP group.

Actions

The user roles described above can perform the following actions:
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e Deleting Action: This action allows an Issue Owner or Action Creator user to delete an
action in Draft status when an Issue Owner or Action Creator believes that the action is no
longer required.

e Force- Closing Action: This action allows an Action Creator or Issue Owner user to close an
issue when associated actions have been completed.

e Reopening Action: This action allows an Issue Owner or an Action Creator to reopen closed
actions.

e Transferring Ownership: This action allows an Action Owner to transfer the ownership of an
action to an appropriate user.

e Exporting Action: This action allows all user roles to export the list of actions to a Microsoft
Excel spreadsheet.

9.4.2 Actions Workflow

Actions Workflow

Creation of Action by |ssue Owner

New
Role: Issue Owner

¥

Capture additional details of the Action. |dentify an Action Owner & Submit

Draft

Roie: Issue Owner

Identify Stakeholders, create activities for the action, define updates and modify other

Action details. Open

Rols: Action Owner

=

can be force closed too. Complete

NGRS G G S

’ When the Progress of the Action reaches 100%, the Action is Completed. The action

Role: Action Owner

9

ﬁ'he Issue Owmner can reopen the
Action if not satisfied with the
closure.

9 Role: Issue Owner

k.

( T
L Closed )
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The status flow of the Actions module is as follows:

New Action

Saved as
Draft

Open

Complete

9.4.3 Tasks and Notifications in Actions

Tasks are actionable items assigned and sent to a user. By performing these tasks, the
appropriate user completes the workflow defined in the module. Notifications are messages sent
to a user stating that an action has been performed in the application. Both Tasks and
Notifications can be viewed from the Inbox menu in the application.

The following table lists the tasks and notifications that each user role will receive in their Inbox
menu on performing a particular action.

Action Performed Task/Notification | Task/Notification Sent To Status
Description
Submitting an Action | Task A Task is sent to the Action | Action Owner Open
by Issue Owner or Owner selected in the
Action Creator Owner field.
Submitting an Action | Notification A Notification is sent to the Issue Creator Open
by Action Owner Issue Creator of the Issues
mapped to the action.
Transferring the Task A Task is sent to the new Action Owner Open
Ownership action ownerselected in the
Transfer Ownership window.
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Transferring Notification A Notification is sent to the Issue Owner Open
Ownership Issue Owner who created and Stake

the Action and all the holders

stakeholders captured in

stake holders tab.
Completing the Notification A Notification is sent to the Issue Owner Closed
Progress of an Issue Owner who created and Stake
Action to 100% the Action and all the stake Holders

holders captured in

Stakeholders tab.
Force closing an Notification A Notification is sent to the Issue Owner Open
Action Issue Owner who created and Stake

the Action and all the stake holders

holders captured in

Stakeholders tab.

The Actions Details page allows you to manage additional tasks and functionalities pertaining to

9.5 Managing Actions
This section includes the following:
e Managing Action Details
e Transferring Ownership of an Action
e Closing an Action
e Reopening Completed Actions
e Deleting an Action
e Exporting List of Actions to Excel
9.5.1 Managing Action Details
the Actions.
This section discuses the following topics:
e Editing Action Details
e Managing Details
9.5.1.1 Editing Action Details

When you want to update or modify action plans associated with issues, you can edit an action
from the Action Details page. Users mapped to the role of Action Owner can edit an issue in
Open status whereas an Action Creator user can edit only in Draft status.

To edit an action in Open status, perform the following steps:
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9.5.1.2

Navigate to the Action Details page.
From the Details tab, click Edit. The Action Details page is displayed.
Modify the necessary action details.

You can also perform actions such as adding an activity, adding stakeholders, adding action
updates and viewing the workflow. For more information, refer to Managing Details.

Click Submit. A Confirmation dialog box is displayed, with the message: Update Operation
Successful.

Click OK. The updated Action Details page is displayed.

Managing Details

The Details page allows you to manage additional tasks and functionalities pertaining to the
Actions.

This section discuses the following topics:

Adding Activities to an Action

Adding Action Updates

Attaching and Deleting Documents

Adding Activities to an Action

To add an activity to an action, perform the following steps:

1. Navigate to the Action Details page of an action in Open status.
2. Expand View More to display the list of sections.
3. Click Add Activity from the Activity section. An activity row is added.
B Activities (1) | (] Add Activity | [E] Save | @ Delete Activities | [F]
actwiy No. | Acty Progress | StartDate End Date s

V1 1 B =l
4. Check the check box for the row to make the Activity editable.
5. Enter the Activity Name, Progress, Start date, End date of the activity. and any comments.
6. Click Save. The following message is displayed: Update Operation Successful.
7. Click OK. A new activity is added in the activities section.

NOTE: To delete an activity, select the row and click Delete Activities.

Adding Action Updates

To add an update to an Action, perform the following steps:

1.
2.
3.

Navigate to the Action Details page of an action in Open status.
Expand View More to display the list of sections.

Click Add Action Updates from Action Updates section. An Action Update row is added.
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B Action Updates (2) | [F] Add Action Updates | 5] Save Action Updates | @ Delete Action Updates | 3]

Update Comments Created By Created Date

dgsuser 29-0ci-2015

4. Click the check box for the row to make the action update editable.
Enter comments in the field Update Comments.

6. Click Save Action Updates. The following message is displayed: Update Operation
Successful.

7. Click OK. A new update action is added in the Action Updates section.

NOTE: To delete an action update, select against each row and click Delete Action Updates.

Attaching and Deleting Documents

The Action Details page allows you to attach or delete documents related to an action. For more
details on how to attach and delete documents, refer to Managing Documents section.

9.5.2 Transferring Ownership of an Action

To transfer the ownership of an Action, perform the following steps:

1. From the Action Search and List page, select an action in Open status, and click Transfer
Ownership. The Ownership Transfer window is displayed.

Or:

From the Action Details page of an action in Open status, click Transfer Ownership. The
Ownership Transfer window is displayed.

M2
9%}
o
7=}
(&

Name ? testl D
Present Owner dgsuser New Owner® o || 2

Comments

| submit | | Back |

Select a new owner from the hierarchy browser window.

Enter any comments in the Comments fields.

Click Submit. The following message is displayed: Update Operation Successful.
Click OK.

o o M 0w N

Click Back. You are navigated to either the updated Issues and Search List page or Issues
Details page from where the transfer of ownership action is performed.
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9.5.3 Closing an Action
Actions can be closed once they are complete. If all actions for an Issue is addressed, then
Issues can be closed. If an Action is abandoned mid-way, it can be force closed. Once all actions
are closed, the Issue can be closed.
Only users mapped to the role of Action Owner can close or force close actions. Only an Issue
Owner can close Issues.
9.5.3.1 Force-Closing an Action
You can force-close an action if it is no longer relevant to the associated issues. You can force-
close an action only when it is in Open status.
To close an action, perform the following steps:
1. From the Action Search and List page, select an action in Open status, and click Force
Close Action. An Action Details window is displayed.
Or:
From the Action Details page of an action in Open status, click Force Close Action. An
Action Details window is displayed.
Comments
Submit | | Back |
2. Enter the reason for the closure of the issue in the Comments field.
3. Click Submit. The following message is displayed: Update Operation Successful.
4. Click OK.
5. Click Back. You are navigated to either the updated Actions and Search List page or Action
Details page from where the closure action is performed. The status of the issue changes to
Complete.
9.5.4 Reopening Completed Actions

Only a user mapped to the role of Issue Owner can reopen actions associated for an Issue.
To reopen a completed action by an Issue Owner, perform the following steps:

1. From the Issues Search and List page, select an issue in Open status. Expand View More
and click the required Action ID in Completed status. The Action Details page is displayed.
Click Reopen Action. An Action Details window is displayed.

Or:

Oracle Financial Software Services 92



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

From the Action Search and List page, select an action in Completed status, and click
Reopen Action. The Action Details window is displayed.

Or:

From the Action Details page of an action in Completed status, click Reopen Action. An
Action Details window is displayed.

Criticality owner dosuser [ Number of Associated i

Components
Start Date* 30-0ct-2015 = 2 Target Date” 27-Nov-2015 |5 | 2
: Number of Activities
Reminder{days)* 15 Progress 0
Component* Contral Primary Source Number of Completed
Z & Activities
Comments test

Mumber of Overdue
Activities

Enter comments in the Comments field.
Click Submit. The following message is displayed: Update Operation Successful.
Click OK.

o M w0

Click Back. You are navigated to either the updated Action Search List page or Issues
Details page from where the reopening actions is performed. The status of the issue changes
to Open.

9.5.5 Deleting an Action

The Controls section allows you to delete Action Plans in Draft status.

Users mapped to the role of Issue Owner can delete Actions in Draft status if Issue Creation is
turned on. If Issue Creation is turned off, Users mapped to the role of Control Owner, can delete
Draft Actions linked to Controls. Users mapped to the role of Action Owner can delete issues in
Draft status if they are not applicable to the business or an organization.

To delete an action in Draft status, perform the following steps:
1. From the Action Search and List page, select an action in Draft status.

2. Click Delete Action. The following confirmation message is displayed: Are you sure you want
to delete this record?

3. Click OK. The following message is displayed: Delete Operation Successful.
4. Click OK. The selected action is deleted.

You are navigated to the updated Action Search and List page.

9.5.6 Exporting List of Actions to Excel

You can export the list of actions displayed in the Action Search and List page to an Excel
spreadsheet. Refer to section Exporting Records for more details.

NOTE: You cannot export individual actions to Excel.
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10 Process Monitoring

This chapter explains the process of identifying the reporting plan.

This chapter includes the following topics:

User Roles and Actions

Process Monitoring Workflow

Creating a Reporting Plan
Linking the OFSAA Runs to a Plan

Linking the Tasks to Runs

Linking the Dependent Tasks to Tasks

Monitoring a Reporting Plan

Viewing a Reporting Plan

10.1 User Roles and Actions

All the users need to be mapped to DGSAUTHGRP, DGSADMINGRP, and DGSANALYSTGRP,
along with DGSPSI and PROCUSER.

Following is the user role and action for Glossary:

PROCUSER : Permits the user to access the processs monitioring module.

10.2 Process Monitoring Workflow

Following flowchart describes the Process Monitoring Workflow:
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New Plan

Saved as
Draft

Open

Closed

10.3 Creating a Reporting Plan

The reporting plan provides an overview of the timelines for the regulatory submission. It is
activity specific. For example, the plan for regulatory report submission of one activity is different
than another. The plan includes the scope and schedule for tracking and completion.

To create a reporting plan, define the name, purpose, owner and additional attributes for the plan.
Additionally, you need to define the OFSAA runs and scope of the plan. You can choose any
OFSAA run as the scope and derive the tasks from all the runs in the scope.

10.3.1 Fields and their descriptions

Fields Description

Fields marked in red asterisk(*) are mandatory

Name Provide a short description of the plan.
ID Displays the unique ID for the plan (auto-generated).
Objective Select the objective from the drop-down box, whether Business,

Management or Regulatory.

Owner Select the owner of the plan such as the user responsible for tracking the
plan to closure.
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Fields Description

Fields marked in red asterisk(*) are mandatory

Type Select the plan type from the drop-down box, whether Regulatory Report
Submission, or Management Report Submission.

Description Provide a long description of the plan.

Frequency It is the frequency of a Plan

10.3.2 Procedure to Create a Reporting Plan

Perform the following steps to create a Reporting Plan:

1. Navigate to the Process Monitoring Search and List page.
2. Click Create Plan. The Plan Details page is displayed.

3. Enter the required information in the fileds.

tans >> Plan Details Help

Save Draft

Name* 1] 150445

Objective* ‘ v‘ Ovmer OFSAD

Type* ‘ v ‘ Frequency v

Description

4. Click Save Draft. A Confirmation dialog box is displayed, with the message: Click OK to
continue to Details page for newly created entry. Click Cancel to remain in the create new
screen to add additional entries.

5. Click OK to proceed. The status of the Plan changes to Draft.

NOTE: You should schedule the plan before submitting.

6. The plan is submitted, and the status changes to Open.

NOTE: To submit a plan, all mandatory fields (marked with an asterisk) must be filled. If
not, the application displays the following message: Mandatory fields are not
entered.

10.4 Linking Reports to a Plan

Regulatory Reports can be associated to a Plan in Process Monitoring module
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FR-2844

FR-25568
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| ok | | cancel

10.5 Linking the OFSAA Runs to a Plan

Data Governance for US Regulatory Reporting facilitates mapping of OFSAA Runs to the Plans
created in Process Monitoring module. For the created plan, user can link the Runs by selecting
the Link button in the Runs Grid. All the selected runs will be displayed in the Runs grid.

NOTE: Install another media pack to obtain the Run information. The runs available as a part
of the applications in the media pack can be made visible in Data Governance for US

Regulatory Reporting.

Metadata Publish is required to publish the Run related information.
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| ORACLE' DataGovernance for US Regulatory Reporting

dgsuser | Thursday, November 10, 2016

5 DESAA

- [m] bes

About & Logout

(= Reports (1) |EXLink | KD Delin
<&|[] ReportID

0 22
Runs (0) | F51 AddRun | B §

Tasks (0) |

Inbox Standards & Policies Controls Key Indicators Process Monitoring Issues & Actions Admin
Plans >> Plan Details Help
Draft
e | & Runs - Intemet Explorer - X
Plan Details = Runs (3) | 1]
o - i D Run Name Run Code Run Description
jec
T [] 1443686743571 PMSegBasel3Std_Scr PMSegBasel3Std PMSegBasel3Sid_Scr
Descripl [[] 1443686743578 Risk Weighted Asset Calculation - C 1305907253832 Risk Weighted Asset Calculation - C.
[[] 1443686743540 USA-USIII-Minimum Tier 1 Levera RNBL0O025 USA - US Il - Minimum Tier 1 Levera.
Link Close
Bl Hide
Scope

© Oracle. All rights reserved

10.6 Linking the Tasks to Runs

Data Governance for US Regulatory Reporting facilitates mapping of Tasks to Runs in Process
Monitoring module. The Task button in the Runs grid give the user the option to select the tasks.
On clicking Task button, a pop-up window displays all the tasks under the selected Run. The
selected tasks can be seen in the Task grid under the Run grid.

= Run Task Selection A
Object Name Object Type Modified Date Modified By Executable
[} PMsegBasel3std_scr Run
= PM Basel Il Risk Weighted Asset Calculation - Credit Risk - BIS Standardised Approach Process 23-Dec-2014 SYSADMN

[¥INon Sec Basel Product Type Assignment - STD Computation Rule 2
Mitigant Standard Issuer Type Assignment - STD Computation Rule SYSADMN 2
Non Sec Basel Methodology Assignment - STD Computation Rule 25-Jun-2012 SYSADMN 2
Non Sec Off-Balance Sheet Drawn CCF Assignment - STD Computation Rule 25-Jun-2012 SYSADMN 2

[¥INon Sec CCF Assignment - STD Computation Rule 25-Jun-2012 SYSADMN 2

Non Sec Pre-Mitigation EAD Amount - STD Computation Rule 25-Jun-2012 SYSADMN 2
Non Sec Pre-Mitigation EAD Drawn Amount - STD Computation Rule 25-Jun-2012 SYSADMN 2
Non Sec Pre-Mitigation EAD Undrawn Amount - STD Computation Rule 25-Jun-2012 SYSADMN 2
Basel Methodology Assignment - Standardised Method Computation Rule 25-Jun-2012 SYSADMN 2
NON_SEC_RISK_WEIGHT_MAPPING_POPULATION Data Mapping 29-Sep-2015 SYSADMN
NON_SEC_RISK_WEIGHT_MAPPING_POPULATION Data Mapping 29-Sep-2015 SYSADMN T2T
Basel Methodology Assignment - Non-Sec Standardized Approach - Option 1 - Banks Computation Rule 25-Jun-2012 SYSADMN 2
Non Sec Pre-Mitigation RW UL for Banks - Option | - STD Computation Rule SYSADMN 2
Basel Methodology Assignment - Non-Sec Standardized Approach - Option 1 - PSEs Computation Rule 25-Jun-2012 SYSADMN 2

Non Sec Pre-Mitigation RW UL for PSEs - Option | - STD Computation Rule SYSADMN 2 v

((submit ] [‘ciose ]
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10.7

10.8

10.9

Details
B Scope
 Runs (2) | B3 Add Run | B Remove Run | E3 Tasks |3
& D Run Hame Run Code Run Description
1443686743571 PMSegBasel35td_Scr PMSeqBasel3std_Scr  PMSegBasel3std_Scr
[] 1443686743540 USA- US Ill- Minimum Tier 1 Leverage Rati.. () RNBL0025 USA-US Il - Minimum Tier 1 Leverag... [2)
(| | >
[ Tasks (54) | 11 1 3
2 TaskHName Run Name Dependent Tasks
[] Non Sec Pre-Mitigation RW UL for Commercial Enfity - STD PMSeqBaseldStd_Scr Collateral Eligibility - STD Mitigant Eligibility - STD Non Sec Basel M¢
[] NON_SEC_RISK_WEIGHT_MAPPING_POPULATION PMSeqBasel3std_Sor
[] PARTY_TYPE_RECLASSIFICATION_POPULATION_STD PMSegBasel35td_Ser
[] PROD_TYPE_RECLASSIFICATION_POP_STD PMSeqBasel3std_Sor
[] SUB_EXPOSURES_NON_SEC PMSeqBaseldStd_Scr CRM Mitigant Violatility Haircut - Supenisory Haircut Miigant Eligibilit
«| | >
Schedule

Linking the Dependent Tasks to Tasks

Data Governance for US Regulatory Reporting facilitates mapping of Dependent Tasks to Tasks
in Process Monitoring module. The Dependent Task button in the Tasks grid give the user the
option to select the dependent tasks. On click of each task, the Dependent Task button is
enabled that displays a pop up window where the user has the provision to select the dependent
task for the selected task. The selected dependent task is also displayed in the Task Grid.

[E] Dependent Tasks (57) | [ 116 > »
Task Name Run Name
B Hide [[] NON_SEC_RISK_WEIGHT_MAPPING_POPULATION PMSegBasel3Std_Scr
[C] PARTY_TYPE_RECLASSIFICATION_POPULATION_IRB USA - US Il - Minimum Tier 1 Leverage Ratio Calculation
B seope [] PARTY_TYPE_RECLASSIFICATION_POPULATION_STD PMSegBasel3Std_Scr
B Runs (2) AddRun | € Remo) [] PROD_TYPE_RECLASSIFICATION_POP_IRB USA - US Ill - Minimum Tier 1 Leverage Ratio Calculation
D Run Name [[] PROD_TYPE_RECLASSIFICATION_POP_STD PMSegBasel3Std_Scr
[] 1443686743571 PMSeqBasel3s| [J] SUB_EXPOSURES_NON_SEC PMSegBasel3Std_Scr
[ 1443686743540 USA - US Ill - Wi [C] CRM Mitigant Volatility Haircut - Supenvisory Haircut PMSegBasel3Std_Scr
3 [] Mitigant Eligibility - STD PMSegBasel3Std_Scr
E Tasks (54) | [ Dependent Task [_] Non Sec Basel Methodology Assignment - STD PMSegBasel3Std_Scr
Task Name [] Collateral Eligibility - STD PMSegBasel3Std_Scr
[v] Non Sec Pre-itigation RW UL for [Link | [ close |
[ NON_SEC_RISK_WEIGHT_MAP!
[[] PARTY_TYPE_RECLASSIFICATI
PROD_TYPE_RECLASSIFICATION_POP_STD PMSeqBasel3sta_scr
[] SUB_EXPOSURES_NON_SEC PMSegBasel3Std_Scr CRM Mitigant Volatility Haircut - Supenvisory Haircut Mitigant Eligibilit v
< >

Monitoring a Reporting Plan
After submission the reporting plan is monitored for completion of individual tasks.
Viewing a Reporting Plan

This helps the user to view the reporting plan. The user needs to be mapped to the
DGPMVIEWGRP group.

To get the Process Monitioring Plan and task details in T2T_FCT_PLAN_TASK_EXEC every time
when the new plan and tasks are added following steps need to be followed.
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Create the batch from FSDF Rule Run framework screen.

Execute the created batch with selected tasks.

Execute the fct_plan_task_exec excluding T2T_FCT_PLAN_TASK_EXEC

Execute the DIM_TASK, DIM_RUN_EXECUTION and DIM_REPORT_SUB_PLAN.

Execute the FCT_PLAN_TASK_EXEC batch including only
T2T_FCT_PLAN_TASK_EXEC Task.

o M wbh P
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11 Dashboards

111

Dashboards will provide the reports for the various modules in the DGUSRR Application.

Data Quality Dashboards

Data Quality Rules for the Dashboards should be executed through batches only and not through
DQ screen.

Batches corresponding to Data Quality and Data Profile have to be executed to view the
dashboards. Refer the Runchart for further details.

Based on Data Quality check defined in the DQ framework of AAAI, Dashboard generates the
reports. These are predefined values as well. Dashboard generates the reports based on what
kind of check type the user wants to analyze the data with.

Data Quality Dashboard provides the data based on following list of drop-downs and selecting the
desired Date:

e Batch Name

e DQ Group Name

e DQ Type

e lteration

Click Apply to generate the reports. Click Reset to reset the values.
The first grid displays the following data:

e Pass DQ percentage (Green shows the pass DQ %)
o Fail DQ percentage (Red shows the failed DQ %)

e Number of Total Records

¢ Number of Valid Records

e Number of Invalid Records

e Number of entities, attributes, and DQ checks

Batch Name --Select Value-- |v SDQGroup Name' --Select Value-- v SDQType --Select Value-- v/ Fpate: 11/30/2010 v Wteration| --Select Value-- [v|B Apply | Reset v

3277 total records
2884 valid records
393 invalid records
2 entities 18 attributes 20 DQ checks

dit

88%
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11.1.1 Distribution of Error Records by Attribute Count

This analysis displays the distribution of error records based on range of attribute counts in the
form of pie charts and bar graphs.

Distribution of Error Records by Attribute Count

of Reca

Edit

1. Click either on pie chart or bar graph to get drill down which displays the following details:
o Entity
e Attributes
e DQ Check Type Name
o Percentage of Rejected Records Count
2. Click Attributes to display the following:
o Data Profile: It displays 2 analyses:

= Data Profile: Tabular representation of the following data based on Entity-Attribute

Name:
" Count Distinct values
" Count Null Values
" Max Value
. Mean Value
" Minimum Value
" Outliers — Greater than 2x mean
" Outliers — Less than 2x mean
" Total Row Count

Business Intelligence search (T B €3 /cvnced Administration Help v SignOu|

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs webloy

Data Profile  Data Buckets =

Data Profile

Entity Stage Cards  Attribute Product Code

Statistic Name Statistic Value
Count Distinct Values 1
Count Null Values 6
Total Row count 7
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= Trend of Data Profile:
. It is a Graphical representation of the following data based on

Entity-Attribute Name:

] Count Distinct values
] Count Null Values
] Total Row Count

Trend of Data Profile

Entity Stage Cards
Attribute  Count Distinct Values  Count Null Values Total Row count

i I l I

o Data Bucket: It displays 2 analyses:

= Data Bucket: Data Bucket is the tabular representation of the following data based on
Dimension Table:

] Node Code

] Distribution Count

Business Intelligence search (IR G €3 ~donced Administration Help v Sign Oy

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblo|

Data Profile  Data Buckets =

Data Buckets

Dimension Node Code Distribution Count
Product Dimension NCF 1

= Trend of Data Bucket:
. It is a graphical representation of Distribution Count and Node

Codes against time intervals. The Trend of Data Buckets includes two types of

graphs:
" Bar Graph
" Line Graph

Trend of Data Buckets

11.1.2 Distribution of Error Records by Error Type

This analysis displays the distribution of error records based on error type.
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Distribution of Error Records by Error Type

Colum
Reference
or
Specific
B Vaie
Check,

No. of
Records

Column Reference or Specific \/alue Check

1. Click either on pie chart or bar graph to get drill down which displays the following details:
e Entity
e Attributes
e DQ Check Type Name
o Percentage of Rejected Records Count
e Date
2. Click Attributes to display the following:
o Data Profile: It displays two analyses:

= Data Profile: Tabular representation of the following data based on Entity-Attribute

Name:
" Count Distinct values
" Count Null Values
. Max Value
" Mean Value
. Minimum Value
" Outliers — Greater than 2x mean
" Outliers — Less than 2x mean
= Total Row Count

Business Intelligence search (TENNENEED B €3 /dvenced Administration Help v Sign O

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblo|

Data Profile  Data Buckets

Data Profile

Entity Stage Cards  Attribute Product Code

StatisticName  Statistic Value
Count Distinct Values 100
Count Null Values 6.00
Total Row count 7.00

Trend of Data Profile

Entity Stage Cards
Attribute  Count Distinct Values  Count Nul Values Total Row count

il I I I
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= Trend of Data Profile: Graphical representation of the following data based on Entity-
Attribute Name:

] Count Distinct values
] Count Null Values
. Total Row Count

e Data Bucket: It displays two analysis:

= Data Bucket: Data Bucket is the tabular representation of the following data based on
Dimension Table:

] Node Code

] Distribution Count

Business Intelligence are Advanced Administration Help v  Sign Oul|

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | B Open v | SignedInAs weblog|

Data Profil=  Data Buckets =

Data Buckets

Dimension Node Code Distribution Count
Product Dimension NCF 1.00
SLBA 7.00

Trend of Data Buckets

Distribution ¢

= Trend of Data Bucket: Graphical representation of Distribution Count and Node Codes
against time intervals. The Trend of Data Buckets includes two
types of graphs:

= Bar Graph
" Line Graph
11.1.3 Distribution of Defaults by Attribute Count

This analysis displays the distribution of default records based on attribute count.

Distribution of Defaults by Attribute Count

M Not defaulted, No. of Records

Not defaulted

1. Click either on pie chart or bar graph to get drill down which displays the following details:
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e Entity

e Attributes

e DQ Check Type Name

e Percentage of Rejected Records Count
2. Click Attributes to display the following:

e Data Profile: It displays two analysis:

= Data Profile: Tabular representation of the following data based on Entity-Attribute

Name:
" Count Distinct values
" Count Null Values
. Max Value
" Mean Value
. Minimum Value
" Outliers — Greater than 2x mean
" Outliers — Less than 2x mean
" Total Row Count

Business Intelligence rch (3 E) Adwenced Administration Help v  Sign Ou

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblos

Data Profile  Data Bucksts

Data Profile

Entity Stage Cards  Attribute Next Payment Date

Statistic Name  Statistic Value
Count Distinct Values 1.00
Count Null Values. 6.00
Total Row count 7.00
Trend of Data Profile
Entity Stage Cards
Attribute Count Distinct Values  Count Null Values Total Row count

Next Payment Date I I

= Trend of Data Profile: Graphical representation of the following data based on Entity-
Attribute Name:

] Count Distinct values
] Count Null Values
] Total Row Count

o Data Bucket: It displays two analysis:

» Data Bucket: Data Bucket is the tabular representation of the following data based on
Dimension Table:
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] Node Code

] Distribution Count

Business Intelligence rch (@ Y Advenced Administration Help v  Sign O

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblo

Data Profile  Data Buckets

Data Buckets

Node Code Distribution Count
] 1.00

VAN
PERF 1.00
inciples Dimension USGAAP 7.00
RA 1.00
us
NG 1.00
ssa 7.00
us 1.00

Trend of Data Buckets

100%

= Trend of Data Bucket: Graphical representation of Distribution Count and Node Codes
against time intervals. The Trend of Data Buckets includes two
types of graphs:

" Bar Graph

= Line Graph

11.2 Controls Dashboard

Execute the batches corresponding to Controls to view the Controls dashboards.
This section displays two dashboard pages:
e Summary

e Controls by Regulatory Reports

11.2.1 Summary

Select the date to generate the dashboard reports.

Following are the types of Controls that are displayed as the Performance Tiles in the Controls
module:

e Quality Control: Provides the number of Quality controls present in the system.

e Operational Control: Provides the number of operational controls present in the system.
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Business Intelligence search (T GRN €3 /cvonced Administration Help v SignOut

Home | Catalog | Favorites v | Dashboards v | [ New v | B5 Open v | SignedInAs weblogic

Summary | Controls by Regulatory Reports =0

Date| 11/30/2010  |v|

11.2.1.1 Quality Controls by Rating

This section provides the graphical representation of Number of Controls against Quality
Controls. The three types of Rating Name are listed as follows:

o Effective
e Ineffective

e Qualified

Quality Controls by Rating

Count of Controls

Ineffective
Rating Name

Edit

1. Click the graphs to view the drill-down Control Assessment reports. The following data is
displayed under Control Assessment dashboard:

e Control ID

e Control Name

e Number of DQ checks
e Assessment ID

e Assessment Date

e Effective Score
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e Rating Name

Control Assessment Details

Control ID Control Name Number of DQ checks AssessmentID Assessment Date Effective Score Rating Name
51010 Original Term in Original Term 2 52782 12-Nov-16 80,00 Ineffective
51020 Interest Provision Amount MTD in Interest Provision Amount MTD 1 52785 12-Nov-16 80.00 Ineffective
51029 Account Write-off Date in Account Write-off Date 1 52772 12-Nov-16 80.00 Ineffective
51080 Card Renewal Date in Card Renswal Date 1 52784 12-Nov-16 80.00 Ineffective
51113 Next Payment Date in Next Payment Date 1 52777 12-Nov-16 100.00 Ineffective
51114 Account Open Date in Account Open Date 1 52786 12-Nov-16 80.00 Ineffective
51139 Account Writeback Date in Account Writeback Date 1 52778 12-Nov-16 80.00 Ineffective
51180 Next Payment Date in Next Payment Date 1 52773 12-Nov-16 80.00 Ineffective
51226 Adjustment Effective Date in Adjustment Effective Date 2 52787 12-Nov-16 100,00 Ineffective
51278 Last Repriced Date in Last Repriced Date 1 52788 12-Nov-16 80.00 Ineffective
51293 End Of Period Balance in End Of Period Balance 1 52781 12-Nov-16 80.00 Ineffective
51305 Biling Cycle Date in Billing Cycle Date 1 52783 12-Nov-16 80.00 Ineffective
51395 Last Activity Date in Last Activity Date 1 52771 12-Nov-16 80.00 Ineffective
51415 Last Card Status Update Date in Last Card Status Update Date 1 52775 12-Nov-16 80.00 Ineffective
51444 Last Payment Date in Last Payment Date 1 52776 12-Nov-16 80.00 Ineffective
51517 Number Of Times Delinquent Throughout Life in Number Of Times Delinquent Throughout Life 1 52789 12-Nov-16 80.00 Ineffective
51540 Last Credit Limit Change Date in Last Credit Limit Change Date 1 52779 12-Nov-16 80.00 Ineffective
51583 Next Reprice Date in Next Reprice Date 1 52780 12-Nov-16 80.00 Ineffective
51839 Revised Renewal Date in Revised Renewal Date 1 52774 12-Nov-16 100.00 Ineffective

Return - Edit - Create Bookmark Link

2. Click Assessment ID to view the drill-down Control Parameter Score.

Control Parameter Score

Control ID Assessment ID Assessment Date Parameter ID Parameter Name P Weight F value Parameter Score
51010 52782 12-Nov-16 1 Number of DQ checks that the data element goes through 80.00 2 1.00
2 Percentage of error flags (from all DQs put together) 20.00 97.5 0.00

Return - Edit - Create Bookmark Link

11.2.1.2 Quality Control Effectiveness Trend

This section provides the graphical representation of Number of Quality Controls within a period
of six months from the selected date.
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Quality Control Effectiveness Trend

@ Effective
@ Qualified

Count of Controls

2010 201

Time

3. Click the graphs to view the drill-down Control Assessment reports. The following data is
displayed under Control Assessment dashboard:

e Control ID

e Control Name

¢ Number of DQ checks
e Assessment ID

e Assessment Date

o Effective Score

e Rating Name

4. Click Assessment ID to view the drill-down Control Parameter Score.

11.2.1.3 Operational Controls by Rating

This section provides the graphical representation of Number of Controls against Operational
Controls. Following listed are the three types of Rating Names:

e Effective
e Ineffective

e Qualified
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Operational Controls by Rating

~
o

o
(=]

ount of Controls

(

Ineffective

Rating Name

Edit

5. Click the graphs to view the drill-down Control Assessment reports. The following data is
displayed under Control Assessment dashboard:

Control ID

Control Name
Number of DQ checks
Assessment ID
Assessment Date
Effective Score

Rating Name

6. Click Assessment ID to view the drill-down Control Parameter Score.

11.2.1.4 Operational Control Effectiveness Trend

This section provides the graphical representation of Number of Operational Controls within a
period of six months from the selected date.

Oracle Financial Software Services 111




User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

Operational Control Effectiveness Trend
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7. Click the graphs to view the drill-down Control Assessment reports. The following data is
displayed under Control Assessment dashboard:

e Control ID

e Control Name

e Number of DQ checks
e Assessment ID

e Assessment Date

o Effective Score

e Rating Name

8. Click Assessment ID to view the drill-down Control Parameter Score.

11.2.2 Controls by Regulatory Reports

Select the desired Regulatory Report, the Date and click Apply to view the Control Assessment
Analysis dashboard.

Following details are listed in the Control Assessment Analysis report:
e Rating Name

e Reporting Line Item
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Business Intelligence

Home | Catalog | Favorites v | Dashbol

Summary  Controls by Regulatory Reports

= . |
Report FFIEC-009 v/ Date 11/30/2010 vl apply | Reset~

Control Assessment Analysis

Rating Name Effective Qualified
Reporting Line Item
DATASET_JOINS
FEDFIEC009AP002MB75
LA1150C02
LA1305C02
LA3170C02
LA3271C02 1
LA3730C02
LAS510C02

g

f

11.3 Key Indicators Dashboards

This dashboard displays various reports based on analysis of key indicators in the system.

11.3.1 Summary

The Summary page displays the following Performance Tiles:

e Total Key Indicators: It displays the total number of key indicators.

e Value Based Key Indicators: It displays the total number of Value based Key Indicators.
e Variance Key Indicators: It displays the total number of Variance based Key Indicators.
e Breached Key Indicators: It displays the total number of Breached Key Indicators.

1. Select a date and click Apply to display the records based on the selected date.

Business Intelligence [} Adwanced Administration Help v  Sign Out]

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New v | B8 Open v | SignedInAs weblog

Summary | Ks by Regulatory Reports =(

Date 01/05/2011 [Vl Apply | Reset~

4522 237 4285 86

Total Key Indicators Value Based Key Indicat... Variance Key Indicators Breached Key Indicators

2. Click each Performace Tile to display the Key Indicator details. The following details are
displayed:

= Key Indicator ID
= Name

= Description

= Comment

* Type
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Business Intelligence Advanced Administration Help v Sign Out

Key Indicators Home | Catalog | Favorites v | Dashboards v | I New v | B& Open v | Signedinas

Key Indicator Details

Key Indicator yame Description Comment Type

11002 Variance of number of loans in servicing portfolo “This Key Indicator compares the value of number of loans in servicing portfolio as of current period with that of previous period K Variance
Comments

11003 Variance of fiylls This Key Indicator compares the value of fry11 s as of current period vith that of previous period K Variance
Comments

11004 Variance of total loans and lease financing receivables: past due 30-89 days and stil  This Key Indicator compares the value of total loans and lease financing receivables: past due 30-89 days and still accruing s of current period with that of previous period K Variance
accruing Comments

11005 Variance of balances due from bank holding company (parent companies only), gross  This Key Indicator compares the value of balances due from bank holding company (parent companies only), gross as of current period with that of previous period K Variance
Comments

11006 Variance of allowance for loan and lease losses - balance end of previous calendar year This Key Indicator compares the value of allowance for koan and lease losses - balance end of ‘year as of ‘with that of | riod K Variance
Comments

11007 Variance of other identfiable intangible 2ssets This Key Indicator compares the value of other identifiable intangible assets as of current period with that of previous period Kt Variance
Comments

11008 Variance of commercial and similar letters of credit “This Key Indicator compares the value of commercial and similar letters of credit as of current period with that of previous period Kt Variance
Comments

11009 Variance of foreign exchange rate contracts - commitments to purchase foreign ‘This Key Indicator compares the value of foreign exchange rate contracts - commitments to purchase foreign currencies and u.s. dollar exchange (futures, forward, and spot) as of current  KI Variance
currencies and u.s. do period with that of previous period Comments

11010 Variance of assets held in trading accounts - securities of alforeign governments and  This Key Indicator compares the value of assets held in trading accounts - securties of all foreign governments and offcial institutions s of current period with that of previous period K Variance
Comments

11011 Variance of net deferred tax labiity This Key Indicator compares the value of net deferred tax liabity as of current period with that of previous period [ Variance
Comments

3. Click Key Indicator ID to display the Assessment Details page. The following details
are displayed:

= Assessment ID

= Key Indicator ID

= Current Period Value
= Previous Period Value
= Variance

= Variance Percentage
= RAG Score

= Status

Key Indicators

Assessment Details

Assessment ID Key Indicator ID Current Period Value Previous Period Value Variance Variance % Rag Score Status
58828 11002
80049 11002
Return - Edit - Create Bookmark Link

Following are the various sections of dashboards:

e Rating Distribution for Variance Kls: This report displays the latest rating distribution for
the assessed variance Kis.
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Rating Distribution for Variance KIs

Passed
M Breached

Edit

e Trend of Rating Distribution for Variance Kls: This report displays the trend of the latest
rating distribution for the assessed variance Kis.

Trend of Rating Distribution for Variance KIs

Total
100 Assessed
Kis
80
ook [l Breached
ou
40

Jan-2011
ime

Edit

e Rating Distribution for Value Based Kls: This report displays the latest rating distribution
for the assessed value based Kis.
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Rating Distribution for Value Based KIs

=
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M Breached
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Trend of Rating Distribution for Value Based Kls: This report displays the trend of the
latest rating distribution for the assessed value based Kis.

Trend of Rating Distribution for Value Based KIs

20 Total
Assessed

M Breached

Jan-2011

m
Q.
-

11.3.2 Kls by Regulatory Reports

The Kls by Regulatory Reporting page displays the following Performance Tiles:

Total Key Indicators: It displays the total number of key indicators.
Value Based Key Indicators: It displays the total number of Value based Key Indicators.
Variance Key Indicators: It displays the total number of Variance based Key Indicators.

Breached Key Indicators: It displays the total number of Breached Key Indicators.
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To view the aforementioned values for a particular report, select the particular report name from
the dropdown, click Apply.

Business Intelligence [} Adwanced Administration Help v SignOut

Key Indicators Home | Catalog | Favorites v | Dashboards v | & New v | B Open v | SignedInAs weblogi

Summary  KIs by Regulatory Reports £

£8101/05/2011 [V apply | Reset~

73 73 0 4

Total Key Indicators Value Based Key Indicat... Variance Key Indicators Breached Key Indicators

Click the Performance Tiles to view the Key Indicator Details. The following data is displayed:
¢ Key Indicator ID

e Name

o Description

e Comment

o Type

Business Intelligence search CNENNES G €3 ~cdonced Administration Help v Sign Out

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New v | B Open v | SignedInAs weblogic|

Key Indicator Details

:‘;V Indicator e Description Comment Type

11002 Variance of number of kans in servicing portfolo “This Key Indicator compares the value of number of oans in sevicing portfolo as of current period with that of previous period K Variance
Comments

11003 Variance of frylls ‘This Key Indicator compares the value of fry11 s as of current period with that of previous period K Variance
Comments

11004 Variance of total loans and lease fivancing receivables: past due 30-69 days and stil  This Key Indicator compares the value of total loans and lease financing receivables: past due 30-89 days and stillaceruing as of current period with that of previous period K Variance
accring Comments

11005 Variance of balances du from bank hokding company (parent companies only), gross  This Key Indicator compares the value of balances due from bank hokling company (parent companies only), gross as of current period with that of previous period K Variance
Comments

11006 Variance of allowance for loan and lease losses - balance end of previous calendar year This Key Indicator compares the value of allowance for loan and lease losses - balance end of previous calendar year as of current period with that of previous period [ Variance
Comments

11007 Variance of other identfiable intangible assets “This Key Indicator compares the value of other identifiable intangible assets as of current period vith that of previous period K Variance
Comments

11008 Variance of commercial and similr ltters of credit “This Key Indicator compares the value of commercial and similr letters of credit as of current period with that of previous period K Variance
Comments

11009 Variance of foreign exchange rate contracts - commitments to purchase foreign ‘This Key Indicator compares the value of foreign exchange rate contracts - commitments to purchase foreign currencies and u.s. dollar exchange (futures, forward, and spot) as of current  KI Variance
currencies and us. do period with that of previous period Comments

11010 Variance of assets held in trading accounts - securties of allforeign governments and  This Key Indicator compares the value of assets heK! in trading accounts - securities of ll foreign governments and offcialinstitutions as of current period with that of previous period K Variance
offcialins Comments

11011 Variance of net deferred tax labilty “This Key Indicator compares the value of net deferred tax iabilty as of current period with that of previous period K Variance
Comments

Following are the various sections of dashboards:
e Variance Analysis: It provides the following data for the selected report:
= Reporting Line Item: It displays the reporting line item for the selected report.

= Key Indicator: It provides the description of the Kls with respect to the Reporting Line
[tem.

= Current Period Value: It provides the current period value for the respective Reporting
Line Item

= Previous Period Value: It provides the previous period value for the respective
Reporting Line Item

Oracle Financial Software Services 117



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

= Variance: It provides the difference in Current and Previous Period Value for the
particular Reporting Line Item

= Variance Percentage: It displays the percentage of variance based on Previous Period
value

= Status: It displays the status of the Kls depending on the various values.

Business Intelligence Search (STHENEEEEES G €3 /cvonced Administration Help v Sign Of

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New v | B Open v | SignedInAs weblo|

Summary  KIs by Regulatory Reports i

Variance Analysis

Reporting Line Item Key Indicator Current Period Value Previous Period Value Variance Variance % Status
AAAS310 Variance of general loan and lease valuation alowances

ARAT205 Variance of total risk-based capital ratio

ARNAT206 Variance of tier 1 risk-based capital ratio

Ana173 Variance of tier 2 capital - excess of elgible credit reserves over total expected credt losses (u

AARATIS3 Variance of eligible credit reserv

ANAPTS3 Variance of common equity tier 1 capital ratio 72,373,452.00
AnAAPB36 Variance of expected credit koss that excesds eigile credt reserves

AnaAP911 Variance of total allowance for loan and lease losses (all) under the standardized approach
AnE247 Variance of undiided profits and capital reserves (retained earmings)

AAB5310 Variance of general oan and lease valuation allowances

87205 Variance of total risk-based capial ratio

AnB7206 Variance of tier 1 risk-based capital ratio

88274 Variance of tier 1 capital allowable under the risk-based capital guideines

AnrBA223 Variance of risk-weighted assets (net of alowances and other deductions)

AAABI61 Variance of less: gain-on-sale associated with securitization exposures

AnaBP742 Variance of common equity tier 1 capital: common stock phis related surplus, net of treasury stock a
AAABP793 Variance of common equity tier 1 capital ratio

AAABPB39 Variance of common equity tier 1 minority interest includable in common equity tier 1 capital
AnaEPB41 Variance of goodwil net of associated deferred tax liabilties (dtks)

Aaagras2 Variance of intangible assets (other than goodwil and mortgage servicing assets (msas)), net of ass
AAAEPB43 Variance of deferred tax assets (dtas) that arise from net operating koss and tax credit carryforwar
AdAEPB4S Variance of accumulated net gain (loss) on cash flow hedges indluded in aodi, net of applcable tax
AnAEPES1 Variance of non-significant i ts in the capital of unconsolidated financial nsttutions in t

AMAEPS3 Variarnce of significant investments in the capital of unconsolidated financial institutions in the f

AMEPESS Variance of msas, net of associated dtis, that exceed the 1C common equity tier 1 capital de

o Performance Indicators: It provides the following data for the selected report:
= Reporting Line Item: It displays the reporting line item for the selected report.

= Key Indicator: It provides the description of the Kls with respect to the Reporting Line
Item.

= Current Period Value: It provides the current period value for the respective Reporting
Line Item

= Status: It displays the status of the Kls depending on the various values.

Key Indicators Home | Catalog | Favorites v | Dashboards v |

Summary  KIs by Regulatory Reports

Performance Indicators

Reporting Line Item Key Indicator Current Period Value Status
SUBCO399 Equity interest in nonrelated organizations Null & Negative indicator s
SUBC1729 Other borrowed money with a remaining maturity of more than one year Null & Negative indicator w0 g
SUBC1754 Held-to-maturity securities Null & Negative indicator w0 g
SUBC1773 Available-for-sale securities Null & Negative indicator w0 g
SUBC2013 Total off-balance-sheet items range indicator

SUBC2143 Intangible assets Null & Negative indicator Q
SUBC2145 Premises and fixed assets (including capitalized leases) Null & Negative indicator 1.00 o
SUBC3240 Surplus (exclude all surplus related to preferred stock) under equity capital Null & Negative indica 1.00 o
SUBC3415 Commitments to purchase foreign currencies and U.S. dollar exchanges (spot, forward, and futures) Nu w Qg
SUBC3450 Notional value of interest rate swaps Null & Negative indicator 1.00 Q
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e Trend Analysis: It displays the trend of total assessed Kls and breached Kis for a particular
time interval.

Trend Analysis

1200 Total

- Assessed
Kls

300

== Breached

600

300

0
Jan-2011 Feb-2011 Jul2011 Oct-2011 Jan-2012 Jul2012

Click the graph marks to view the Key Indicator Details drill down report.

Business Intelligence Search (STHEEEEES B €3 ~cerced Administration Help v Sign Oul

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblog

Key Indicator Details

KeyIndicator | game Description Comment  Type

11003 Variance of frylls “This Key Indicator compares the value of fryl1 s as of current period with that of previous period Ki Variance
Comments

11007 Variance of other identiiable intangible assets This Key Indicator compares the value of other identifiable intangible assets as of current period with that of previous period K Variance
Comments

11012 Variance of provision for loan and lease losses This Key Indicator compares the value of provision for loan and lease losses as of current period with that of previous period K Variance
Comments

11015 Variance of provision for loan and lease losses This Key Indicator compares the value of provision for loan and lease losses as of current period with that of previous period KI Variance
Comments

11019 Variance of net change in fair values of financial instruments accounted for under a fair value  This Key Indicator compares the value of net change in fair values of financial instruments accounted for under a fair value option as of current period with that of previous period  KI Variance
opti Comments

11022 Variance of gains (losses) on securities not held in trading accounts “This Key Indicator compares the value of gains (Josses) on securities not held in trading accounts as of current period with that of previous period Kt Variance
Comments

11031 Variance of net deferred tax assets This Key Indicator compares the value of net deferred tax assets as of curent period with that of previous period K Variance
Comments

11032 Variance of noninterest expense pertaining to related organizations This Key Indicator compares the value of noninterest expense pertaining to related organizations as of current period with that of previous period Kt Variance
Comments

11053 Variance of applicable income taxes This Key Indicator compares the value of applicable income taxes as of current period with that of previous period K Variance
Comments

11054 Variance of noninterest income from related organizations This Key Indicator compares the value of noninterest income from related organizations as of current period with that of previous period K Variance
Comments

11057 Variance of accounts payable This Key Indicator compares the value of accounts payable as of current period with that of previous period K Variance
Comments

11064 Variance of noncash income from negative amortization on cosed-end loans secured by 14 This Key Indicator compares the value of noncash income from negative amortization on closed-end loans secured by 1-4 family residential properties as of current period with that of K1 Variance
family resi pravious per Comments

11086 Variance of perpetual preferred stock (inchuding related surplus) “This Key Indicator compares the value of perpetual preferred stock (including related surplus) as of current period with that of previous period Ki Variance
Comments

11078 Variance of insurance commissions and fees “This Key Indicator compares the value of insurance commissions and fees as of current period with that of previous period K Variance
Comments

11080 Variance of accumulated other comprehensive income “This Key Indicator compares the value of accumulated other comprehensive income as of current period with that of previous period Kt Variance
Comments

Key Indicators: Kis by Regulatory Reports > KI Details Breached Trend Analysis

11.4 Process Monitoring

This dashboard provides the following two pages:
e Process Monitoring

e Process Analysis
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11.4.1 Process Monitoring

When a Plan is executed, the user can refresh the page to check the details of on-going tasks.

Select a Plan from the drop-down and click Apply to view the Process Monitoring dashboard. It
also displays the Plan Owner and Plan Status based on the Plan selection.

This section describes the following analysis:
e Plan Scope

e Task Tracking

11.4.1.1 Plan Scope

This grid displays the Report Name and Report Description associated with the selected Plan
from the drop-down.

Business Intelligence search (NN SN €3 ~conced Administration Help v SignOut |

Process Monitoring Home | Catalog | Favorites v | Dashboards v | & New v | BS Open v | SignedIn As weblogic

Process Monitoring  Process Analysis 2@

"% Plan | Daily regulatory report submission plan v Apply | Reset v

Plan Owner: User Name 1 Plan Status : Complete

Plan Scope
Report Name Report Description
FR2052a Complex Institution Liquidity Monitoring Report
FR 2052b Liquidity Monitoring Report

Edt

11.4.1.2 Performance Tiles

Following Performance Tiles are displayed based on the selected Plan:
e Total Runs: It displays the count of total number of runs

e Total Tasks: It displays the count of total number of tasks

e Tasks Complete: It displays the percentage of tasks completed

e Time Elapsed: It displays the time elapsed during the execution of the Plan.

Business Intelligence search CTTNENENENNNES G €3 ~cvonced Administration Help v Signout C|

Process Monitoring Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedIn As weblogic |

Process Monitoring  Process Analysis = @
% plan Daily requlatory report submission plan [v I apply | Reset~
Plan Owner: User Name 1 Plan Status : Complete
Edit
Plan Scope

Report Name Report Description

FR 20522 Complex Institution Liquidity Monitoring Report

FR 2052 Liquidity Monitoring Report
Edit

1 55 100% 00:01:15
Tasks Time Elapsed
Total Runs Total Tasks ek e
Edit Edit Edit
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11.4.1.3 Task Tracking

This grid displays the following data based on the selected Plan:

e Run Task Hierarchy: It displays the Runs associated with the Plan and tasks associated with
the Runs.

e Start Time: It displays the start time of each Run on Run level and start time of each task
associated with the Run.

e End Time: It displays the end time of each Run on Run level and end time of each task
associated with the Run

e Time Taken: It displays the total time taken by each Run on Run level and time taken by each
task associated with the Run.

e Status: It displays the status of each Run on Run level and status of each task associated
with the Run.

Business Intelligence EY Advenced Administration Help v  Sign Out]

Process Monitoring Home | Catalog | Favorites v | Dashboards ~ | B New v | B Open v | SignedIn As weblog
Process Monitoring  Process Analysis

Task Tracking

Time Taken (HH:MM:SS) Status
US FED Run
Reg Collateral Stock - Mitigant
Reg Collateral Stock - Placed
Reg Covered Transaction Type - Credit Line
Reg Covered Transaction Type - Loans
Reg Covered Transaction Type - Securities Borrowings and Lending  13-Dec-
Reg Liq Cashflow - Inflow Assets - Forward Asset Purchases
Reg Liq Cashflow - Inflow Assets - Unsettled Asset Purchases
Reg Liq Cashflow - Inflow Others - Derivatives
Reg Liq Cashflow - Inflow Secured - Collateral Swaps
Reg Liq Cashflow - Inflow Secured - Dollar Rolls
Reg Liq Cashflow - Inflow Secured - Reverse Repo
Reg Liq Cashflow - Inflow Secured - Securities Borrowings
Reg Liq Cashflow - Inflow Unsecured - Nostro Account
Reg Liq Cashflow - Inflow Unsecured - Offshore Placement
Reg Liq Cashflow - Inflow Unsecured - Onshore Placement
Reg Liq Cashflow - Loan Book - Committed Draws

11.4.2 Process Analysis

Select a Plan from the drop-down, select a date and click Apply to view the Process Analysis
dashboard.

It displays Average Total Time (HH:MM:SS) Performance Tile.

Business Intelligence search (NN R €3 /conced Administration Help v Signout (|

Process Monitoring Home | Catalog | Faworites v | Dashboards v | [ New v | B Open v | SignedInAs weblogic «

Process Monitoring  Process Analysis

S lan Daily regulatory report submission plan  |v | 'patel 12/13/2016 |vi Apply | Resst~

00:01:15

Average Total Time
HH:MM:SS

The following sections are displayed in this dashboard:

e Plan Performance
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e Longest Running Tasks

e Trend of Rating Distribution for Variance Kls

e Trend of Rating Distribution for Value Based Kls
e Trend of Issues

e Quality Control Effectiveness Trend

e Operational Control Effectiveness Trend

e Trend of Issues

11.4.2.1 Plan Performance

This report displays the time taken by the Run.

Business Intelligence E) Adanced Administration Help v  Sign Out

Process Monitoring Catalog | Favorites v | Dashboards v | & New v | B% Open v | SignedInAs weblogic

Hii

)

Process Monitoring  Process Analysis

Plan Performance

US FED Run

Click X axis to view the Task level details.

11.4.2.2 Longest Running Tasks

This report displays the time taken by each task in descending order.

Business Intelligence search (THENEEENENNES G £) /conced Administration Help v Signout (|

Process Monitoring Home | Catalog | Favorites v | Dashboards v | [ New v | B5 Open v | SignedIn As weblogic <

Process Monitoring  Process Analysis

Longest Running Tasks

Time Taken (HH:MM:SS)

s - Affiiated and Sweep Accous

w Wholesale - Group 2

flow Unsecured - Onshore Placement

w Assets - Unsettled Asset Purchases
w - Outflow Othy

utflow Others - MTV Impact

uppl Info - Structured Debt

pIFX

flow Others - Derivatives

flow Unsecured - Offshore Placement

Loss of Rights - Placed

11.4.2.3 Trend of Rating Distribution for Variance Kls

This report displays the rating distribution of Variance Kls in the form of bar-graph.
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Business Intelligence

Process Monitoring

Process Monitoring Process Analysis

Trend of Rating Distribution for Variance KIs
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11.4.2.4 Trend of Rating Distribution for Value Based Kls

This report displays the rating distribution of Value Based Kls in the form of bar-graph.
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Trend of Rating Distribution for Value Based KIs

i
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Il Breached
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11.4.2.5 Trend of Issues

This report displays issue reported for Kls based on the selected plan.

Trend of Issues

12-Nov-16

reated Date

23-Jan-17

Issue (

Oracle Financial Software Services

124




User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

11.4.2.6 Quality Control Effectiveness Trend

This report displays the Quality Control Effectiveness, based on the selected Plan, in the form of

bar-graph.
Quality Control Effectiveness Trend
2}
=
=
S Ineffective,
¥ : . No. of
s Controls
3
Q

Nov-2010

Time

11.4.2.7 Operational Control Effectiveness Trend

This report displays the Operational Control Effectiveness, based on the selected Plan, in the
form of bar-graph.

Operational Control Effectiveness Trend

.

6
v
S 5
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8 < -» Effective
= = |neffective
S 3 Qualified
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=
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1

il

2010 2011
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11.4.2.8 Trend of Issues

This report displays issue reported for Controls based on the selected plan.

Trend of Issues

12-Nov-16

23-Jan-17

25-Jan-17

11.5

1151

Regulatory Report Monitoring

Select a Plan Name from the dropdown, select a date from the calendar and Click Apply to view
the Regulatory Report Analysis.

The following values are displayed in terms of Performance Tiles:
¢ Reporting Elements with Errors: It displays the percentage of Reporting Elements with Errors.

e Reporting Elements with breach in Variance Key Indicators: It displays the percentage of
Reporting Elements associated with breached Variance Key Indicators

e Reporting Elements with breach in value Based Key Indicators: It displays the percentage of
Reporting Elements associated with breached Value Based Key Indicators

e Reporting Elements with Control Failures: It displays the percentage of Reporting Elements
associated with failed controls.

e Issues in total: It displays the total number of issues associated with Controls and KI.
e OQutstanding Issues: It displays the total number of open issues.

Regulatory Report Analysis dashboard displays the following grids:

e Plan Analysis by Report

e Issue and Action Tracking

Plan Analysis by Report

This analysis displays reports, schedules, and count of Reporting Elements associated with the
selected Plan.
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1. Select the Report Name from the drop-down to view the following data:
e Schedule Name: It displays the name of schedule.
e Total: It displays the number of reporting elements linked to schedule
e Without Errors: It displays the number of reporting elements without errors

e Variance Indicator Breach: It displays the number of reporting elements linked to breached
Variance Indicators

e Kl Breach: It displays the number of reporting elements linked to breached Value Based
Key Indicators

e Control Failure: It displays the number of reporting elements linked to failed controls.

Plan Analysis by Report

Reporting Elements
Schedule Name Total Without Errors Variance Indicator breach KI Breach Control Failure
FR-2( 0 0 0 0 0

2. Click Total associated with each schedule to display Reporting Element drill-down Report.
Following details are displayed:

e Schedule: It displays the name of the schedule.

¢ Cell Reference: It displays the reporting elements associated with the schedule.
e Breached Variance KI: It displays if there are any Breached Variance Kis.

e Breached Value Based KI: It displays if there are any Breached Value Based Kis.

¢ Ineffective Control: It displays if there are any Ineffective Controls.
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Regulatory Report Analysis

Reporting Element Drill - Schedule Report

Schedule  Cell Reference Breached Variance KI Breached Value Based KI Ineffective Control

FFIEC-041 RC RCON0071 No No Yes
RCONO081 No No Yes
RCON2130 No No No
RCON2145 No No No
RCON3000 No No No
RCON3163 No No No
RCON3200 No No No
RCON3230 No No No
RCON3656 No No No
RCON3838 No No No
RCON3839 No No No
RCON5369 No No No
RCONG631 No No No
RCONG636 No No No
RCONA130 No No No
RCONBS528 No No No
RCONB530 No No No
RCONB987 No No No
RCONB993 No No No

3. Click No Errors associated with each schedule to display Reporting Element drill-down
Report. Following details are displayed:

e Schedule: It displays the name of the schedule.

o Cell Reference: It displays the reporting elements associated with the schedule.
e Breached Variance KI: It displays if there are any Breached Variance Kis.

e Breached Value Based KI: It displays if there are any Breached Value Based Kis.

¢ Ineffective Control: It displays if there are any Ineffective Controls.
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Business Intelligence

Regulatory Report Analysis

Schedule Cell Reference Breached Variance KI Breached Value Based KI Ineffective Control

FRY-14A A.1.a DATASET_JOINS No No No
FEDFRY14ASUMPOO2R0030C0010 No No No
FEDFRY14ASUMPOO2R0O030C0020 No No No
FEDFRY14ASUMPOO2R0030C0030 No No No
FEDFRY14ASUMPOO2R0030C0040 No No No
FEDFRY14ASUMPOO2R0030C0050 No No No
FEDFRY14ASUMPOO2R0030C0060 No No No
FEDFRY14ASUMPO02R0030C00S0 No No No
FEDFRY14ASUMPOO2R0030C0100 No No No
FEDFRY14ASUMPO02R0040C0010 No No No
FEDFRY14ASUMPO02R0040C0020 No No No
FEDFRY14ASUMPO02R0040C0030 No No No
FEDFRY14ASUMPO0O2R0O040C0040 No No No
FEDFRY14ASUMPO02R0O040C0050 No No No
FEDFRY14ASUMPOO2R0040C0060 No No No
FEDFRY14ASUMPO02R0040C0070 No No No
FEDFRY14ASUMPOO2R0040C0080 No No No
FEDFRY14ASUMPO02R0040C00S0 No No No
FEDFRY14ASUMPO02R0060C0010 No No No
FEDFRY14ASUMPO02R0O060C0020 No No No
FEDFRY14ASUMPO02R0O060C0030 No No No
FEDFRY14ASUMPOO2R0O060C0040 No No No
FEDFRY14ASUMPOO2R0060C0050 No No No
FEDFRY14ASUMPO02R0O060C0060 No No No
FEDFRY14ASUMPOO2R0060C0070 No No No

Q Ez Rows 1-25
Return - Analyze - Edit - Refresh - Create Bookmark Link

4. Click Variance Indicator Breach associated with each schedule to display Variance
Indicators and Issue Details — Variance Based Indicators drill-down Report. Following details
are displayed in Variance Based Indicators:

e Plan Name
e Report Name
e Schedule

e Date
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e Variance Indicator

e Owner

e Report

¢ Cell Reference

e Current Value

¢ Previous Value

e Variance

e Variance %

e Variance % (Last Period)
e Status

e Status (Last Period)

¢ Comments

Business Intelligence search CHEEES G €3 ~cdonced Administration Help v Sign Of
Regulatory Report Analysis Home | Catalog | Favorites v | Dashboards v | I New v | B Open v | SignedInAs weblo|
Variance Indicators
Plan Name :QA Test 1 Report : FFIEC101 Schedule: SchG Date : 04-Jan-11
Variance Indicator Owner Report Cell Reference CurrentValue Previous Value Variance Variance % Variance % (Last period) Status Status(Last Period)
Variance of 100 defauk OFSAD FFIEC101 AAGEX034 1.00 [+ [+
AAGFI034 1.00 [+ [+
AATK034 1.00 [+) +
ANIL034 1.00 [+ [+
Variance of eligible margin loans where a 300% risk-weight has been applied OFSAD FFIEC101 ARXI037 1,00 o [+
Variance of probabilty of default (pct) 0.00 to < 0.15 OFSAD FFIEC101 AAFDI0OS 1.00 o °
Variance of probabilty of defaut (pct) 0.15 to < 0.25 OFSAD FFIEC101 AAFFI008 1.00 o o

Following details are displayed in Issue Details-Variance Based Indicators:
e Issue ID

e Issue Name

e Variance Indicator

e Cell Reference

e Issue Owner

e Target Completion Date

e Issue Status

e Action Name

e Action Status
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e Action Owner

e |ssue Source Name

Business Intelligence EY Adanced Administration Help v Sign Ol

Regulatory Report Analysis Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | SignedInAs weblo)

i

Issue Details - Variance Indicators

Issue 5 5 cell Target Completion  Issue Action Action Action . -
= Tssue Name Variance Indicator eforence e e e s Issue Source Name
52792 Issue Testing 1 12-Nov-2016 Open
53544 Issue Testing 2 Prepaid expenses under other Assets Null & Negative indicator  BHCSA022 12-Nov-2016 Open Prepaid expenses under other Assets Null & Negative indicator
User Name 1 12-Nov-2016 Open
- Reg Liq Cashflow - Outflow Deposts - Prepaid Cards Issue Owner 30-Jan-2017 Open Reg Liq Cashflow - Outflow Deposits - Prepaid Cards
_1479376218501_Taskss
in Reg Lig Cashflow - Inflow Unsecured - Nostro Account Issue Owner 30-Jan-2017 Open Reg Liq Cashflow - Inflow Unsecured - Nostro Account
DGSCONFINFO_1479376218501_Task84
e in Task - Reg Liq Cashflow - Inflow Secured - Dollar Rolls Issue Owner 30-Jan-2017 Open Reg Lia Cashflow - Inflow Secured - Dollar Rolls
GSCONFINFO_1479376218501_Task79
Reg Covered Transaction Type - Securiies Borrowings and Issue Oviner Open Reg Covered Transaction Type - Securities Borrowings and
_1479376218501_Task123 Lending Lending
99903 Reg Covered Transaction Type - Loans Issue Oviner 30-Jan-2017 Open Reg Covered Transaction Type - Loans
_1479376218501_Task122
99905 Reg Covered Transaction Type - Credit Line Issue Ovner 30-Jan-2017 Open Reg Covered Transaction Type - Credit Line

in
GSCONFINFO_1479376218501_Task120

99906 Issue in Task- Reg Trading Position Class - External Cash Transaction Issue Owner 30-Jan-2017 Open Reg Trading Postion Class - External Cash Transaction
DGSCONFINFO_1479376218501_Task115

99907 Issue in Task

ask - Reg Trading Position Class - Customer Longs. Issue Owner 30-Jan-2017 Open Reg Trading Position Class - Customer Longs
DGSCONFINFO_1479376218501_Taski14

99908 1

Reg Liq Cashflow - Suppl Info - Structured Debt Issue Owner 30-Jan-2017 Open Reg Liq Cashflow - Suppl Info - Structured Debt
_1479376218501_Task110

999 Reg Lig Cashflow - Suppl Info - Client Position

e Owner 30-Jan-2017 Open Reg Li Cashflow - Suppl Info - Client Position

_1479376218501_Task109

9910 sk - Reg Lia Cashflow - Suppl Info - Other Collateral Sub Risk and Issue Owner 30-Jan-2017 Open Reg Lig Cashflow - Suppl Info - Other Collateral Sub Risk and
DGSCONFINFO_1479376218501_Task108 Capacity Capacity

99911 Issue in Tasl Reg Liq Cashfiow - Suppl Info - Sub Risk and Capacity Issue Ovmer 30-Jan-2017 Open Reg Liq Cashflow - Suppl Info - Sub Risk and Capacity
DGSCONFINFO_1479376218501_Task107

99913 Issue in Task- Reg Lig Cashflow - Outflow Others - TBA Purchases Issue Ovner 30-Jan-2017 Open Reg Liq Cashflow: - Outflow Others - TBA Purchases

5. Click KI Breach associated with each schedule to display Value Based Indicators and Issue
Details — Value Based Indicators drill-down Report. Following details are displayed in Value
Based Indicators:

e Plan Name

e Report

e Schedule

e Date

e Name

e Owner

e Report

e Cell Reference
e Value

e Status

e Value (Last Period)

e Status (Last Period)
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Business Intelligence F Adwnced Administration Help v SignO|

Regulatory Report Analysis Home | Catalog | Favorites v | Dashboards v | [ New v | B Open v | SignedinAs

Value Based Indicators
Plan Name :Quarterly regulatory report submission plan Report :FRY-11 Schedule :B5-M Date :05-Jan-11

Name Owner Report Cell Reference Value Status Value(Last Period) Status{Last Period)
Balances due from related institutions, gross in BS indicator with Balances due from related institu ~ User Name 1 FRY-11 BHCS1793 o Q@ [+
Cash dividends declared indicator with Stock under equity capital User Name 1 FRY-11 BHCS4598 0.00

Dollar amount of loans and other assets in servicing portfolio indicator with Number of bansand ot User Name 1 FRY-11 BHCSA020 0.00

Fair value under Loans that are past due S0 days or more indicator with Loans under Assets heldin  User Name 1 FRY-11 BHCSFS39 0.00

Net change in fair values of financial instruments accounted for under a fair value option indicator User Name 1 FRY-11 BHCS)980 0.0(

©0 0006 ©6 6 0 o0
e 6 0 o

Number of loans and other assets in servicing portfolio indicator with Dollar amount of loans and ot User Name 1 FRY-11 BHCSA(

13

Realized gains (losses) on securities indicator vith Held to maturites or Available for Sake securi User Name 1 FRY-11 BHCS4091

Sale, conversion, acquisition, or retirement of common stock and perpetual preferred stock indicator  User Name 1 FRY-11 BHCSA035 100

Trading Revenue indicator from trading assets or trading liabilities User Name 1 FRY-11 BHCSA220 0.00 o
Trading assets indicator vith Assets held in trading accounts User Name 1 FRY-11 BHCSS478 100

Unpaid principal balance under Loans that are past due 90 days or more indicator with Loans under As User Name 1 FRY-11 BHCSF640

Following details are displayed in Issue Details - Value Based Indicators:
e [ssue Name

¢ Key Indicator

¢ Cell Reference

e Issue Owner

e Target Completion Date
e Issue Status

e Action Name

e Action Status

e Action Owner

e Issue Source Name

¢ Kl Report Code

e Kl Schedule Code

Tssue Details - Value-Based Indicators

IssueName  Key Indicator Cell Reference Issue Owner Target Completion Date Issue Status Action Name Action Status Action Owner Issue Source Name KI Report Code KI Schedule Code
Issue Testing 1 User Name 1 12-Nov-2016 Open FFIEC041  RGRCA
Issue Testing 2 Prepaid expenses under other Assets Null & Negative indicator BHCSAD22 User Name 1 12-Nov-2016 Open Prepaid expenses under other Assets Null & Negative indicator FRY-11 BS-M

User Name 1 12-Nov-2016 Open

Anshze - Edit - Refresh

Createa

6. Click Control Failure associated with each schedule to display Control details and Issue
Details — Value Based Indicators drill-down Report. Following details are displayed in Control
Details:

e Plan Name
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¢ Report Name
e Schedule

e Date

e Control Name
e Owner

o Effectiveness

e Cell Reference

¢ Data Quality Checks

Business Intelligence search (TN B £ /cvenced Administration Help v SignO|

Regulatory Report Analysis Home | Catalog | Favorites v | Dashboards v | [ New v | B5 Open v | SignedInAs weblq

Control Details - Schedule Report
Plan Name : Quarterly regulatory report submission plan Report : FFIEC-031 Schedule : RC Date: 30-Nov-10

Control Name Owmer Effectiveness Cell Reference Data Quality Checks
End Of Period Balance in End Of Period Balance User Name 1 RCFD0071
RCFD00S1
RCFD1410
RCFD1420
RCFD1460
RCFD1563
RCFD1590
RCFD1763
RCFD1764
RCFD1797
RCFD2081
RCFD2107
RCFD2746
RCFD3381
RCFD3484

RCFDS367

Following details are displayed in Issue Details - Controls:
e [ssue Name

e Control Name

e Cell Reference

e Issue Owner

e Target Completion Date

e |ssue Status

e Action Name

¢ Action Status

e Action Owner
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Business Intelligence search (TN G €3 ~conced Administation Help v Sign |
Regulatory Report Analysis Home | Catalog | Favorites v | Dashboards v | I New v | B% Open ~ | SignedInAs webk|
Issue Details - Controls
Issue Name Control Name Cell Reference Issue Owner Target Completion Date Issue Status Action Name Action Owner Action Status Control Report Code Control Schedule Code
Issue Testing 1 ATM Expenses in ATM Expenses User Name 1 12-Nov Open
User Name 1 Open
e Testing 2 Prepaid expenses under other Assets Null & Negative indicator User Name 1 Open
User Name 1 Open
Issue in Task - DGSCONFINFO_1479376218501_Task105 Reg Lia Cashflow - Outflow Others - TBA Purchases Issue Oviner Cosed
Open
Issue in Task - DGSCONFINFO_1479376218501_Task107 Reg Lia Cashflow - Suppl Info - Sub Risk and Capacity Issue Oviner Open
Open
Issue in Task - DGSCONFINFO_1479376218501 _Task108 Reg Lia Cashflow - Suppl Ifo - Other Collateral Sub Risk and Capacity Issue Owiner Open
Open
Issue in Task - DGSCONFINFO_1479376218501_Task109 Reg Lia Cashflow - Suppl Info - Client Position Issue Owner Open
Open
Issue in Task - DGSCONFINFO_1479376218501_Task110 Reg Lia Cashflow - Suppl Info - Structured Debt Issue Owner Open
Open
Issue in Task - DGSCONFINFO_1479376218501_Task114 Reg Trading Position Class - Customer Longs. Issue Owner Open
Open
Issue in Task - DGSCONFINFO_1479376218501_Task115 Reg Trading Position Class - External Cash Transaction Issue Owner 30-Jan-2017 Open
30-Jan-2017 Open

7. Click Data Quality Checks associated with each Control to display the following Data Quality
Details:

e ID

e DQ Check
* Type

¢ Result Entity

e Attribute

Business Intelligence

Regulatory Report Analysis

Data Quality Details

Type Result Entity  Attribute
than Cash bolance. Colm 8 or Spechi Ve Check Faled  Stage Cards End Of Perod Balance.

Regulstory Report Ansiysis: Page 2 > Regulatory Report Anslyss: Canirols > Dets Quaity Detsls

11.5.2 Create a New Issue

Click Create a New Issue hyperlink to navigate to the OFSAA Create Issue page where the user
can log in a new issue.
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Business Intelligence Advanced Administration Help v Sign Out]

Regulatory Report Analysis

Home | Catalog | Favorites v | Dashboards v | I New v | B Open v | SignedIn As weblog|

i

Plan Analysis by Report

Reporting Elements View Reporting Schedule Hisrarchy Report Schedule Reporting Element View Reporting Schedule Hierarchy Report Schedule Reporting Element
Report / Schedule Total No Errors Variance Indicator breach KI Breach Control Failure KI Schedule Code KI Report Code Control Schedule Code Control Report Code:
> FDIC-8020 15 15 0 0 0 FDIC-8020 FDIC8020
> FRY-19A 9718 440 ) 0 FRY-148 FRY-142
Anahze - Edit -Refresh

Issue and Action Tracking

IssueID Issue Name Issue Owner Target Completion Date Issue Status Action Name Action Owner Action Status.
154840 sk - DGSCONFINFO_1487248181328_Task105 23-Feb-2017 New

156174 k - DGSCONFINFO_1467246181328_Task62 28-Feb-2017 New

156742 Testing OFSAD 16-Feb-2018 New

156964 Testing OFsAD 28-Feb-2017 New

160755 testingl OFSAD 28-Feb-2017 Open testingl OFsAD Complete

181570 79000 OFsAD 28-Feb-2018 Open

181692 7492677 OFSAD 28-Feb-2018 Open 1059580 OFsSAD Complete
2483657  OFSAD Open
3303869  OFSAD Open
7267442 OFSAD Open
7460126 OFSAD Complete
78900 OFsAD Open
9201654  OFSAD Open

11.5.3 Create Action

Click Create Action hyperlink to navigate to the OFSAA Create Action page where the user can create
an action.

| =l save Draft Cancel

Action Name* ID 7 301066
Description ‘
Criticality* vJ Owner* (5]
Start Date* Iy j 2 Target Date* ii ¥ (2
Reminder(days)* [ ) 3
Component* Control [~ Primary Source Instrument Code in Stage Investments
Comments [~

Oracle Financial Software Services 135



User Guide: Oracle Financial Services Data Governance
for US Regulatory Reporting Release 8.0.4.0.0

12 Metadata Browser

This section includes the following sections:

e Exporting Metadata Browser Objects to XML

e Registering a Metadata Browser Object

e Publishing a Metadata Browser Business Term

12.1 Exporting Metadata Browser Objects to XML

You can export the Metadata Browser (MDB) objects, in an XML format. This exported XML can
be directly used to import data in the database. By using this XML export functionality you can:

e Export the list of all the objects of a particular object type.
o Export all the details of a particular object.

Based on the requirement you need to make the respective Webservice call by passing request
XMLs, with all the fields required to generate the desired output XML.

The WebService class that holds the two methods is the MDBObjectExportWs. A Webservice
call to either of the methods in this class should be made from the server on which the
application is hosted, to the server on which the Webservice is hosted, such as the OFSAAI
server.

1. To generate an XML with list of all the objects of a particular object type, you need to invoke
the generatexXMLObjectsList (String xml) .

Use the following format of request xml with the fields holding not null values:

<Object>

<infodom>{infodom}</infodom>
<objectType>{Object Type Id}</objectType>
</Object>

Below is the format of the corresponding response XML:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<Objects>

<object>

<Id>{object def id}</Id>

<Name>{object name}</Name>

<MasterId>{master id}</MasterId>

<Folder>{folder name}</Folder>

<Type>{object type id}</Type>
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</object>

<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
</object>

<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>

</object>

<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
</object>
</Objects>
2. To generate an XML with with all the details of the object, you need to invoke the
generateXMLObjectDetails (String xml) .

Use the following format of request xml with the fields holding not null values:
<object>

<infodom>{infodom}</infodom>

<Id>{Object def id}</Id>

<Name>{object name}</Name>

<MasterId>{Master Id} </MasterId>

<Folder>{Folder name}</Folder>
<Type>{Object Type Id}</Type>
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</object>

Following is the format of the corresponding response XML:
<?xml version="1.0" encoding="UTF-8" standalone="no"?>

<Object>
<Id>{Object def id}</Id>
<Name>{object name}</Name>
<MasterId>{Master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
<Properties>
<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>
<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>

<AttributeValue>{attribute value}</AttributeValue>

<AttributeValue>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>
<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>

</Property>

<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>

</Properties>
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<DependentObjects>

<DependsOn>
<Object
<Object

Id="obj def id"
Id="obj def id"

Type="object type id"/>
Type="object type id"/>

<Object Id="obj def id" Type="object type id"/>
</DependsOn>
<UsedIn>
<Object Id="obj def id" Type="object type id"/>
<Object Id="obj def id" Type="object type id"/>
<Object Id="obj def id" Type="object type id"/>
</UsedIn>
</DependentObjects>
</Object>

12.2 Registering a MDB Object

The Mutility registers a new MDB object based on the input XML. You should provide valid entries
in this XML before execution.

Provide the path of input XML file in the MDBObjectRegistration.properties file located in
the FIC DB/conf folder.
Following is an example of a Sample MDBObjectRegistration.properties file:

file path:/FIC_HOME/XML Directory/MDBObjectRegistraionSample.xml

In the command line execute the ‘MDBObjectRegistration.sh' shell script available in
FIC DB/bin folder. After successful execution you can view the object in the MDB.

The XML file has a predefined template. You can only provide values based on this template
structure.

Following is the Input XML template:

<OBJECT TYPE ID="">
<INFODOM></INFODOM>
<NAME></NAME >
<TYPE>E</TYPE>
<LOCALE>en US</LOCALE>
<ATTR_GROUP ID="1">
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<FORM_CODE></FORM CODE>

<GROUP_FORM CTIL ID></GROUP FORM CTIL_ ID>

<GROUP_FORM_CTL_NAME></GROUP_FORM CTL NAME>

<LAYOUT TYPE>1</LAYOUT TYPE>

<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE ID="1">
<TYPE>1</TYPE>
<FORM_CODE></FORM_ CODE>
<CONTROL_ID></CONTROIL, ID>
<CONTROL_NAME></CONTROL_ NAME>
<OBJECT LINK>1</OBJECT LINK>
<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER_CODE></MEMBER_ CODE>
<PARAM VALUE></PARAM VALUE>

</ATTRIBUTE>
<ATTRIBUTE ID="2">
<TYPE>1</TYPE>

<FORM_CODE></FORM CODE>
<CONTROL_ID></CONTROL_ ID>
<CONTROL_NAME></CONTROL NAME>
<OBJECT LINK>1</OBJECT LINK>
<DISPLAY ORDER>2</DISPLAY ORDER>

<ATTRIBUTE_LOCALE_PACKAGE></ATTRIBUTE_LOCALE_PACKAGE>
<MEMBER_CODE></MEMBER CODE>
<PARAM_VALUE></PARAM_VALUE>

</ATTRIBUTE>
<ATTRIBUTE ID="3">
<TYPE>1</TYPE>

<FORM_CODE></FORM CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL_NAME></CONTROL_ NAME>
<OBJECT LINK>1</OBJECT LINK>
<DISPLAY ORDER>3</DISPLAY ORDER>

<ATTRIBUTE LOCALE_ PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER _CODE></MEMBER CODE>
<PARAM VALUE></PARAM VALUE>
</ATTRIBUTE>
</ATTR_GROUP>
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<ATTR_GROUP ID="2">
<FORM CODE></FORM_ CODE>
<GROUP_FORM CTL ID></GROUP_ FORM CTL ID>
<GROUP_FORM CTL NAME>C</GROUP_FORM CTL NAME>
<LAYOUT TYPE>3</LAYOUT TYPE>
<DISPLAY ORDER>2</DISPLAY ORDER>
<ATTRIBUTE ID="1">
<TYPE>1</TYPE>
<FORM_ CODE></FORM CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL_NAME>C</CONTROL NAME>
<OBJECT_LINK></OBJECT LINK>
<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER_ CODE></MEMBER_ CODE>
<PARAM VALUE></PARAM VALUE>

</ATTRIBUTE>
<ATTRIBUTE ID="2">
<TYPE>1</TYPE>

<FORM_CODE></FORM_ CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL NAME></CONTROL NAME>
<OBJECT LINK></OBJECT LINK>
<DISPLAY ORDER>2</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER CODE></MEMBER_ CODE>
<PARAM VALUE></PARAM VALUE>
</ATTRIBUTE>
</ATTR_GROUP>
<MENU ID="">
<MENU TYPE>MDB OBJECT VIEW</MENU TYPE>
<PARENT MENU_ ID></PARENT MENU ID>
<DEFAULT LABEL></DEFAULT LABEL>
<USER_PRIVILEGES></USER PRIVILEGES>
<GROUPING REQUIRED>N</GROUPING REQUIRED>
</MENU>
</OBJECT>
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12.3 Publishing a MDB Business Term

The execution occurs through the command line by calling the MDBPublishExecution shell
script in the FIC_DB/bin location.

Following are the prerequisites for publishing:

You should make an entry for both MDBGIlossarylmplementation and
MDBSubjectArealmplementation API in the MDB_POP_IMPL_LIST table . The order of
execution order should be such as, first the subject area should be executed, followed by the
glossary.

You should create a menu for the Business Term in MDB, using MDB_MENU_DETAILS
table, before publishing.

An object type of 15001 for Business Term and 15002 for subject area is created in the MDB
table.

After executing the APIs, Subject area objects and Business Term objects are populated in
the MDB tables.

You should specify the attribute layout in the tables MDB_OBJECT_TYPE_LAYOUT and
MDB_OBJECT_TYPE_ATT_LAYOUT. After successful execution, you can view the
Business Term objects in the Meta Data Browser.
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13 Metadata Report Extract

Metadata Report Extract Functionality helps the user to export OFSAA metadata into Excel sheet
and XMLs. This feature helps to get a view of OFSAA metadata and its dependencies. It is a
template based approach where-in user creates templates and selects Metadata Objects that
need to be extracted. The extraction process is supported only for Excel and XMLs. While
defining the template, user is expected to have prior knowledge of the OFSAA Metadata objects
that are relevant from his application point of view.

13.1 Prerequisites

The following executions must be performed before using the Metadata Report Utility:

1. MDB Publish: Execute the batch, INFODOM_MDB

Logs: MDB logs are generated under deployed area
/Context_Name/logs/MDB_XXXX.log
2. Data Elements Wrapper: Execute the batch, INFODOM_POP_DATA_ELEMENTS_USFED

Logs: Data Elements logs are generated in atomic schema under
FSI_MESSAGE_LOGS table.

NOTE: Both executions require adequate tablespace. Ensure your atomic schema is
having enough tablespace.

13.2 Creating and Exporting Metadata Report Templates

Perform the following steps to create and export Metadata Report Templates:

1. Navigate to Object Administration - Utilities - Metadata Report.

24 DGS Master Summary - Intermet Explorer =6 s

By A vsemen | orsy
ORACLE Financial Services Analytical Applications

Applications ~ Object Administration = System Configuration & Identty Management

Tempiate
yical Appications Infrastructure -

» & Object Administration =
« Template List {3) 1§ Add

| Tempiate Name Tempiate Descripion Created Date Created By Status
report 2314 17022017 OFsaD Compie
usage 17022017 OFsaD Comple
ineage 17022017 OFsAD Compie

2. Click Add icon, in Summary screen, to create a new Metadata Report template.

Object A System G & Identity

Select Applications Common Tasks > Metadats Report

Financial Semvices Dala Govemnance for US Reg .. ¥ ¥ Search and Filter ) Go ) Clear ) Refresh

Tempiste | | Templete
4 @ common Tasks o Neme

» @ Data Model Management

» Template List (3} [§ Add
» [E] Unified Analytical Metadata

B Metadata Report % Templste |0 ¥ | Template Neme Template Description Crested Date q
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3. Provide the Name and Description for the new template in Template Definition page.
Click Save and Next.

Template Definition

Back L Next
Definition Choose Object type

Definition
Basic Details

Name NDfTest X

Description Tester

@ Save Return

4. Select the desired object from the Object Type dropdown to be exported. Select Export
Options type as Individual/Relational.

Individual report generates only the basic properties of the object selected, that is, name
and description. Relational report generates detailed information up to the Entities level,
if Dependencies is chosen; and up to the Staging Columns level, if Data Lineage is
selected along with Dependencies.

Dependencies: Metadata object is dependent on several other metadata objects.
Metadata object is also used (that is, consumed) in several other metadata objects.
Dependency or usage tree can be of any depth. For example, a rule can be dependent
on a hierarchy, business processor, and dataset. Further, each of these metadata objects
can be dependent on other metadata objects. Metadata Export Utility exports all the
dependent or used metadata objects for all paths in the dependency or usage tree, if this
option is selected.

Lineage: Data is loaded from source systems to staging and then moved across to
processing / reporting. Lineage traces the data element as it moves across different
layers of OFSAA: staging, processing, and reporting. Metadata Export Utility exports the
lineage of each of the reporting area data element that is identified by dependencies.

For Individual: In the Export Options, do not select Dependencies or Data Lineage.
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Financial Services Anslytical Applications Infrastructure > Object Administration > Utiities > Metadsta Report

Template Definition

< Back O L4 O Next >
Definition Choose Object ty.. Filter Objects
Choose Object type
Object Types

Choose  pashboard %
Export Options

Dependencies

Data Lineage

@ Save ¥ Return

The exported sample report for Individual is as follows:

A B C D E F

1 [CLASSIFICATION RULE DEF ICLASSIFICATION_RULE_NAME CLASSIFICATION_RULE_DESC il
2 1465916940587 RRDF - 14Q FRY 9C Line Re- Classification RRDF - 14Q FRY 9C Line Re- Classification

3

2 =
5

6 |
7

8

9

10

1

W 4 » ¥ | Classification Rule %] [ m | 0.

For Relational: In the Export Options, select Dependencies.

Financial Services Analytical Appli frasts re > Object Admini: 1 > Utilities > Metadata Report

Template Definition

< Back ) L d O Next >
Definition Choose Object ty... Filter Objects

Choose Object type

Object Types

Choose | pashboard x

Export Options

Dependencies ()

Data Lineage

& Save ¥ Return
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The exported sample report for Relational is as follows:

A B c D E F G H J K
1 [Path Name IDependency =
2 Path1 Dashboard > Report = View = Hierarchy = Entities »
3 |Path2 Dashboard > Report = Viiew > Derived Entity > Measure > Entities >
4 Path3 Dashboard > Report = View = Derived Entity = Hierarchy > Entities =
5 Pathd Dashboard > Report = View > Derived Entity > Dataset > Alias > Entities >
6 |Paths Dashboard > Report = View > Derived Entity > Dataset > Entities =
7 |Pathé Dashboard > Report = View » Derived Entity > Business Processor > Measure » Entities >
8 Path? Dashboard > Report > Viiew > Derived Entity > Business Processor > Dataset > Alias > Entities >
9 |Pathg Dashboard > Report = Viiew » Derived Entity > Business Processor > Dataset > Entities >
10 Pathd Dashboard > Report = View > Reporting Element > Measure > Entities = A |
11 Path10 Dashboard > Report = View » Reporting Element > Hierarchy > Entities = 1
12 Path11 Dashboard = Report = View = Reporting Element > Derived Entity > Measure > Entities =
13 Path12 Dashboard » Report > Viiew » Reporting Element > Derived Entity > Hierarchy » Entities >
14 Path13 Dashboard > Report = View > Reporting Element > Derived Entity > Dataset = Alias > Entities >
15 |Path14 Dashboard > Report = View » Reporting Element > Derived Entity > Dataset > Entities >
16 Path15 Dashboard > Report = View > Reporting Element > Derived Entity > Business Processor > Measure > Entities >
17 |Path16 Dashboard > Report = View » Reporting Element > Derived Entity > Business Processor > Dataset > Alias > Entities =
18 Path17? Dashboard > Report = View » Reporting Element > Derived Entity > Business Processor > Dataset » Entities >
19 Path18 Dashboard > Report = View > Reporting Element > Business Processor > Measure > Entities >
20 Path1g Dashboard > Report = View > Reporting Element » Business Processor > Dataset > Alias > Entities » T
21 Path20 Dashboard > Report > Viiew > Reporting Element > Business Processor = Dataset > Entities =
22 |
4 4 » v| paths <Pathl Path2 "Path3 ~Path4 . Paths - Pathé - Path7 .~ Pathg8 . Pathi [l I ] 0.

The first sheet shows the different Paths and their Dependencies upto the Entities level.
Select the required Path sheet at the bottom to view the dependencies.

Each path tells how the dependency/usage is derived from dashboard to entity or vice
versa involving various OFSAA object types like Derived Entity, Hierarchies, Datasets,
Measures, and so on.

These paths are generated by the system using data already published in MDB
dependency tables as part of OFSAA MDB object publish.

1. For every dependent object type displayed in each path sheet, the following columns
are displayed:

a) Object type name

b) Object type description

c) One or many Object specific properties (optional)
For example: In Pathl, Dashboard is the first Object type, the dependencies generated
are Dashboard Name, Dashboard Description, and Dashboard properties: Dashboard
Country, Dashboard Regulator and so on. Similarly, Report is the next Object type in
Pathl and the dependencies generated are Report Name, Report Description, Views
Name, Views Description, View Display Format and so on. Then followed by Hierarchy
Objects name, description and properties up to the Entities level.
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A g C [) 3 H 1 J
1 _NAME _DESC _COUNTRY _REGULATOR E TREPORT_DESC v»sws NAME VIEWS_DESC VIEW_DISPLAY_FORMAT HIERARCHY_NAME F
2 FRY-11 Financial Statements of US. USA Board of Governors of the Federal Resene |BS [Schedule BS?Balance Sheet FRY-11-BS FRY-11-8S Tabular IFRS - Reported at fair Value Flag H
3 |FRY-11 Financial Statements of U.S. USA Board of Govemars of the Federal Reserve [BS-M [Schedule BS-M?Memoranda FRY-11-85M FRY-11854 Tabular Reg delnquency band Hisrarchy
4 FRY-1 Financial Statements of U'S. USA Board of Governors of the Federal Reserve [BS-M Schedule BS M2Memoranda FRY-118SM FRY-118SM Tabular Sale type code Hierarchy
5 [FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS [Schedule BS7Balance Shest FRY-11:85  FRY-118S  Tabular IFRS - Fair Value RCY Hierarchy
6 FRY-11 Financial Statements of U.S. USA Board of Goverors of the Federal Resen [1S Schedule IS7income Stateme FRY-1145  FRY-114S  Tabular Consolidation Code
7 |FRY-11 Financial Statements of U S. USA Board of Gowemars of the Federal Reserve |IS-8 Schodule IS-B7Changes in Al FRY-11458  FRY-114S8  Tabular Reporting Line Code
8 FRY-11 Financial Statements of US. USA Board of Goverors of the Federal Resenve [BS-M [Schedule BS-M?Memoranda FRY-11-BS-M FRY-11-8SM Tabular Bands hierarchy
9 FRY-11 Financial Statements of U.S. USA Board of Govemrs of the Federal Reserve [BS Schoduie BS7Balance Shest FRY-11-85  FRY-11BS  Tabular Darnative Type Code Hierarchy
10 FRY-11 Financial Statements of U S. USA Board of Gowemars of the Federal Reserne [BS-M [Schedule BS MPMemoranda FRY-11.8SM FRY-11854 Tabular Standard Party Type Hierarchy
11 |FRY-11 Financial Statements of U.S. USA Board of Govemars of the Federal Resene [BS Schedue BS7Balance Shest FRY-11:85  FRY-118S  Tabular Balance Sheet Catagory Hierarchy
12 |FRY-11 Financial Statements of U S. USA Board of Govemrs of the Federal Resenve [BS [Schedule BS7Balance Shest FRY-11-85  FRY-118S  Tabular Trading Account Book Typs Code 1
13 |FRY-11 Financial Statements of U S, USA Board of Governors of the Federal R A?Changes in ECFRY-114SA  FRY-14SA  Tabular Capital Instrument Transaction Typd
14 FRY-11 Financial Statements of US. USA Board of Govemors of the Federal Resenve |BS [Schedule BS7Balance Sheet FRY-11-BS FRY-11-8S Tabular Non Interest beanng deposit Heerard *|
15 FRY-11 Financial Statements of U.S. USA Board of Governors of the Federal Reserve [BS-M [Schedule BS-M?Memoranda FRY-11-BSM FRY-11-BSM Tabular Accrual Status Code Hierarchy
16 |FRY-11 Financial Statements of U'S. USA Board of Govemars of the Fedaral Resene [BS [Schodule BS7Batance Shest FRY-11.85  FRY-1185  Tabular Reporting Line Code
17 FRY-11 Financial Statements of U S. USA Board of Governars of the Federal R ges in ECFRY-114S-A  FRY-1HSA  Tabular Instrument type Hierarchy
18 |FRY-11 Financial Statements of U S. USA Board of Govemors of the Fedaral Reserve [BS-M Schedule BS M7Memoranda FRY-11-8SM FRY-118SM Tabular Reguiatory Product Classifcation |
19 FRY-11 Financial Statements of U S. USA Board of Govemars of the Fedaral Resene [BS-A [Schodulo BS-A”Loans and LeFRY-11.8SA  FRY-1185A Tabular Reg denquency band Hierarchy
20 FRY-11 Financial Statements of U.S. USA Board of Govemars of the Federal Reserve [BS-M Schedue BSMoMemoranda FRY-11-85M FRY-11854 Tabular Balance Sheet Category Hierarchy
21 FRY-11 Financial Statements of U.S. USA Board of Governors of the Federal Reserve [BS-M Schedule BS-M?Memoranda FRY-11-BS-M FRY-11-BS-M Tabular Consolidation Code
2 FRY-11 Financial Statements of U.S. USA Board of Governors of the Fedaral Reserve [BS-M [Schodule BSMPMemoranda FRY-11-85M FRY-11.854 Tabular Holding Type Coda Hierarchy
23 FRY-11 Financial Statements of U'S. USA Board of Governors of the Federal Reserve [BS. [Schedule BS7Balance Sheet FRY-1185  FRY-118S  Tabular Bands hierarchy
24 FRY-11 Financial Statements of U S. USA Board of Govemars of the Federal Resenve [BS [Schedule BS7Balance Shest FRY-11-85  FRY-118S  Tabular Instrument typs Hierarchy
25 FRY-11 Financial Statements of U.S. USA Board of Govemars of the Fedaral Reserve [BS [Schodule BS7Batance Shest FRY-11-85  FRY-1185  Tabular Buy or Sell Indicator Hierarchy
2 FRY-11 Financial Statements of U S. USA Board of Governars of the Federal Reserve [BS-A Schedule BS-A7Loans and LeFRY-11.85A FRY-118SA Tabular Troubled Deb Restructure Flag Hie
27 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve |BS Schedule BS7Balance Sheet FRY-11-BS FRY-11-8BS Tabular (Other Real Estate Owned Flag Hier}
28 FRY-11 Financial Stataments of U.S. USA Board of Govemars of the Fedaral Reser [15-8 [Schedule IS-B7Changes in AIFRY-1145.8  FRY-114S8  Tabular Consolidation Code
29 |FRY-11 Financial Statements of U S. USA Board of Goverars of the Federal Reserve [BS-M Schedule BS M2Memorands FRY-11.8SM FRY-11.8SM Tabular Reg Instrument Classification Hiera
30 |FRY-11 Financial Statements of U.S. USA Board of Goverars of the Federal Reserve [BS-M IScheduie BS-MPMemoranda FRY-118SM  FRY-1185M Tabular Instrument type Hierarchy
31|FRY-11 Financial Statements of U.S. USA Board of Govemors of the Fedaral Reserve [BS-M [Schodule BSM?Memoranda FRY-11-85M FRY-1185M Tabular Risk Factor type code Hierarchy
2 FRY-11 Financial Statements of U'S. USA Board of Govemars of the Federal Resenve JISA [Schedule IS-A7Changes in ECFRY-1145A  FRY-11ISA  Tabular Cansolidation for Aggregation
33 FRY-11 Financial Statements of U.S. USA Board of Governars of the Federal Reserve [BS-A Schedule BS-A7Loans and LeFRY-11-85A  FRY-118SA Tabular Negative Amortization Flag Hiecarct
34 FRY-11 Financial Statements of U.S. USA Board of Goverors of the Federal Reserve [BS-M [Schedule BS-M?Memoranda FRY-11-8SM FRY-118SM Tabular Customer Country Hierarch
35 FRY-11 Financial Statements of U S. USA Board of Govermars of the Federal Reserve [BS-A Schedule BS-A7Loans and LeFRY-11-8SA  FRY-1185A Tabular Accrual Status Code Flag Hierarchy
36 FRY-11 Financial Statements of U S. USA Board of Govemars of the Federal Resen |15 Schedule [S7income Stateme FRY-1145  FRY-114S  Tabular Regorting Line Code
37 FRY-11 Financial Statements of U.S. USA Board of Govemars of the Fedaral Reserve [BS-M Schedule BS-M7Memoranda FRY-11-85M FRY-118SM Tabular Reporting Line Code
AN Cimmeinl Simtammantn 11 8 ICA loe b ot in BE20 ni EOVA1BE B Tabuime PRl S
W4V paths | path1 “Path: _ bathi . bathd Patns _ Pathe  Path7 bathis _wathid _ vathisbathisl Ml

The Usage sample report (generated by default when Dependencies is selected) is as
follows:

| A B C D E F G H J
1 |Path Name Usage
2 Path1 Columns > Hierarchy > View > Report >=Dashboard »
3 |Path2 Columns > Measure = Derived Entity > View > Report >=Dashboard >
4 |Path3 Columns = Hierarchy > Derived Entity > View > Report =Dashboard =
5 |Pathd Columns > Measure = Business Processor > Derived Entity > View > Report =Dashboard =
6 Patho Columns > Measure = Reporting Element > View > Reportt >Dashboard >
7 |Path6 Columns = Hierarchy > Reporting Element > View > Report >Dashboard >
8 Path? Columns > Measure = Derived Entity > Reporting Element > View > Report ~Dashboard >
9 |Pathg Columns > Hierarchy = Derived Entity > Reporting Element > View = Report >Dashboard »
10 (Pathd Columns > Measure = Business Processor > Derived Entity > Reporting Element > View > Report »Dashboard =
11 |Path10 Columns > Measure = Business Processor > Reporting Element > View > Report >Dashboard >
12
13
14
15
H 4 » | paths < Pathl ,“Path2 - Path3 - Path4 'Path5 Path6 -~ Path7 . Pathg - Path{JNIL I

The first sheet shows the different Paths and their Usage upto the Dashboard level.
Select the required Path sheet at the bottom to view the Usage.

B C 0 E G

(i OLUMNS_DESC COLUMNS_PHYSICAL_COL ID  HIERARCHY_NAME HIERARCHY_DESC NIER TYPE msn uum DIl_PROPERTY NIER TOI'AL REQD VIEWS_NAME i
2 Transaction Account Flag ___ Indicates if sad account is consids FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account Flag BI FFIECO31-RC-E

3 Repurchased Ot Indemnifed Flagindicates i the s account is Rep FCT_LOAN_ACCOUNT_SUMMARY. Repurchased or Indemnied Flag Repurchased of Indemaified Flag8I REGUAR Yo FFIECO31-RCP

4 Impairment Amount Under Asc 3 This column stores the impaiment FCT_LOAN_ACCOUNT_SUMMARY . Impair asc31030 Amount Check Impair asc31030 Amount Check 81 REGULAR Yes FRY-9CHC-C

5 Troubled Debt Restructure Flag This column indicates if saxd loan i FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag Troubled Debt Restructure Flag t 81 REGULAR Yes FREC041RC-O

6 Negative Amortization Flag  This column stores if loan has negeFCT_LOAN_ACCOUNT_SUMMARY. Negatwe Amortization Flag Hiera Negative Amortization Flag Heera I REGULAR Yes FFIECA31-RC-C

7 | Mortgage Broker Surrogate Key This stores unique identser for the FCT_LOAN_ACCOUNT_SUMMARY Broker Skey Hierarchy Broker Skey Hierarchy REGULAR Yes FFIECO31-RC-P

8_ Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81 REGULAR Yes FFIEC031-RCR Part Il
3 Cleared Transaction Flay This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81 REGULAR Yes FRY-15D

10 Mark To Market Value In Report This stores the mark to market valuFCT_REG_ACCOUNT_SUMMARY NMtm Value FRAS Hierarchy _ Hierarchy Mim Value FRAS 81 REGULAR Yos FRY-168

11 Broker Sumogate key This stores unique identie for the FCT_DEPOSITS_BORROWINGS N_Broker Hirarchy Deposit Borowi Broker Hierarchy Deposit Borow 81 REGULAR Yes FFIEC-A31-RCE

12 |Callable Deposit indicator Indicates i said deposit can be call FCT_DEPOSITS_BORROWINGS F_ Deposit Option Indicator Hierarct Deposit Option Indicator Hierarct 81 REGULAR Yes FFECO31-RCE :
13 Impairment Amount Under Asc 3 This column stores the impament FCT_LOAN_ACCOUNT_SUMMARY Impar asc31030 Amount Check Impair asc31030 Amount Check BI REGULAR Yes FFIECA31-RC-C

14 Troubled Debt Restructure Flag_This column indicates if saxd loan i FCT_LOAN_ACCOUNT_SUMMARY . Troutled Debt Restructure Flag F Troubled Debt Restructure Flag 81 REGULAR Yes FRY-9CHCN

15 | Troubled Debt Restructure Flag This column indicates if said loan iFCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag f Troubled Debt Restructure Flag ¢ 81 REGULAR Yes FRECO41-RC-C

16 |Troubled Debt Restructure Flag This column indicates if said loan i<FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag } Troubled Debt Restructure Flag } 81 REGULAR Yes FFEC031RC-O

17 Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY . Negative Amortization Flag Hiera Negative Amortization Flag HheraBl REGULAR Yes FRECO41-RC-C

18 Cleared Transaction Flag This columns stores if paticular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc BI REGULAR Yes FFIEC-041-RCR Pant Il
19 Mark To Market Value In Report This stores the mark to market valuFCT_REG_ACCOUNT_SUMMARY NMtm Value FRAS Hierarchy _ Hierarchy Mtm Value FRAS 81 REGULAR Yes FRY-15F

20 | Broker Surrogats key This stores unique identser for the |FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borow Broker Hierarchy Deposit Borow 81 REGULAR Yes FRIECO41-RCE

21 Troubled Dett Restructure Flag This column indicates if sad loan it FCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag F Troubled Debt Restructure Fiaglsi REGULAR Yos FRY-9C-HC-C

22 | Mortgage Broker Surrogate Key This stores unique identifierfor the FCT_LOAN_ACCOUNT_SUMMARY . Broker Skey Hierarchy Broker Skey Hierarchy REGULAR Yes FFECO41-RCP

23 | Mortgage Broker Surrogate Key This stores unique identifierfor the FCT_LOAN_ACCOUNT_SUMMARY. Broker Skey Hierarchy Broker Skey Hisrarchy REGULAR Yes FRY-SC-HCP

24 | Claim Local Cumency Code  Refers to the Local currency code f FCT_REG_ACCOUNT_SUMMARY.V Currency Code Comparison Hier: Currency Code Comparison Hier: 81 REGULAR Yes FFIEC009.C. Part Il

25 Cross Border Claim indicator _ Indicates if sad claim is cross brod FCT_REG_ACCOUNT_SUMMARY F Cross Border Claim Hieraschy  Cross Border Claim Hierarchy 61 REGULAR Yes FFIEC009.C, Pan Il
26 Transaction Account Fl Indicates i ssid account is conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account Flag 81 REGULAR Yes FRY-SCHCE

27 Deposit Call Exercised indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_ Next Option Flag Deposit Bormow Next Option Flag Depost Borron 81 REGULAR Yes FFIECO31-RCE

2 Troubled Debt Restructure Flag This column indicates if saud loan is FCT_LOAN_ACCOUNT_SUMMARY  Troubled Debt Restructure Flag  Troubled Debt Restructure Flag 61 REGULAR Yes FRYTNBSA

29 | Troubled Debt Restructure Flag_This column indicates if said loan isFCT_LOAN_ACCOUNT_SUMMARY  Troubled Debt Restructure Flag | Troubled Dett Restructure Flag REGULAR Yes FR2I4BSA

30 Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY  Negatie Amortization Flag Hiera Negative Amortization Flag Hiera i REGULAR Yes FRY-11-8SA

31 Recourse to General Credit  This stores the recourse to general FCT_REG_ACCOUNT_SUMMARY F Recoursa To General Cred Indic Recourse To General Credit Indi 61 REGULAR Yes FFIECO41-RCY

32 | Contractual Maturty in Days  This column stores the onignal matu FCT_REG_ACCOUNT_SUMMARY K Contractual Maturity Term Heerar Contractual Maturity Term Hierar 81 REGULAR Yes FFIECO41RCR Par I
33 Nettable Pool Suogate Key  This column stores the reference taFCT_REG_ACCOUNT_SUMMARY N Nettabie Pool Surrogate Key Hie Nettable Pool Sumogate Key Hie 81 REGULAR Yes FRY-9C-HCM

34 Broker Surragate key ‘This stores unique identifer for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borow: B1 REGULAR Yes FRY-SCHCE

35 Broker Surogate key This stores unique identier for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borow Broker Hierarchy Deposit Borow 81 REGULAR Yes FFIEC031-RC-O

3 Deposit Call Exercised indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_ Next Option Flag Deposit Bormow Next Option Flag Deposit Borron 81 REGULAR Yes FFIEC041-RCE

37 Depost Listng Senvce Prander This Column Stores the ungue ider FCT_DEPOSITS_BORROWINGS N_Deposit List Skey Herarchy  Deposi List Skey Hierarchy 81 REGULAR Yes FFECO41-RCE
W3 aths | Patha . patha | Bath  Pakhd _ Paths . BaihG . Pathy . Pathé . Pathd .. Pathi0 S N— e = i

Select Data Lineage in Template Definition - Choose Object Type to export the
lineage details up to the Staging Columns level.

NOTE: Data Lineage can be selected only if Dependencies is opted.
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Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Mefadata Report

Template Definition

< Back Q L] O Next »
Definition Choose Object ty.. Filter Objects
Choose Object type
Object Types
Choose  pashboard X

Export Options

Dependencies O
Data Lineage O

& Save ¥ Return

NOTE: Data Lineage is generated as a separate sheet in the generated Relational
report along with the Dependencies. Select the Lineage sheet to view the Data
Lineage (up to Staging column level).

Home | Insert  Pagelaout  Formulas  Data  Review  View @
T e e P TIE I ¢

T [a a7 [ || | Siwrep ij! ¥Eﬂ | = e S &a
P romotpante #1287 & verseacener~ | [$ 7 % o 3 ) ST e swee | w e o | 20 fers saear

Clipboard ) Font ) Alignment ) Number ) Styles Cells Editing
AL - fe | SCHEDULE ¥
A B D D E F G T

1 [SCHEDULE _|VIEW CELL ID DERIVED ENTITY CODE METADATA CODE RESULT AREA TABLE RESULT AREA COLUMN
2 HCE FRY-9C-HC-E BHODE648 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
3 HCE FRY-9C-HC-E BHCB6E48 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
4 HCE FRY-9C-HC-E BHODE648 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
5 |HCE FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
6 [HCE FRY-9CHC-E BHOD2604 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
7 [HCE FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
8 [HCE FRY-9CHC-E BHOD6848 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
9 [HCE FRY-9C-HC-E BHCB2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAF N_REG_DEPOSIT_TYPE_SK
10 |HC-E FRY-9CHC-E BHCB2210 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
11 HC-E FRY-9C-HC-E BHDMA164 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
12 HC-E FRY-9CHC-E BHCB2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
13 HC-E FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
14 |HC-E FRY-8CHCE BHFNA245 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
15 |HC-E FRY-9C-HC-E BHCB6648 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
16 HC-E FRY-8CHCE BHDMA242 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT TYPE_SK
17 |HC-E FRY-9G-HC-E BHFNA245 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
18 HC-E FRY-8CHCE BHOD2604 DERHCEQ3 DSRHCE03 FCT REG_ACCOUNT_SUMMAFN_REG_DEPOSIT TYPE_SK
19 HC-E FRY-9C-HC-E BHDMA242 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
20 HC-E FRY-8CHCE BHFNA245 DERHCEQ3 DSRHCE03 FCT REG_ACCOUNT_SUMMAFN_REG_DEPOSIT TYPE_SK
21 HCE FRY-9C-HC-E BHCB6648 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
22 HCE FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
23 HCE FRY-9C-HC-E BHDMA242 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
24 HCE FRY-9C-HC-E BHCB2210 DERHCEQ3 DSRHCE03 FCT_LEGAL_ENTITY_DETAILS N_ENTITY_TYPE_SKEY
25 HC-E FRY-9C-HC-E BHCB6648 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
26 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
27 HC-E FRY-9CHC-E BHOD2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
28 HCE FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
29 HC-E FRY-9CHC-E BHOD6848 DERHCEQ3 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
30 HCF FRY-9CHCF AHCA?3A DFRHGEN3 NSRHCFO3 FCT RFG_ACCOUNT SUMMAFN RFG DFPOST TYPF SK
W A b W[ Paths ~Pathl  Path2  Path3 , Path4  Path5 . Path Path; Lineage ‘E‘JI ] TR  __.§n1
Ready — |53 O ) 0036 O o

5. Select Filter Objects to see the selected objects.
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Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report

Template Definition

< Back ) o L Next >
Definition Choose Object type Filter Objects Review
Filter Objects
Dashboard

& Save ¥ Return

>
6. Select one Filter Object from the Available Objects and click to add a Selected

<
Object. Select one Selected Object from the Available Objects and click to
remove a Filter Object.

Dashboard

Available Objects Selected Objects

B FR-2314

EFR-2314s
Ei[FR 20524
i FR 2052b
EFRY-14Q
EFRY-14A

i FR-28368
B FFIEC041

B FRYTN
B FRY-OLP
EFFIEC101

B FRY-9C

Search. .

When the object list is huge, use the Search option as shown above. Type first three
letters of the Filter Object name and the relevant Filter Objects will be displayed.

NOTE: You can type the complete Filter Object name to select and add to the Selected
Objects.
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Dashboard

Available Objects Selected Objects

BFRYTN B FRY-9C
EFRY-9LP

BFRY-14M £

EFRY-15

EFRY-20

EFRY-12

BFRY-11

EFRY-11s

EFRY-14Q

EFRY-14A

FRY| X o OK

7. Review the Template Definition once and click Save.

. A
Template Definition
< Back Q O O L] Next »
Definition Choose Object ty.. Filter Objects Review
Review
Object Identifier Object Name Object Type
0 1482689198163 FRY-8C Dashboard
< >
Page 1 of1(1of1items)
@ Save 7 Retun v
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8. Click Return to go to the Summary page.

9. Select a Template in the Template List in Summary screen and click Export to excel
or Export to XML to export the desired objects in Excel Sheet and XML format.

2 DGS Master Summary - ntemet Explorer

b Y =i -

B v X v| usengmv | oFsapv

ORACLE’ Financial Services Analytical Applications

Applications | Object Admin

stration  System Configuration & identity Management

n Tasks > Metadats Report

Select Applications o5

Financial Services Data Govemance for US Reguiatory Rep. . ¥ = Search and Filter C)Go ) Clear i Refresn
Template Tempiate
D Name

4 @ common Tasts

» B Data Movel Management

» Bl unifed Anatytcal Metadata

@ metadata Report

+ Template List (3) 7§ Acs @ Detete B view 2 et [ Export o excel .oy Exportto XaL | 224 Downioss

S Tempiate ID ¥ | Template Name Template Descripbion Created Date: Created By Status
0 2w repot 2314 722017 0FsAD Comple
v 20 wsage TR ) Comple
T 2603 ineage 1722017 '0FSAD " Compke
c2 for US Reguiatory Reporting

~
v

About Oracle ContactUs  Legal Nosices  Terms Of Use  Your Privacy Rights Copyright © 2016 Oracie andios s afliates. Allighis reserved.

NOTE: MDB Publish must be triggered before executing the Generate option.

NOTE: XMLs will be exported as individual type only

10. The Report Generation function is an asynchronous action and to check the status of the
export function, use the Refresh option in Summary screen.

Financial Services Analytical Applications Infrasfructure_> Object Adminsstration > Utilites > Mefadata Report
* Search and Filter ) Go 4 Cleafl 0, Refresh
Template ID Template Name 0070/
= Template List (2) (& Add
ate Name Template Description Created Date Created By Status
Tester 05-01-2017 OFSAD Not Started
04-01-2017 OFSAD Not Started
< [ >
L] For Excel Export, the following are the Status values:

= Not Started: The Report Generation is yet to start, but the function has
triggered the action in the background.

= Ongoing: The Report Generation is started and in process.

= Completed: The Report Generation is completed and ready to view or
download.

= Failed/Partially Completed: The Report Generation encountered an issue and
the process is partially completed or failed.
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NOTE: The export logs are generated and placed in the path
/Context_Name/logs/MDB_XXXX.log.

. For XML Export:

= Not Started
=  Check Metadata Export folder in server

NOTE: This is to distinguish the XML extract from the Excel export. XMLs
cannot be downloaded from Ul

11. Select a Template in the Template List in Summary screen and click Download to

save a copy of the generated Metadata Report Templates excel sheet, after the export
status shows as completed.

NOTE: XML files exported cannot be downloaded using this option.

& DGS Master Summary - Internet Explorer - [S=tto ]

ORACLE Financial Services Analytical Applications

Applications | Object Adminisraion ~ System Configuration & Ident

Select Applications

n Tasks > Metadsts Report

Financial Services Data Govemance for US Reguiatory Rep... ¥ » Search and Filter £)Go ) Ciear 2, Refresh

Tempizte Tenpiate
] ~ Mame 7

= Template List (3) "§Add © petete Biview Jeait [ Exportto excer Qixmmm

Tempiale® v | Tempiaie ame Tempiate Descripton Created Date: Created By
2% report 2314
23604 usage
23603 ineage

@ Metadata Report

» B operatons

Stans
17022017 OFSAD Complé
2T ) Compié
2217 OFsaD Compié

B

CHR) )

nce for US Reguistory Reporing

~

About Oracle  Contact Us  Legal Notices Tems Of Use ~ Your Privacy Rights Capyright © 2015 Oracie andior s affiales. A rights reserved.

User Access:

The following user groups are pre-seeded in the component that helps user to get access
to the Metadata Report Extract screen.

= MDR View Group: Helps users to see Metadata Report Extract with View
permissions.

= MDR Owner Group: Helps users to create templates in Metadata Report
Extract.
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13.3 Viewing Metadata Report Templates

Perform the following steps to view the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click View icon to view the generated Metadata Report Templates excel report (after the
export status shows as completed).

(& DGS Master Summary - Internet Explorer E-

g ol

B .H.v‘ US-Englisnvl OFSAD ¥

ORACLE Financial Services Analytical Applications

Applications | Object Administration ~ System Configuration & Identity Management

Select Applications Common Tasks > Metadata Report
Financial Services Data Governance for US Regulatory Rep... ¥ © Search and Filter Ty Go_ o Clear 20, Refresh
Template Template
4 @ common Tasks B2 Nt [ I
» & Data Model Management ————— ————
2 » Template List (3) [§Add @ oeue;" £dit [X] Exportto excel . Exportto XML 224 Download
» [ unified Analytical Metadata
@ Metadata Report | | Tempaten v | Tempiate Name Templale Description Created Date Created By Status
» @Opeyalmns O 223623 report_2314 17-02-2017 OFSAD Comple
8 metadata Browser M z6m e el OSAD Comok
- O 223603 lineage 17-022017 OFSAD Complé
Gt Data Governance for US Regulatory Reporting < ] >
About Oracle | Contact Us  Legal Notices  Terms Of Use  Your Privacy Rights Copyright © 2016 Oracle and/or s affiaes. Al rights reserved

NOTE: The Metadata Report Templates excel report is opened in view-only mode.

13.4 Modifying/Editing Metadata Report Templates

Perform the following steps to edit or modify the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click Edit icon to modify the generated Metadata Report Templates excel report (after
the export status shows as completed).
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ORACLE Financial Services Analytical Applications

Applications = Object Administration ~ System Configuration & Identity Management

Select Applications Common Tasks > Metadata Report
Financial Services Data Governance for US Reguiatory Rep... ¥ | v Search and Filter T Go ) Clear % Refresh
Template Tempiate |
4 @ common Tasks miel | ‘ ‘ I

» Data Model Management —
& s [+ Template List (3) S Add @ petete Bvi

€] Export to excel . Export to XML, Download
» [ unified Analytical Metadata i |

& Metadata Report el Template ID v | Tempiate Name | Tempite Description Created Date | created By Status |
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NOTE: Pre-defined Seeded Metadata Report Templates cannot be edited.

13.5 Deleting Metadata Report Templates

Perform the following steps to delete the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click Delete icon to delete the Metadata Report Templates.
2 DGS Master Summary - Internet Explorer . 9 T s .

UsEngiish v | OFSAD ¥

ORACLE Financial Services Analytical Applications

Object System C &Identity
Select Applications Common Tasks > Metadata Report
Financial Services Data Goverance for US Regulatory Rep... ¥ | v Search and Filter C)Go o) Clear 21 Refresh

Template [ ] Template |
D7 3

4 @ common Tasks

» B Data Model Management =
< [ v Template List (3) [ A iew 2] Edit 3] Export to excel . Export to XML 23 Download
» [E unified Analytical Metadata —— - ;
@ Metadata Report || | Template i ¥ | Template Name ‘Template Description | Created Date | Created By | Status
» [& operations | O 222 report 2314 17022017 OFSAD Com
B Metadata Browser M 223804 usage 17-02-2017 OFSAD Compl
= | 223603 lineage 17-02-2017 OFSAD ‘Comple
it Data Governance for US Regulatory Reporting | <] >

Pre-defined Seeded Metadata Report Templates cannot be deleted.
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14 Appendix A: Setting up Application and Workflow Function

This section details the steps involved in configuring an Application and/or its corresponding
Workflow Functions in the Workflow Manager to enable defining the complete workflow for the
Application Workflow function.

This chapter lists the following steps:

e Step 1: Application

e Step 2: Workflow Function

o Step 3: Application Component Mapping

o Step 4: Workflow Function Status Mapping

e Step 5: Create Workflow Action

e Step 6: Associate Workflows to Workflow Functions
e Step 7: Conclusion

Step 1: Application

For the availability of a new application in workflow manager, entries must be made to the tables
DIM_APP_INFO and DIM_APP_INFO_MLS.

TABLE NAME

DIM_APP_INFO

SCHEMA NAME

Atomic

DESCRIPTION This table stores basic information regarding the application(s). Like Application Name,
Application Code, and so on.

FIELD NAME DESCRIPTION DATA TYPE SAMPLE VALUE | MANDATORY

N_APP_KEY A unique number to identify NUMBER 5 Yes
the Application.

V_APP_CODE A unique number to identify VARCHAR OFS_BANK Yes
the Application.

V_APP_NAME Name of the Application. VARCHAR Banking Yes

Management

V_APP_DESC Brief description about the VARCHAR Banking No
Application. Management

D_RECORD_STAR | Application is valid from the DATE 4/1/2015 Yes

T _DATE start date. 11:00:00AM

D_RECORD_END_ | Application is valid to the end DATE 4/1/9999 Yes

DATE date. 11:00:00AM
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TABLE NAME DIM_APP_INFO_MLS
SCHEMA NAME Atomic
This table stores the locale specific entries for the application(s) name.
DESCRIPTION
FIELD NAME DESCRIPTION DATA TYPE SAMPLE VALUE MANDATORY
N_APP_KEY A unique number to identify the NUMBER 5 Yes
Application. This key is as
specified in the DIM_APP_INFO
table.
V_APP_NAME Name of the Application. VARCHAR Banking Yes
Management
DESCLOCALE Locale (en_US, es_ES, and so VARCHAR en_US Yes
on)

Step 2: Workflow Function

For the availability of a new workflow function in workflow manager, the entries must be made to
the tables SETUP_COMPONENTS & SETUP_COMPONENTS_MLS.

TABLE NAME

SETUP_COMPONENTS

SCHEMA NAME

Atomic

DESCRIPTION This table stores basic information regarding the workflow function(s). Like Function
Name, Function Key, Physical Fact table name, and so on.
FIELD NAME DESCRIPTION DATA SAMPLE VALUE MANDATORY
TYPE
N_ENTITY_KEY A unique number to identify NUMBER | 200 Yes
the Workflow Function.
V_ENTITY_NAME Name of the Workflow VARCHAR | Credit Banking Yes
Function.
V_ENTITY_DESC Brief description about the VARCHAR | Manage the Credit No
Workflow Function. Banking facility
V_FCT_TABLENAME | The primary FACT table of the | VARCHAR | FCT_CREDIT_BANK | Yes
Workflow Function
D_RECORD_START_ | Workflow Function is valid DATE 4/1/2015 11:00:00 Yes
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DATE

from the start date.

AM

D_RECORD_END_DA
TE

Workflow Function is valid to
the end date.

DATE

4/1/9999 11:00:00
AM

Yes

TABLE NAME

SETUP_COMPONENTS_MLS

SCHEMA NAME

Atomic

DESCRIPTION This table stores the locale specific entries for the workflow function(s) name.
FIELD NAME DESCRIPTION DATA TYPE | SAMPLE VALUE MANDATORY
N_ENTITY_KEY A unigue number to identify NUMBER 200 Yes
the Workflow Function. This
key is as specified in the
SETUP_COMPONENTS table.
V_ENTITY_NAME Name of the Workflow VARCHAR Credit Banking Yes
Function.
DESCLOCALE Locale (en_US, es_ES, and so | VARCHAR en_US Yes

on)

Step 3: Application Component Mapping

To map the new/existing Workflow Function(s) to the new/existing Application,
made to the FCT_APP_COMPONENT_MAP table.

an entry must be

TABLE NAME

FCT_APP_COMPONENT_MAP

SCHEMA NAME

Atomic

DESCRIPTION This table stores the mapping between application and workflow function(s).
FIELD NAME DESCRIPTION DATA TYPE SAMPLE VALUE | MANDATORY
N_APP_COMP_KEY A unique number to identify NUMBER 1000 Yes
the mapping between
Workflow Function and
Application.
N_APP_KEY Unique key that identifies the | NUMBER 5 Yes
Application. This key is as
specified in the
DIM_APP_INFO table.
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N_ENTITY_KEY Unique key that identifies the | NUMBER 200 Yes
Workflow Function. This key
is a specified in the
SETUP_COMPONENTS
table.

Step 4: Workflow Function Status Mapping

To map the component status to the respective workflow function, the following entries must be
made to the table SETUP_COMPONENT_STATUS_ MAP.

TABLE NAME SETUP_COMPONENT_STATUS_MAP

SCHEMA NAME Atomic

DESCRIPTION This table stores the mapping between workflow functions and their respective statuses.

FIELD NAME DESCRIPTION DATA SAMPLE MANDATORY
TYPE VALUE

N_OR_STATUS_CD | The status of the component. NUMBER | 13 Yes

This key is as defined in
DIM_OR_STATUS table.

N_ENTITY_KEY Unique key that identifies the NUMBER | 200 Yes
Workflow Function. This key is
a specified in the

SETUP_COMPONENTS table.

N_SORT_ORDER The sequence in which the NUMBER | 1 Yes

status needs to be displayed.

Step 5: Create Workflow Action

To enable create workflow functionality (== Create Workflow y o1 the new Application &workflow
function, following entries should be made to the following table.

NOTE: This step is required only when a new application is being included in the workflow
manager. It is not necessary to follow this step if a new workflow function is being
added to an existing application.

TABLE NAME FORMS_VIEW_MAPPING
SCHEMA NAME Configuration
DESCRIPTION This table contains the masking definition for the form control Create Workflow.
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FIELD NAME

DESCRIPTION

DATA TYPE

MANDATORY

FORM_CODE

Name of the Physical File that
displays the list of Workflows
configured for a Workflow Function.
The form code is as specified in the
FORMS_MASTER table in the
configuration schema.

VARCHAR

Yes

FORM_VERSION

Identifies if the configuration is
enabled or disabled. (0 — Enable,
1 - Disable)

NUMBER

Yes

DSN_ID

The Information Domain name

VARCHAR

Yes

CONTROL_ID

The identification number provided to
identify a field in the Ul. This
information is available in the
FORMS_MAP_ITEMS table in the
configuration schema.

NUMBER

Yes

VIEW_ID

A unique identifier provided for a
specific ROLE against a specific
Workflow Function status.

NUMBER

Yes

PARENT_VALUE

A computed value which is a product
of Workflow Function Status and

render mode.

NUMBER

Yes

CONTAINER

This flag identifies if the above
mentioned CONTROL_ID, identifies a
specific control or a specific container
(0 — control, 1 — container)

NUMBER

Yes

CONTROL_STATUS

The visibility mode that needs to be
applied to the control/container.

(1 - Enabled, 2 — Disabled,
3 — Hidden).

NUMBER

Yes

The following

values must be seeded mandatorily.

FIELD NAME

ROW 1 ROW 2

ROW 3

ROW 4

FORM_CODE

FrmWFMaster FrmWFMaster

FrmWFMaster

FrmWFMaster

FORM_VERSION

0 0

0

0

DSN_ID

OFSINFODOM OFSINFODOM

OFSINFODOM

OFSINFODOM
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CONTROL_ID 2 233 231 3
VIEW_ID 29007 29007 29007 29007
PARENT_VALUE 2005* 2005* 2005* 2005*
CONTAINER 0 0 0 0
CONTROL_STATUS | 1 1 1 1

* 2005 is a computed value = (2000 + Application Key)

Step 6: Associate Workflows to Workflow Functions

To associate the workflows created through Workflow Manager to its appropriate Workflow
Function, make the required following entries.

TABLE NAME WFM_LIST
SCHEMA NAME Atomic
DESCRIPTION This table associates the workflows created through workflow manager to its

respective workflow function.

FIELD NAME DESCRIPTION DATA SAMPLE MANDATORY
TYPE VALUE
N_WFM_LIST_ID Unique Identification number | NUMBER 2000 Yes

to identify the workflow
function within the Workflow

Manager.

V_DSN_ID The Information Domain VARCHAR | OFSINFODOM | Yes
name.

V_SEGMENT_ID Segment in which the VARCHAR | OFSSEGMENT | Yes

solution is installed.

N_WFM_FN_ID Workflow Function ID as NUMBER 200 Yes
specified in
SETUP_COMPONENTS
table.

V_WFM_FN_NAME | Name of the Workflow VARCHAR | Credit banking No

Function.

N_KBD_1_REQD Is Key Business NUMBER | 1 Yes

Dimension 1 required?

1-Yes/0-No

N_KBD_2 REQD Is Key Business NUMBER 1 Yes
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Dimension 2 required?

1-Yes/0-No

N_KBD_3_REQD

Is Key Business
Dimension 3 required?

1-Yes/0-No

NUMBER

Yes

N_KBD_4 REQD

Is Key Business
Dimension 4 required?

1-Yes/0-No

NUMBER

Yes

V_KBD_1_LABEL

If KBD 1 required, then give
the KBD label name.
(Business Line, Location,
others).

VARCHAR

Business Line

No

V_KBD_2_LABEL

If KBD 2 required, then give
the KBD label name.

(Business Line, Location,
others).

VARCHAR

Location

No

V_KBD_3_LABEL

If KBD 3 required, then give
the KBD label name.

(Business Line, Location,
others).

VARCHAR

No

V_KBD_4 LABEL

If KBD 4 required, then give
the KBD label name.
(Business Line, Location,

others).

VARCHAR

No

Step 7: Conclusion

You have successfully completed the setup process to define a workflow for a new application or

workflow function using workflow manager.

Log into the application and started defining the workflow for the new application or workflow

function.
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